
Прежде чем работать с устройством, внимательно изучите все инструкции и сохраняйте данное руководство для
последующего использования.
Прежде чем приступать к эксплуатации, внимательно ознакомьтесь с разделом “Прочитайте нижеследующее до
начала эксплуатации!” (стр. 3 и 4) данного руководства.
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Торговые знаки и зарегистрированные 
торговые знаки

	p Термины HDMI и HDMI High-Definition Multimedia 
Interface и Логотип HDMI являются товарными знаками 
или зарегистрированными товарными знаками HDMI 
Licensing Administrator, Inc. в Соединенных Штатах и 
других странах.
	p NDI® является зарегистрированным товарным знаком 

компании NewTek, Inc. в США и других странах.
	p Прочие наименования компаний и изделия, 

встречаемые в настоящей инструкции по 
эксплуатации, могут быть торговыми знаками 
или зарегистрированными торговыми знаками 
соответствующих их владельцев.

Об авторском праве и лицензии

Дистрибуция, копирование, разборка, обратная 
компиляция, обратный инжиниринг и экспорт в нарушение 
экспортных законов ПО, поставляемого с настоящим 
прибором, строго воспрещены.

Сокращения

В данном руководстве используются перечисленные ниже 
сокращения.
	p Персональные компьютеры обозначаются как 

“компьютеры”.

Иллюстрации и изображения экранов, 
используемые в руководстве

	p Иллюстрации и изображения экранов, используемые в 
руководстве, могут отличаться от реальных.

	p Информация о программном обеспечении для данного изделия
1.	� К данному изделию прилагается программное обеспечение, лицензированное в соответствии с принципами 

общедоступной лицензии GNU (GPL) и общедоступной лицензии ограниченного применения GNU (LGPL), 
и настоящим пользователи проинформированы о том, что они не имеют права приобретать, изменять и 
распространять исходные коды данного программного обеспечения.

	� Для приобретения исходного кода перейдите по указанной ниже ссылке:
	 https://pro-av.panasonic.net/en/
	� Производитель призывает пользователей воздержаться от вопросов к представителям производителя 

относительно приобретенного исходного кода и прочих деталей.
2.	� К данному изделию прилагается программное обеспечение, лицензированное в соответствии с лицензией МТИ.
3.	� В этом изделии используется программное обеспечение, предоставленное по лицензии FreeType Project (www.

freetype.org).

За дополнительной информацией об этом обратитесь к указанному ниже веб-сайту.
https://pro-av.panasonic.net/manual/en/index.html
Подробная информация предоставлена на языке оригинала (английский язык).
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Прочитайте нижеследующее до начала эксплуатации!

ВНИМАНИЕ:
Обязательно храните принадлежности (крепежные 
винты разъема заземления, зажим кабеля) в 
месте, недоступном для младенцев и маленьких 
детей.

ВНИМАНИЕ:
Это оборудование совместимо с классом A 
стандарта CISPR32.
В жилых районах это оборудование может стать 
причиной радиопомех.

 Данный знак обозначает информацию, относящуюся к технике безопасности.

ВНИМАНИЕ:
•	� Для снижения риска возникновения пожара 

или удара электрическим током не подвергайте 
данное оборудование воздействию дождя или 
влаги.

•	� Для снижения риска возникновения пожара или 
удара электрическим током держите данное 
оборудование подальше от любых жидкостей. 
Используйте и храните его только в местах, где 
оно не будет подвергаться риску попадания 
капель или брызг жидкости и не помещайте 
емкостей с жидкостью на оборудование.

ОСТОРОЖНО:
Не отвинчивайте крышки панелей.
Для снижения риска удара электрическим 
током не снимайте панели. Внутри устройства 
нет деталей, подлежащих обслуживанию 
пользователем.
Обратитесь за сервисным обслуживанием к 
квалифицированному персоналу.

ОСТОРОЖНО:
Внутри устройства установлена батарея в виде 
монеты.
Не подвергайте устройство воздействию 
чрезмерных источников тепла, например 
солнечный свет, огонь и т.п.

ОСТОРОЖНО:
На устройстве не следует размещать источники 
открытого пламени, например, зажженные свечи.

ОСТОРОЖНО:
Для снижения риска возникновения пожара или 
удара электрическим током и возникновения 
помех используйте только рекомендуемые 
дополнительные принадлежности.

ОСТОРОЖНО:
Для обеспечения надлежащей вентиляции 
не устанавливайте и не размещайте данное 
устройство на книжном стеллаже, во встроенном 
шкафу или в другом закрытом пространстве. Для 
предотвращения риска поражения электрическим 
током или опасности возгорания вследствие 
перегрева убедитесь, что занавески или другие 
материалы не препятствуют вентиляции.

ОСТОРОЖНО:
Сетевой штепсель шнура источника питания 
должен всегда оставаться в пределах 
досягаемости.
Штепсельная розетка переменного тока (сетевая 
розетка) должна быть установлена возле 
оборудования и должна быть легкодоступной. 
Для полного отключения данного оборудования 
от розетки переменного тока отсоедините шнур 
питания от штепсельной розетки переменного тока.

ВНИМАНИЕ:
Данный прибор должен быть заземлен.
Для обеспечения безопасной работы 
вставляйте трехконтактную штепсельную вилку 
исключительно в стандартную трехконтактную 
розетку, эффективно заземленную при помощи 
обычной бытовой проводки.
Используйте с данным прибором исключительно 
трехжильные удлинительные шнуры, проводка 
которых выполнена надлежащим обра ом, для 
обеспечения заземления. Неправильная проводка 
удлинительных шнуров является основной 
причиной несчастных случаев.
Нормальная работа прибора не может 
свидетельствовать о наличии заземления у 
розетки или о том, что процедура монтажа 
полностью безопасна.
В целях Вашей безопасности, пожалуйста, 
обратитесь к квалифицированному электрику, 
если не уверены в эффективности заземления 
розетки.

Символы на данном изделии (включая дополнительные принадлежности) означают следующее.

Переменный ток

Постоянный ток
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Прочитайте нижеследующее до начала эксплуатации!

ПРИМЕЧАНИЕ EMC ДЛЯ ПОКУПАТЕЛЯ/ПОЛЬЗОВАТЕЛЯ

1.	 Условия, которые необходимо соблюдать для достижения соответствия указанным стандартам
	 <1>	�Периферийное оборудование, которое подключается к устройству, и специальные соединительные кабели
		  •	� Настоятельно рекомендуется использовать только то оборудование, которое поставляется как 

периферийные устройства для подключения к данному аппарату.
		  •	 Используйте только соединительные кабели, представленные ниже.
	 <2>	�В качестве соединительных кабелей используйте экранированные кабели, которые соответствуют 

задачам подключения устройства.
		  •	� Соединительные кабели для передачи видеосигнала 

Для подключения SDI (Serial Digital Interface) следует использовать двойной экранированный коаксиальный кабель, 
предназначенный для высокочастотных приложений с сопротивлением 75 Ом, для SDI (Serial Digital Interface). 
Для передачи аналоговых видеосигналов рекомендуется использовать коаксиальный кабель, 
предназначенный для высокочастотных приложений с сопротивлением 75 Ом.

		  •	� Соединительные кабели для передачи аудиосигнала 
Если видеокамера принимает цифровые аудиосигналы AES/EBU, следует использовать кабели, 
предназначенные специально для AES/EBU. 
Для передачи аналоговых аудиосигналов используйте экранированные кабели, которые обеспечивают 
высокую производительность при работе с высокочастотными приложениями.

		  •	� Другие типы соединительных кабелей (LAN, RS‑422) 
Следует использовать экранированные кабели, которые обеспечивают высокую производительность при 
работе с высокочастотными приложениями.

		  •	 При подключении к DVI signal terminal следует использовать кабель на основе феррита.
		  •	� Если камера поставляется с ферритовыми сердечниками, следует подсоединить их к кабелям, как показано 

в инструкции.

2.	 Уровень производительности
	� Уровень производительности данного устройства соответствует требованиям указанных стандартов или 

превосходит их. 
При использовании устройства вблизи оборудования, которое является источником сильного электромагнитного 
излучения, могут возникать помехи (например, при использовании вблизи устройств передачи сигналов, 
мобильных телефонов и др.). Для минимизации подобного воздействия на устройство рекомендуется выполнить 
следующие действия с устройством и другими источниками электромагнитного излучения:

		  1.  Переместите камеру на достаточно большое расстояние от других устройств.
		  2.  Измените направление расположения камеры.
		  3.  Измените метод подключения камеры.
		  4.  Подключите камеру к другому источнику питания, который не используется никакими устройствами.

Меры предосторожности для сетевого провода 
переменного тока

В ЦЕЛЯХ ВАШЕЙ БЕЗОПАСНОСТИ, ПОЖАЛУЙСТА, ВНИМАТЕЛЬНО ПРОЧТИТЕ ПРИВЕДЕННЫЙ НИЖЕ ТЕКСТ.
К данному изделию прилагаются сетевой провод переменного тока 3 типов.

В каждом местном регионе необходимо использовать соответствующий сетевой провод, поскольку другой тип 
сетевого провода не подходит.

ДЛЯ ЕВРОПЕЙСКОГО 
КОНТИНЕНТА И Т.П.
Не для использования в 
Великобритании.

ТОЛЬКО ДЛЯ ВЕЛИКОБРИТАНИИ ТОЛЬКО ДЛЯ ИНДИИ

 Данный знак обозначает информацию, относящуюся к технике безопасности.
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	wОбщие сведения
Данное устройство является цифровым видеомикшером 1 ME, поддерживающим множество форматов 3G и HD.
Несмотря на небольшие размеры, этот видеомикшер оснащен четырьмя входами SDI, двумя входами HDMI, двумя 
выходами SDI, одним выходом HDMI, четырьмя входами IP, двумя выходами IP и аналоговым двух-канальным аудио 
входом/выходом.
Компактный эфирный видеомикшер AV-HSW10, совместимый с IP-системами ввода/вывода, такими как NDI*1/SRT/ 
RTMP, наряду с 3G-SDI, обладает базовыми функциями, которые конкурируют с функциями микшеров среднего класса, 
позволяя создавать HD-видео.
Отлично приспособленный для перевозки, многофункциональный основной блок можно легко транспортировать для 
использования на различных музыкальных, спортивных и развлекательных мероприятиях с прямой трансляцией.
Кроме того, наряду с поддержкой мультиформата 3G / HD, он также имеет множество IP-входов и выходов, совместим 
с UVC, что позволяет ему не только стабильно работать на мероприятиях, где есть несколько камер*2, но и напрямую 
передавать видео, используя различные способы передачи в территориально удаленных местах.
Два коммутатора спецэффектов, включая один канал для цветовой рирпроекции и два канала PinP, обеспечивают 
множество технологических приемов производства программ.
Более того, даже если в сюжетах используются разные форматы, можно легко выбирать видеовыход в соответствии со 
своими целями с помощью таких функций, как повышающие/понижающие преобразователи и масштабирование HDMI.
Мы постарались сделать это изделие полезным в качестве переносного аппарата для множества сфер применения, 
например на праздничных мероприятиях, на передвижных телевизионных станциях, на презентациях в университетах 
или компаниях и т. п., и конечно, для самих вещательных компаний. Этот компактный эфирный видеомикшер является 
действительно высокоэффективным при создании изображений в прямом эфире вне студии.

*1	�NDI® означает NDI® с высокой пропускной способностью, а NDI®|HX - высокоэффективный NDI®|HX с низкой 
пропускной способностью.  
NDI® – это протокол, используемый для поддержки рабочих процессов создания изображений в реальном времени с 
использованием IP, который был разработан компанией NewTek, Inc.

*2	�Встроенные камеры Panasonic 4K/HD и видеорегистратор с картой памяти AG-CX350. 
Информацию о встроенных камерах 4K/HD, совместимых с NDI® и NDI®|HX, смотрите на веб-сайте Panasonic:  
https://pro-av.panasonic.net/en/

	wОб отображении паспортных данных
Название, номер модели и класс мощности устройства указаны на боковой панели.

	wОтказ от гарантии
НИ В КАКИХ СЛУЧАЯХ, КРОМЕ ЗАМЕНЫ ИЛИ ОБОСНОВАННОГО ТЕХОБСЛУЖИВАНИЯ ПРОДУКТА, Panasonic 
Entertainment & Communication Co., Ltd. НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ПЕРЕД ЛЮБОЙ СТОРОНОЙ ИЛИ ЛИЦОМ ЗА 
СЛУЧАИ, ВКЛЮЧАЯ, НО НЕ ОГРАНИВАЯСЬ ЭТИМ:

1	�ЛЮБЫЕ УБЫТКИ И УЩЕРБ, В ТОМ ЧИСЛЕ ПРЯМЫЕ ИЛИ КОСВЕННЫЕ, ФАКТИЧЕСКИЕ, ПОБОЧНЫЕ ИЛИ 
ШТРАФНЫЕ УБЫТКИ, ВОЗНИКАЮЩИЕ ИЗ-ЗА ИЗДЕЛИЯ ИЛИ В СВЯЗИ С НИМ;

2	�ТРАВМЫ ИЛИ ЛЮБОЕ ПОВРЕЖДЕНИЕ, ВЫЗЫВАЕМЫЕ НЕСООТВЕТСТВУЮЩИМ ПРИМЕНЕНИЕМ ИЛИ 
НЕБРЕЖНЫМ УПРАВЛЕНИЕМ ПОЛЬЗОВАТЕЛЯ;

3	�НЕОБОСНОВАННУЮ РАЗБОРКУ, РЕМОНТ ИЛИ МОДИФИКАЦИЮ ИЗДЕЛИЯ ПОЛЬЗОВАТЕЛЕМ;
4	�НЕУДОБСТВО ИЛИ ЛЮБЫЕ ПОТЕРИ, ВОЗНИКАЮЩИЕ ПРИ НЕПРЕДСТАВЛЕНИИ ИЗОБРАЖЕНИЙ ПО ЛЮБОЙ 

ПРИЧИНЕ, ВКЛЮЧАЮЩЕЙ ОТКАЗ ИЛИ НЕИСПРАВНОСТЬ ИЗДЕЛИЯ;
5	�ЛЮБУЮ НЕИСПРАВНОСТЬ, КОСВЕННОЕ НЕУДОБСТВО ИЛИ ПОТЕРЮ ИЛИ ПОВРЕЖДЕНИЕ, ВОЗНИКАЮЩИЕ 

ИЗ СИСТЕМЫ, КОМБИНИРОВАННОЙ С УСТРОЙСТВАМИ ТРЕТЬЕЙ СТОРОНЫ;
6	�ЛЮБЫЕ НЕУДОБСТВА, УЩЕРБ ИЛИ УБЫТКИ, ВОЗНИКАЮЩИЕ ИЗ-ЗА НЕПРАВИЛЬНОГО СПОСОБА УСТАНОВКИ 

ИЛИ ДРУГИХ ФАКТОРОВ, ЗА ИСКЛЮЧЕНИЕМ НЕИСПРАВНОСТИ САМОГО ИЗДЕЛИЯ;
7	�ПОТЕРИ ЗАРЕГИСТРИРОВАННЫХ ДАННЫХ ИЗ-ЗА КАКОГО-ЛИБО СБОЯ;
8	�ЛЮБОЙ УЩЕРБ ИЛИ ИСКИ ИЗ-ЗА ПОТЕРИ ИЛИ УТЕЧКИ ИЗОБРАЖЕНИЙ ИЛИ УСТАНОВОЧНЫХ ДАННЫХ, 

СОХРАНЕННЫХ В ЭТОМ ПРИБОРЕ, НА КАРТЕ ПАМЯТИ ИЛИ В КОМПЬЮТЕРЕ.

Перед использованием
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	wСетевая безопасность
В данном устройстве также есть функции, которые используются только при подключении к сети. Использование 
устройства, когда оно подключено к сети, может привести к возникновению перечисленных ниже проблем.

1	Утечка или кража информации через данное устройство
2	�Использование данного устройства для незаконных операций лицами со злым умыслом
3	�Вторжение в данное устройство лиц с злоумышлением или его остановка ими

Вы обязаны принять описанные ниже меры предосторожности против вышеуказанных рисков нарушения сетевой 
безопасности.

	p Сеть, в которой используется этот прибор, должна быть защищена брандмауэром и т.п.
	p Если данное устройство подключено к сети, в которую входят компьютеры, обязательно убедитесь в том, что система 
не поражена компьютерными вирусами или другими вредоносными программами (используя регулярно обновляемую 
антивирусную программу, антишпионскую программу и т.п.).

Также необходимо принимать во внимание указанные ниже рекомендации.
	p Для оборудования, подключенного к устройству, рекомендуется использование одного сегмента. 
Если устройство подключено к оборудованию с разными сегментами, могут происходить события, обусловленные, 
например, присущими сетевому оборудованию настройками, поэтому перед началом использования тщательно 
проверяйте способы подключения к оборудованию, к которому будет подключено устройство.

	p Не выбирайте место установки, где устройство, кабели и другие детали могут быть легко повреждены.
	p Передача данных NDI может стать нестабильной в некоторых сетевых средах. 
Проверьте запланированный объем трафика NDI, приблизительно рассчитав объем передачи данных NDI, а затем 
убедитесь, что диапазон скорости передачи по линии достаточен. 
Когда к одному источнику NDI выполняется несколько обращений, объем сигнала NDI на стороне передачи 
увеличивается в соответствии с количеством обращений. 
Рассмотрите возможность использования многоадресной передачи, если этого требует структура системы.

Перед использованием



10

 Обращайтесь осторожно.
	� Не роняйте устройство и не подвергайте его сильным 

ударам или тряске.  
Не переносите и не передвигайте устройство за рычаг 
регулятора. Данные меры предосторожности призваны 
предотвратить возникновение неисправностей или 
несчастных случаев.

 �Допускается использование 
устройства при температуре 
окружающей среды от 0 °C до 40 °C.

	� Избегайте использования данного устройства в 
холодных местах с температурой ниже 0 ºC или в 
жарких местах с температурой выше 40 ºC, так как 
очень низкая или высокая температура оказывают 
неблагоприятное воздействие на внутренние детали.

 �Отключение электропитания перед 
подсоединением и отсоединением 
кабелей.

	� Перед подсоединением или отсоединением кабелей 
убедитесь, что Вы отключили питание.

 �Избегайте попадания влаги и пыли.
	� Избегайте использования данного устройства во 

влажных или пыльных местах, так как повышенная 
влажность и запыленность вызывают повреждения 
внутренних деталей.

 �Обслуживание
	� Выключите питание устройства и протрите изделие 

сухой тканью. Для удаления трудновыводимых 
загрязнений смочите тряпку в разбавленном растворе 
кухонного чистящего средства (нейтрального), 
тщательно отожмите ее и аккуратно протрите изделие. 
Затем, после протирки изделия влажной тряпкой, снова 
протрите его сухой тканью.

•	�Не используйте бензин, растворители для краски и 
другие летучие жидкости.

•	�Если для чистки используется салфетка с 
химической пропиткой, перед использованием 
внимательно ознакомьтесь с мерами 
предосторожности.

Осторожно

 �Меры предосторожности при 
эксплуатации

	� Функции переключения изображения изделия и 
эффекта изображения можно использовать для 
создания изображений, которые быстро мигают, или 
изображений, которые быстро изменяются.

	� Однако следует иметь в виду, что использование этих 
функций в процессе эксплуатации приводит к созданию 
таких типов изображений, которые могут иметь 
неблагоприятный эффект на физическое состояние 
пользователя.

 Если изделие подлежит списанию
	� Если по завершении срока эксплуатации 

изделие подлежит списанию, обратитесь к 
специализированному подрядчику по проведению 
корректной утилизации с целью защиты окружающей 
среды.

 Изнашиваемые детали
Охлаждающий вентилятор:
	� Является изнашиваемой деталью. 
	� Как правило, его следует заменять каждые 5 лет или 

чаще (когда устройство используется по 15 часов в 
день).

Адаптер переменного тока:
	� Является изнашиваемой деталью. 
	� Как правило, его следует заменять каждые 5 лет или 

чаще (когда устройство используется по 15 часов в 
день).

Период замены изнашиваемых частей будет 
различным в зависимости от условий эксплуатации.
При наступлении времени замены этих деталей 
обратитесь к Вашему дилеру для выполнения 
работы.

Меры предосторожности при эксплуатации
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	qПомимо выполнения действий пунктов, указанных в разделе “Прочитайте 
нижеследующее до начала эксплуатации!”, соблюдайте также меры 
предосторожности, указанные ниже.

По поводу выполнения работ по установке и подключению прибора обратитесь к своему дилеру.

Подключение источника питания
	p Используйте только кабель 
переменного тока и адаптер 
переменного тока, поставляемые 
вместе с устройством.

	p Обязательно подключите разъем 
заземления (SIGNAL GND), расположенный сзади на 
устройстве, к заземлению системы.

	p Вставьте адаптер переменного тока до упора.
	p Если устройство не будет использоваться в течение 
длительного периода времени, выключите его питание 
и отсоедините штепсельную вилку от розетки сети 
переменного тока.

Обращайтесь с устройством осторожно!
	p Если устройство бросать или подвергать сильному 
ударному воздействию или вибрации, это 
может привести к возникновению проблем и/или 
неисправностей.

Не допускайте попадания посторонних 
предметов внутрь устройства!

	p Попадание воды, металлических предметов, крошек или 
других посторонних предметов внутрь устройства может 
привести к пожару и/или поражению электрическим 
током.

Выбор наилучшего места установки
	p Этот прибор предназначен для использования только 
внутри помещений.

	p Устанавливайте данное устройство на достаточно 
прочной, устойчивой и ровной поверхности для 
использования.

	p Во избежание возникновения препятствий 
для вентиляции убедитесь в том, что вокруг 
вентиляционных отверстий устройства есть не менее 
100 мм свободного пространства.  
В частности, при монтировании устройства в панель 
или стол убедитесь в том, что между вентиляционными 
отверстиями и проводами оставлено достаточно 
свободного пространства.

	p Не устанавливайте устройство таким образом, чтобы 
кабели и прочие аксессуары можно было легко 
повредить.

	p Не устанавливайте устройство в холодном месте, где 
температура может опуститься ниже 0 °C, или в месте, 
где температура может подняться выше 40 °C.

	p Не устанавливайте устройство в местах, где оно будет 
подвергаться воздействию прямых солнечных лучей 
или воздействию горячего воздуха, выдуваемого из 
других изделий.

	p Установка устройства в очень влажном, пыльном 
или подверженном вибрации месте может привести к 
возникновению проблем.

Вентиляционный вход

Вентиляционное выходВентиляционный вход

Меры предосторожности при установке
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Компактная конструкция, множество входов и 
выходов

	p �Несмотря на свой компактный размер, видеомикшер 
поставляется с четырьмя SDI-входами, двумя HDMI-
входами, двумя SDI-выходами и одним HDMI-выходом.  
Кроме того, микшер может пригоден для различных 
вариантов коммутации в реальном времени, поскольку 
он оснащен IP-входами и выходами, опорным 
входом, сквозным выходом, 2-канальным аналоговым 
аудиовходом и выходом UVC.

	p Помимо фоновых переходов с помощью вырезов, 
микширования и вытеснения, устройство оснащено 
пятью коммутаторами спецэффектов, включая канал 
для цветовой рирпроекции и два канала PinP.

	p С помощью функций многооконного просмотра 
экран монитора можно разделить для показа до 
16 видеоизображений.

	p Вход/выход поддерживает 3G/HD-SDI, и каждый вход 
оснащен синхронизатором кадров (FS).

	p Он поддерживает множество IP-систем ввода-вывода, 
включая NDI, NDI|HX, SRT и RTMP.

	p 2-канальные разъемы аналогового аудиовхода 
позволяют подключать аудио по любой из выходных 
шин.  
Вы также можете настроить уровень входного сигнала и 
задержку звука.

Поддержка множества форматов
	p Поддерживаются следующие форматы сигналов:

Форматы 2K:
1080 × 59,94p, 1080 × 50p, 1080 × 29,97p, 1080 × 25p, 
1080 × 24p, 1080 × 23,98p, 1080 × 59,94i, 1080 × 50i

Форматы HD:
720×59,94p, 720×50p

	p Поддерживает несколько форматов 2K / HD.
	p Совместимость с различными интерфейсами, например 
3G-SDI, 1.5G-SDI, HDMI и IP.

	p Максимальное количество входов: четыре SDI входа, 
два - HDMI и четыре IP входа.

	p Максимальное количество выходов: два SDI выхода, 
один HDMI выход и два IP выхода.

	p Устройство оснащено двумя коммутаторами, 
позволяющими создавать множество видеоэффектов,

	p такими функциями, как повышающие / понижающие 
преобразователи.

	p Устройство оснащено двумя шинами AUX BUS. Имеет 
функцию смешивания переходов MIX.

	p Оснащен функцией удаленного управления камерой, 
которая позволяет управлять девятью встроенными 
камерами Panasonic 4K /HD.

	p Доступна функция цветовой рирпроекции.
	p Видеопамять (два неподвижных изображения) может 
быть записана и вызвана подключенными сигналами 
рирпроекции.

	p Устройство оснащено функциями памяти кадров.
	p Совместим с USB-памятью.

Функции
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Убедитесь в том, что приведенные ниже принадлежности имеются в наличии в указанном количестве.
	p После извлечения устройства из упаковки утилизируйте соответствующим образом крышку кабеля электропитания 
(при наличии) и упаковочные материалы.

	p Данное устройство поставляется с зажимом для кабеля, который предотвращает случайное отсоединение адаптера 
переменного тока.

Адаптер переменного тока.................................1
Зажим кабеля......................................................1

Кабель переменного тока для AV-HSW10E......3
	p Для Великобритании и 
Саудовской Аравии

	p Для континентальной 
Европы и т. д.

	p Только для Индии

	p К данному изделию прилагаются сетевой провод переменного тока 3 типов. 
В каждом местном регионе необходимо использовать соответствующий сетевой провод, поскольку другой тип 
сетевого провода не подходит.

Принадлежности
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Крепление кабельного зажима

DC IN 16V

Отсоединение кабельного зажима

1	 Зажмите 1 и потяните в направлении 2.

DC IN 16V







Закрепление адаптера переменного тока

1	 Разблокируйте кабельный зажим.

DC IN 16V

2	 Вставьте адаптер переменного тока.

DC IN 16V

3	 Зафиксируйте кабель адаптера переменного 
тока с помощью кабельного зажима.

DC IN 16V

Принадлежности
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Компоненты и их функции

Панель управления

POWER

AMB:F
GRN:S

PGM

PST

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4

1 7 2 8 3 9 4 10 5 11 6 12

USER 2 5 USER 3 SHOT MEM EXIT

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

MENU6

PGM PVW

SHIFT

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

3

1

2

4 5C6 7 ? 8 9

:

;

<

=

A

B

D

E

@ >

1	Индикатор POWER [POWER]
Этот индикатор загорается, когда выключатель питания 
POWER (F) на задней панели устанавливается в 
положение ON, при подаче питания на разъем DC IN 
(U) .

2	Индикатор ALARM [ALARM]
Индикатор загорается, когда вентилятор охлаждения 
(T) перестает работать, если возникает проблема с 
источником питания (падение напряжения) или когда 
температура внутри устройства достигает аномально 
высокого уровня.
Когда это происходит, в экранном меню появляется 
тревожное сообщение, в то время как экранное меню 
отображается на внешнем мониторе (в состоянии 
OSD ON).
Информация о тревоге может быть выведена 
на внешнее устройство через разъем TALLY/GPI 
устройства (N).
 См. раздел “Аварийное сообщение”.
При появлении аварийной сигнализации немедленно 
прекратите работу с устройством и обязательно 
обратитесь к дилеру. 
Продолжение использования устройства после 
появления аварийной сигнализации может привести к 
повреждению устройства. 

3	Кнопка STREAM [STREAM]
Передачи могут быть непосредственно запущены, 
остановлены и переведены в режим ожидания с этого 
устройства с помощью SRT / RTMP. Цвет светодиодной 
подсветки меняется, указывая на состояние передач. 
(ВЫКЛ.: Выкл. (*1), Режим ожидания: зеленый, 
Передача: красный)
Данное устройство оснащено двумя каналами 
передачи (CH1 и CH2), и операции для CH2 можно 
выполнять нажатием кнопки [SHIFT] (6).

Функция кнопки

Канал  
передачи: LED

Нажать Нажать и 
удерживать

ВЫКЛ.: Выкл. (*1) Передача: 
красный

Режим 
ожидания: 
зеленый

Режим ожидания: 
зеленый

Передача: 
красный

ВЫКЛ.: Выкл. 
(*1)

Передача: красный Режим ожидания: 
зеленый

ВЫКЛ.: Выкл. 
(*1)

*1 �Загорается цветами, установленными в группе 
цветов в [12] Config > Button Illumination > Color 
Group Other > STREAM.

4	Кнопки USER [USER 1, USER 2, USER 3]
Любые шесть функций, выбранных из пунктов меню, 
могут быть назначены кнопкам [USER 1], [USER 2] и 
[USER 3], а затем использованы.
Функции, зарегистрированные в [USER 1] и 
[USER 4], назначаются кнопке [USER 1], тогда 
как функции, зарегистрированные в [USER 2] и 
[USER 5], назначаются кнопке [USER 2], а функции, 
зарегистрированные в [USER 3] и [USER 6] 
назначаются кнопке [USER 3].
Пока кнопка SHIFT (6) удерживается нажатой, можно 
выбрать функцию, зарегистрированную в [USER 4], 
[USER 5] или [USER 6].
Горит Функции, назначенные кнопкам [USER], 

включены.
Гаснет Функции, назначенные кнопкам [USER], 

выключены.
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5	Кнопка памяти кадра [SHOT MEM]
Эта кнопка позволяет регистрировать, вызывать и 
удалять память кадров.
 См. раздел “Память кадров”.

6	Кнопка SHIFT [SHIFT]
Эта кнопка используется для вызова функций [USER 
4], [USER 5] и [USER 6], которые были назначены 
кнопкам [USER 1], [USER 2] и [USER 3], а также для 
вызова XPT7-XPT12 материалы, назначенные для 
кнопок с перекрестными точками [1] по [6], а также для 
операций с памятью кадров.
Горит Кнопка [SHIFT] включена.
Гаснет Кнопка [SHIFT] выключена.

(Функции, выполняемые с помощью кнопки [SHIFT], 
вступают в силу только при удержании этой кнопки 
нажатой.)

7	Меню OSD/TIME
С помощью этого меню выполняются следующие 
операции.

	p При отображении главного меню:
Включите меню OSD/TIME, чтобы выбрать подменю, 
и нажмите на шкалу, чтобы перейти к выбору.
	p Когда отображается подменю:
Включите меню OSD/TIME, чтобы выбрать подменю, 
и нажмите на шкалу, чтобы перейти к выбору.
При вводе значений настроек они изменяются при 
первом нажатии на меню и его повороте, затем 
значения настроек подтверждаются при повторном 
нажатии на меню.
Удерживайте меню нажатым, чтобы вернуть 
значение настройки к значению по умолчанию.
	p При повороте меню, удерживая его нажатым после 
[KEY1 ON], [KEY2 ON], [FTB ON] или [AUTO] можно 
изменить соответствующую продолжительность 
перехода.

8	Кнопка EXIT [EXIT]
Эта кнопка позволяет перейти на один уровень 
подменю при использовании экранных меню OSD.

9	Кнопка MENU [MENU]
При этом выбирается, должно ли экранное меню OSD 
отображаться или скрываться.
Каждый раз, при удерживании нажатой кнопки [MENU], 
меню либо отображается, либо скрывается.
Оранжевый 
индикатор

Действия с меню OSD

Не светится Меню OSD скрыто

При нажатии кнопки [MENU] во время отображения 
меню OSD дисплей переключается между главным 
меню и отображением состояния.
Следующую информацию можно увидеть на дисплее 
состояния:

	p Настройки шаблона сдвига
	p Настройки времени перехода
	p Настройки кнопки [USER]
	p Настройки назначения коммутации

:	Кнопка FTB ON [FTB ON]
Нажмите эту кнопку, чтобы изображение программы 
превратилось в черный экран на заданную 
продолжительность перехода.
При повторном нажатии кнопки изображение 
программы исчезает с черного экрана.

Нажмите кнопку. Мигает

Затухает.

Нарастает.

Горит

Индикатор кнопки 
гаснет.
Программное 
изображение

Горит
Затухание завершено.

Нажмите кнопку.

Помимо черного экрана может быть установлено 
изображение для затухания изображения программы.
 См. раздел “FTB (от Fade до Black)”.
Поворачивая меню OSD/TIME (7) и удерживая 
нажатой кнопку [FTB ON] можно изменить 
продолжительность перехода.

;	Кнопка KEY 1 ON, Кнопка KEY 2 ON 
	 [KEY 1 ON, KEY 2 ON]

Эта операция используется для объединения 
материалов вставки на заданную продолжительность 
перехода.

Нажмите кнопку.
Мигает

Идет процесс 
объединения 
изображений.

Объединение 
изображений отключено.

Горит

Индикатор кнопки гаснет.
Изображения 
комбинировать не 
возможно.

Горит
Процесс объединения 
изображений завершен.

Нажмите кнопку.

Поворачивая меню OSD/TIME (7), удерживая 
нажатыми [KEY 1 ON] или [KEY 2 ON], можно изменить 
продолжительность перехода.

<	Кнопка CUT [BKGD CUT]
Это мгновенно инициирует переход к выбранной в 
данный момент операции.
Горит Переход выполняется.
Гаснет Переход завершен.

Компоненты и их функции
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=	Кнопка AUTO [BKGD AUTO]
При этом автоматически инициируется переход 
на заданную продолжительность перехода 
(автоматический переход).
Горит Выполняется автоматический переход.
Гаснет Автоматический переход завершен.

Если кнопка [AUTO] нажата во время выполнения 
автоматического перехода, операция автоматического 
перехода прерывается.
При повторном нажатии кнопки после того, как 
операция была прервана, выполняется оставшийся 
переход.
Когда кнопка [AUTO] нажата, а рычаг фейдера (>) 
находится в промежуточном положении, переход 
выполняется за время, оставшееся от промежуточного 
положения.
Поворачивая меню OSD/TIME (7) и удерживая 
нажатой кнопку [AUTO] можно изменить 
продолжительность перехода.

>	Рычажок фейдера
Эта кнопка служит для выполнения ручного перехода.
Когда рычажок фейдера перемещен до конца, переход 
завершен.
Если рычажок фейдера перемещается во время 
автоматического перехода, управление переключается 
на ручное в точке, где положение рычага фейдера 
превышает текущую величину перехода.
Для материалов, содержащих переходы, можно 
выбрать фон или клавишу, используя меню.

?	Кнопка переключения MIX/WIPE [MIX, WIPE]
С помощью этой кнопки выбирается способ перехода.
MIX и WIPE переключаются при каждом нажатии 
кнопки.
MIX Используется для выполнения переходов 

(смешивания переходов) при наложении 
изображений шины A и шины B (или 
изображений шины PGM и шины PST).
Во время выполнения перехода общее 
количество выходных данных шины A и шины 
B (или шины PGM и шины PST) сохраняется 
на уровне 100 %.
Индикатор [MIX] слева горит оранжевым, 
когда выбрано СМЕШИВАНИЕ.

WIPE Переход выполняется в соответствии с 
выбранным шаблоном сдвига.
Индикатор [WIPE] слева горит оранжевым, 
когда выбрана функция WIPE.

@	Индикаторы сигналов шин [A, B]
Загорается индикатор, соответствующий шине, на 
которую выводятся программные материалы (PGM).

A	Кнопка переключателя шины AUX
	 [AUX BUS DELEGATION]

Выберите шину для управления с помощью 
коммутационных кнопок шины AUX (B). 
Выбранная кнопка подсвечивается.

[KEY 1], [KEY 2]:
Данная кнопка используется для переключения 
коммутационных кнопок шины AUX (B) в режим кнопок 
выбора источника для шин вставки заполнения или 
шин источника вставки.
При каждом ее нажатии функция кнопки выбора 
переключается между шинами вставки заполнения и 
шинами источника вставки.
Оранжевый 
индикатор

Шины заполнения вставки

Зеленый 
индикатор

Шины источника вставки

[AUX 1], [AUX 2]:
Данные кнопки используются для переключения 
коммутационных кнопок шины AUX (B) в режим кнопок 
выбора источников шин AUX.

B	Коммутационные кнопки шины AUX
Эти кнопки служат для выбора источника шины, 
выбранной с помощью кнопки переключения шины 
AUX (A).
С помощью кнопки [SHIFT] можно выбрать кнопки от 
1 до 12 (6). Когда удерживаются коммутационные 
кнопки (B, D, E), меню OSD отображает название 
входного материала и номер коммутационной кнопки.

C	�Кнопки коммутации исключительно для шины 
AUX [AUX SOURCE]
Когда светятся кнопки переключения шины AUX [AUX 
1], [AUX 2] (A), этими кнопками выполняется выбор 
источников шины AUX.
Нажатые кнопки загораются желтым цветом.

[MV]:
Выполняется выбор одного из сигналов многооконного 
дисплея для шины AUX.

[PGM/PVW]:
Выполняется выбор сигнала PGM или сигнала PVW 
для шины AUX.
Переключение между сигналом PGM и сигналом PVW 
выполняется с помощью кнопки [SHIFT] (6).

D	Коммутационные кнопки шины PGM [1 - 6]
Служат для выбора видеосигналов шины PGM/A. С 
помощью кнопки [SHIFT] можно выбрать кнопки от 1 до 
12 (6).
Режим шины может быть выбран как “A/B”, “PGM-A/
PST-B” или “PGM-B/PST-A” в меню конфигурации.
 См. раздел “Фоновый переход”.
Когда удерживаются коммутационные кнопки (B, 
D, E), меню OSD отображает название входного 
материала и номер коммутационной кнопки.

E	Коммутационные кнопки шины PST [1 - 6]
Служат для выбора видеосигналов шины PGM/B. С 
помощью кнопки [SHIFT] можно выбрать кнопки от 1 до 
12 (6).
Режим шины может быть выбран как “A/B”, “PGM-A/
PST-B” или “PGM-B/PST-A” в меню конфигурации.
 См. раздел “Фоновый переход”.
Когда удерживаются коммутационные кнопки (B, 
D, E), меню OSD отображает название входного 
материала и номер коммутационной кнопки.

Компоненты и их функции
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F	Выключатель питания [POWER]
Если выключатель питания [POWER] включен, 
загорится индикатор [POWER] (1), что указывает на 
готовность устройства к работе.

G	Разъемы SDI IN [SDI IN 1 - 4]
Разъемы для ввода сигнала HD SDI.

	p SDI IN 1 и HDMI IN 1 являются 
взаимоисключающими. Выберите один из них в меню 
ввода.
	p Для SDI IN версиях 3 и 4 доступны расширенные 
настройки повышающего /понижающего 
преобразователя.

H	Разъемы SDI OUT [SDI OUT 1, 2]
Разъемы для вывода сигнала HD SDI. Следующие 
сигналы могут быть назначены для разъема с 
помощью операций меню:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Меню OSD не отображаются через разъем SDI OUT 1.

I	Разъемы HDMI IN [HDMI IN 1, 2]
Разъемы для ввода сигнала HDMI. Они поддерживают 
HDMI 1.4b. Данное устройство не поддерживает HDCP.
Сигналы со следующими разрешениями могут 
вводиться с помощью операций меню.
Разрешение (Вертикальная частота: 60 Гц):
WSXGA+ (1600 × 1050), SXGA (1280 × 1024), 
WXGA (1280 × 768), XGA (1024 × 768)
Разрешение:
1920 × 1080/59,94p, 1920 × 1080/50p, 
1920 × 1080/29,97p, 1920 × 1080/25p, 1920 × 1080/24p, 
1920 × 1080/23,98p, 1920 × 1080/59,94i, 1920 × 1080/50i, 
1280 × 720/59,94p, 1280 × 720/50p

	p Разъем HDMI IN поддерживает функцию 
масштабирования.

J	Разъемы HDMI OUT [HDMI OUT]
Это выходной разъем сигнала HDMI. Следующие 
сигналы могут быть назначены для разъема с 
помощью операций меню:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Возможен вывод с тем же разрешением, что и 
системный формат данного устройства.

Сигналы со следующими разрешениями могут 
выводиться с помощью операций меню.
Выходное разрешение может быть зафиксировано на 
уровне 1080/720.
Разрешение (Вертикальная частота: 60 Гц):
WSXGA+ (1600 × 1050), SXGA (1280 × 1024),  
WXGA (1280 × 768), XGA (1024 × 768)
Разрешение:
1920 × 1080/59,94p, 1920 × 1080/50p, 
1920 × 1080/29,97p, 1920 × 1080/25p, 1920 × 1080/24p, 
1920 × 1080/23,98p, 1920 × 1080/59,94i, 1920 × 1080/50i, 
1280 × 720/59,94p, 1280 × 720/50p

K	Опорный входной разъем [REF]
Проходной выход в режиме внешней синхронизации.
Если проходной выход не будет использоваться, 
подключите к нему 75-омную заглушку.

L	Входной аудио разъем [AUDIO IN]
Это разъемы для ввода внешнего аудио (микрофон/ 
линия).
Они поддерживают два канала, левый и правый.

M	Разъем USB (*1) (разъем типа-C) 
	 [USB STREAM OUT]

Вы можете загрузить видео- и аудиовыходы с этого 
устройства на компьютер, подключив их через USB 
Video Class.
Следующие сигналы могут быть назначены для 
разъема с помощью операций меню:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

*1 �УСТРОЙСТВО USB 3.2 Gen1, без функции питания 
по шине USB

Область задней панели

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

Q F

R P O N M J

L K H G

I

Компоненты и их функции
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N	Разъем TALLY/GPI  
	� [TALLY/GPI] (15-контактный разъем D-sub, 

гнездовой, дюймовый винт)
Устройство оснащено 5 контактными входными 
портами для управления устройством с внешних 
устройств и 8 открытыми коллекторными выходными 
портами для вывода информации о подсчете и 
аварийной информации с этого устройства.

O	Разъем LAN [LAN] (RJ-45) (1000Base-TX)
Это разъем LAN (RJ-45), используемый для 
подключения внешнего устройства к данному 
устройству с целью IP-управления.
Кроме того, IP-сигналы также отправляются и 
принимаются этим разъемом.
Для подключения используйте кабель LAN (*1).

*1 �категория 5e или выше, STP (экранированная витая 
пара), макс. 100 м

P	СЕРВИСНЫЙ переключатель [BOOT SV NM]
Этот переключатель используется для целей 
технического обслуживания.
Для обычной эксплуатации выберите положение [NM].

Q	Разъем заземления [SIGNAL GND]
Подключите этот разъем к цепи заземления системы.

R	Слот защиты
Вы можете подключить защитный кабель производства 
Kensington.
Инструкции по подключению приведены в инструкции 
по эксплуатации, прилагаемой к кабелю.
Защитный разъем и защитный кабель предназначены 
для предотвращения кражи. Panasonic не несет 
ответственности за любой ущерб, причиненный в 
случае кражи.

Область правой панели

USB

S T

S	Разъем USB (*2) (разъем типа-А) [USB]
Файлы проекта можно загружать и сохранять, 
подключив это устройство к USB-памяти.
Кроме того, вы можете загружать и сохранять 
неподвижные данные, сохранять файлы журналов и 
загружать встроенное ПО.

*2 �УСТРОЙСТВО USB2.0, без функции питания по 
шине USB

T	Охлаждающий вентилятор
Блокирование вентиляционных отверстий 
охлаждающего вентилятора может привести к 
неисправности.
Оставьте достаточное пространство вблизи 
вентиляционных отверстий.

Компоненты и их функции
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Область передней панели

LEVEL

W X

W	�Разъем для наушников [  ]  
(Φ3,5 мм, стерео мини-разъем)
Аудиовыход можно контролировать, подключив к 
устройству наушники.
С помощью меню настроек на данном устройстве 
можно выбрать PGM, PVW, AUX1, AUX2 или CLN.

X	Регулятор громкости монитора [LEVEL]
Данный регулятор используется для регулировки 
громкости наушников монитора.

Компоненты и их функции

Область левой панели

DC IN 16V

V U

U	�Разъем DC IN [DC IN 16 V ]  
(Пост. ток 16 В, 3,0 А)
К этому разъему подключен адаптер переменного тока, 
входящий в комплект поставки устройства.

V	Отверстие для установки кабельного зажима
Закрепите адаптер переменного тока с помощью 
прилагаемого кабельного зажима. (стр. 14)
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Подготовка

Включение и выключение питания устройства

Включение питания

1	 Установите переключатель [POWER] в 
положение ON.
При подаче питания в устройство загорается 
индикатор [POWER].

Во время запуска устройства кнопки переключения 
шины PGM и шины PST загораются синим цветом 
по порядку. Когда все кнопки выключатся, запуск 
устройства завершен.

Выключение питания

1	 Установите переключатель [POWER] в 
положение OFF.
При выключении питания устройства индикатор 
[POWER] гаснет.

Проверка видеовыхода

Ниже описаны шаги для отображения меню OSD устройства на внешнем мониторе для проверки видеовыхода 
устройства.

Отображение меню OSD на мониторе HDMI

1	 Подключите монитор HDMI к разъему HDMI 
OUT устройства.

2	 Включите питание монитора HDMI.

3	 Включите питание устройства.

4	 Нажмите и удерживайте кнопку [MENU].
Загорается индикатор кнопки [MENU], и меню OSD 
отображаются на мониторе HDMI.
Если меню OSD не отображаются на мониторе, 
обратитесь к разделу “Как принудительно вызвать 
экранные меню”.

Если меню OSD не отображается на мониторе 
HDMI даже после выполнения описанных выше 
действий, это может означать, что монитор HDMI не 
поддерживает формат вывода HDMI устройства. 
Проверьте входные характеристики монитора HDMI.

Примечание

Отображение меню OSD на мониторе SDI

1	 Подключите монитор SDI к разъему SDI OUT 
2 устройства.

2	 Включите питание монитора SDI.

3	 Включите питание устройства.

4	 Нажмите и удерживайте кнопку [MENU].
Загорается индикатор кнопки [MENU], а меню OSD 
отображаются на мониторе SDI.
Если меню OSD не отображаются на мониторе, 
обратитесь к разделу “Как принудительно вызвать 
экранные меню”.

	p Меню OSD не могут быть выведены через разъем 
SDI OUT 1.

	p Если меню OSD не отображается на SDI-мониторе 
даже после выполнения описанных выше действий, 
это может означать, что формат видео, который был 
установлен в устройстве, неверен. 
Выполните действия, описанные в следующем 
разделе, чтобы изменить видеоформат устройства. 
 См. раздел “Изменение формата видео”.

Примечания
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Изменение формата видео

Вы можете указать формат видео при выключенном питании, а затем запустить систему.
Если меню OSD не отображаются даже при подключении SDI-монитора к устройству, необходимо изменить формат 
видео. 
Выполните действия, описанные ниже, чтобы изменить видеоформат.
Если меню OSD отображаются с помощью монитора ПК, измените формат видео, выполнив действия, описанные в 
разделе “Установка формата системы”.

1	 Выключите питание устройства.

2	 	�Включите питание устройства, одновременно удерживая нажатой кнопку, соответствующую 
видеоформату, поддерживаемому SDI-монитором.

Кнопка, удерживая одновременно Видеоформат
[MENU] + Коммутатор шины А [1] 1080/59,94p

[MENU] + Коммутатор шины А [2] 1080/50p

[MENU] + Коммутатор шины А [3] 1080/59,94i

[MENU] + Коммутатор шины А [4] 1080/50i

[MENU] + Коммутатор шины А [5] 1080/29,97p

[MENU] + Коммутатор шины А [6] 1080/25p

[MENU] + Коммутатор шины В [1] 1080/24p

[MENU] + Коммутатор шины В [2] 1080/23,98p

[MENU] + Коммутатор шины В [3] 720/59,94p

[MENU] + Коммутатор шины В [4] 720/50p

	p Удерживайте кнопку нажатой до завершения запуска устройства.

3	 	�Нажмите и удерживайте кнопку [MENU].
Загорается индикатор кнопки [MENU], а меню OSD отображаются на мониторе SDI.

Если меню OSD не отображается на мониторе SDI даже после выполнения описанных выше действий, это может 
означать, что монитор SDI не поддерживает формат вывода SDI устройства. 
Проверьте входные характеристики монитора SDI.

Примечание

Подготовка
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Операции с меню OSD (экранный дисплей)

Настройки устройства выбираются с помощью меню OSD, которые отображаются на внешнем мониторе.
Здесь описывается, как работать с меню OSD.

Отображение и очистка экранных меню

Основные действия

Когда кнопка [MENU] удерживается нажатой, загорается индикатор кнопки [MENU] и экранные меню отображаются на 
внешнем мониторе.
Когда кнопка [MENU] удерживается нажатой во время отображения экранного меню, индикатор кнопки [MENU] гаснет, а 
отображение экранного меню очищается.

Изменение разъема для вывода экранных меню

Разъем вывода экранного меню можно изменить с помощью элемента Operate > Menu Out в Config [12].

SDI OUT2 Меню выводятся через разъем SDI OUT 2.

HDMI OUT Меню выводятся через разъем HDMI OUT.

SDI2+HDMI Меню выводятся как с разъема SDI OUT 2, так и с разъема HDMI OUT.

Кроме того, используя настройку в OUT6 (UVC OUT) > Menu Out в [11] Output, можно изменить настройки вывода 
экранного меню с USB-разъема (USB STREAM OUT, разъем типа-C).

On Экранные меню выводятся через USB-разъем (разъем типа-C).

Off Экранные меню не выводятся через USB-разъем (разъем типа-C).

Меню OSD не могут быть выведены через разъем SDI OUT 1.
Примечание

Как принудительно вызвать экранные меню

При одновременном нажатии кнопок [МЕНЮ] и [SHIFT] во время работы устройства выполняется следующая 
автоматическая установка:

	p Разъем SDI OUT 2 и разъем HDMI OUT настроены для вывода экранных меню. Кроме того, включается выход через 
USB-разъем (разъем типа-C).

	p Размер экрана, выводимый через разъем HDMI OUT, установлен на “Auto”.

Подготовка
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Настройка меню и переключение между меню

Настройка меню устройства

Здесь экранные меню состоят из “главного меню” и “подменю”, которые имеют несколько слоев.

Главное меню:
Здесь перечислены элементы подменю.

Подменю:
Отображаются элементы подменю нижних слоев.
Здесь отображаются элементы настройки и сами настройки. 
Настройки можно изменить на этом экране.

Перемещение между главным меню и подменю

Переход из главного меню в подменю
Чтобы выбрать элемент подменю:

Вращайте экранное меню/меню времени, чтобы выбрать нужный элемент.
Ввод параметра, выбранного для элемента подменю:

Нажмите экранное меню / меню времени, чтобы ввести настройки выбранного элемента.

Переход из подменю в подменю верхнего слоя или в главное меню
Нажмите кнопку [EXIT], чтобы вернуться в подменю верхнего слоя или в главное меню.

 �Вращайте экранное меню/меню 
времени, чтобы выбрать элемент 
подменю.

 �Нажмите экранное меню / меню 
времени, чтобы ввести настройки 
выбранного элемента.

 �Нажмите кнопку [EXIT].

Главное меню

Подменю

Знак “>” отображается справа от 
элемента, если этот элемент имеет 
подменю.

Знак “>” отображается справа от элемента, 
если этот элемент имеет дополнительные 
подменю.

Установки
Знак “▼” отображается справа от элементов, 
значения которых можно изменить.

Элементы подменю

Отображение меню, состоящего более чем из одной страницы

Если меню содержит несколько пунктов настройки, они отображаются более чем на одной странице.
В данном руководстве отображается только один экран меню, даже если этот экран состоит из нескольких страниц.

Подготовка
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Операции с использованием подменю

1	 Выбор строки с параметром настройки.
Выделенный курсор перемещается вверх и вниз при повороте экранного меню/меню времени.
Когда курсор находится на строке элемента настройки, который вы хотите изменить, нажатие экранного меню/ меню 
времени позволяет изменить значение настройки.
Кроме того, знак “>” отображается справа от элемента, если этот элемент имеет дополнительные подменю.
Подменю на слое ниже отображаются при нажатии меню OSD/TIME.

Вращайте меню OSD/TIME, 
чтобы выбрать элемент.

Нажмите меню OSD/
TIME, чтобы ввести 
элемент.

Теперь значение настройки можно 
изменить.

2	 	Изменение настройки.
Существует два следующих способа изменить значения настроек:

	p Выпадающее меню
Пока курсор находится на строке с параметром настройки, который вы хотите изменить, при нажатии на меню OSD/
TIME отображается выпадающее меню с возможными значениями.
Поверните меню OSD/TIME, чтобы переместить курсор на установочное значение, затем нажмите меню OSD/TIME, 
чтобы обновить данное значение.

	p Изменение числового значения
Нажмите меню OSD/TIME, находясь на строке, для выбора элемента настройки, который вы хотите изменить, чтобы 
изменить настройку.
Вращайте меню OSD/TIME, чтобы изменить значение.
Чем быстрее вы вращаете меню, тем быстрее меняются значения.

Вращайте меню OSD/TIME, чтобы 
изменить значение, которое мигает.

[Возврат к настройкам по умолчанию]
При нажатии и удержании поворотного меню OSD/TIME цифровое значение возвращается к значению по умолчанию.

При изменении значений для обычных элементов настройки эти изменения отражаются сразу же, однако для 
некоторых элементов настройки (таких как Формат) изменения не будут отражены до тех пор, пока кнопка меню OSD/
TIME не будет нажата после внесения изменений.
Курсор мигает на данном элементе.

Примечание

Подготовка
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Ввод строки символов

Некоторые элементы настройки на этом устройстве требуют ввода строки символов.

Нажмите меню OSD/TIME, находясь на строке элемента настройки, который вы хотите изменить, чтобы ввести символы.
Появится экран выбора символов, похожий на клавиатуру, а желтая рамка указывает на выбор символа.
Вращайте меню OSD/TIME, чтобы выбрать символ, затем нажмите на меню OSD/TIME, чтобы ввести символ.
При выборе следующих значений изменяются доступные виды символов.

[A-a] Переключение между символами верхнего и нижнего регистра

[BS] Удаляется один символ

[123#+=] Переключение на ввод цифр и символов

[!?~] Переключение на ввод символов

[   ] Пробел

[  ] Перемещение курсора влево

[  ] Перемещение курсора вправо

[Enter] Подтверждение ввода строки символов и возврат к строке настроек

[Load TEXT] Открытие экрана для загрузки строк символов из USB-памяти

Примечания о возможности [Load TEXT]

При выборе [Load TEXT] вы можете загрузить текстовый файл (.txt), который был сохранен в папке “HS\HSW10\TEXT” в 
USB-памяти, отформатированной данным устройством, и использовать содержимое на строке символов.
Элемент [Load TEXT] нельзя выбрать, если USB-память не подключена.

[Load TEXT] можно выбрать, если USB-память подключена.

Подготовка
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После выбора [Load TEXT] выберите текстовый файл, который вы хотите загрузить, в появившемся диалоговом окне.

Для текстового файла существуют следующие ограничения:
	p При вводе многобайтовых символов, например, на японском языке возникает ошибка загрузки.
	p Длина строки символов ограничена.
	p Символы перевода строки автоматически удаляются.

Указания, используемые в настоящей инструкции по эксплуатации

Действия с элементами настройки показаны в данном руководстве следующим образом.
Пример: �При действиях с элементом “[1] WIPE > BKGD Transition > Direction”.

[1] WIPE > 		
	 BKGD Transition > Direction	

Подменю  
Параметр

Подготовка
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Функция делегирования меню

При двойном нажатии следующих кнопок меню переключается на делегированное меню.
(Функция делегирования меню)
Также выполняется операция, соответствующая нажатой кнопке.

<Перечень функций делегирования меню>
Кнопка Выбранное меню

AUTO

[5] Time
FTB
KEY 1 ON
KEY 2 ON
MIX/WIPE [1] WIPE

KEY 1 F/S • При “On” PinP
[3] Key > PinP
• Когда PinP “Off” и в качестве вставки выбрана “Chroma”
[4] ChromaKey
• Когда PinP “Off” и в качестве вставки выбрана не “Chroma”
[3] Key

KEY 2 F/S • При “On” PinP
[3] Key > PinP
• Когда PinP “Off” и в качестве вставки выбрана не “Chroma”
[3] Key

USER 1

[12] Config > User Button

USER 2
USER 3
USER 4 (SHIFT + USER 1)

USER 5 (SHIFT + USER 2)

USER 6 (SHIFT + USER 3)

Отображение состояния шины

При повторном нажатии кнопки [MENU] во время отображения экранного меню отображается экран состояния.
Кроме того, при нажатии и удержании кнопок шин A, B или AUX на экранном меню отображается экран состояния.

AMB:F
GRN:S

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

Подготовка
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Фоновый переход

Выбор шины

Нажмите одну из кнопок пересечения для выбора 
материала, который будет использоваться для фонового 
перехода. 
В зависимости от рабочего состояния нажатая кнопка 
будет гореть одним из двух цветов.

Индикатор 
светится 
красным 
цветом

Когда выбранные входные сигналы 
выводятся на PGM.
(Однако, при выполнении операций FTB он 
светится желтым цветом.)

Светится 
зеленым 
цветом

Когда выбранные входные сигналы не 
выводятся на PGM.

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

		   Индикатор светится красным цветом
		   Светится зеленым цветом

	p Если держать нажатыми кнопки коммутации, номера 
кнопок и названия входных материалов, назначенных 
кнопкам, будут отображены на встроенном дисплее 
в виде списка, пока кнопки коммутации будут 
удерживаться нажатыми.

Выбор шины с помощью функции SHIFT

Функция SHIFT позволяет назначить два материала — 
фронтальный материал и тыловой материал — одной 
кнопке, а также выбрать материалы с помощью кнопки 
[SHIFT].
Всего можно назначить 12 материалов — фронтальные 
материалы (от 1 до 6) и тыловые материалы (от 
7 до 12) — по трем группам 12 коммутационных 
кнопок, независимо от того, являются ли данные 
кнопки коммутационными кнопками шины PGM/A, 
коммутационными кнопками шины PST/B или 
коммутационными кнопками шины AUX.

All SHIFT используется для переключения всех 
материалов кнопок пересечения шины PGM/A, кнопок 
пересечения шины PST/B или кнопок пересечения шины 
AUX с фронтальных материалов на тыловые материалы 
или наоборот.

Тыловой материал выбирается, только когда нажата 
кнопка [SHIFT].

	p При выборе тыловых материалов (7 – 12) кнопка 
[SHIFT] горит желтым цветом.

Выбор режима шины

Выберите режим шины A/B или триггерную систему 
(систему PGM/PST) в меню настроек.

Выберите режим шины с помощью следующего меню:

[12] Config >
	 Operate > Bus Mode

A/B Когда рычаг микшера находится в положении 
A, сигналы, выбранные шиной A, заменяются 
материалами PGM.
Когда рычаг микшера находится в положении 
B, сигналы, выбранные шиной B, заменяются 
материалами PGM.

PGM-A/
PST-B

С помощью триггерной системы сигналы, 
выбранные шиной A, всегда заменяются 
материалами PGM, а сигналы, выбранные 
шиной B, всегда заменяются материалами 
PST.

PGM-B/
PST-A

С помощью триггерной системы сигналы, 
выбранные шиной B, всегда заменяются 
материалами PGM, а сигналы, выбранные 
шиной A, всегда заменяются материалами 
PST.

Выбор режима перехода

Выберите режим перехода с помощью кнопок [MIX] и 
[WIPE].

Переключите режим фонового перехода с помощью 
кнопки переключения [MIX/WIPE].
Загорается индикатор выбранного режима.
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Переход вручную

С помощью рычага регулятора переходы можно 
осуществлять вручную.
Если начать перемещение рычага во время выполнения 
автоперехода, автоматический режим перехода 
переключится на ручной режим, как только рычаг 
пройдет позицию, соответствующую завершенной части 
автоперехода.
Сигнальные светодиоды шины слева от рычага 
регулятора указывают программное выходное состояние 
шины.

Горит только 
светодиод A

Выход PGM/A шины

Горят светодиоды 
A и B

При переходе

Горит только 
светодиод B

Выход PST/B шины

Выберите цель перехода с помощью следующей 
операции меню:

[12] Config >
	 Operate > Fader

Любая из следующих целей, для которых должен быть 
выполнен переход, может быть установлена с помощью 
рычажка фейдера.

BKGD Фоновый переход
KEY1 Основной переход
BKGD+KEY1 Фоновый переход и основной переход будут 

выполняться одновременно.
No Assign Переходы не выполняются даже при нажатии 

на рычажок фейдера.

Автоматический переход

	p При нажатой кнопке [AUTO] переход выполняется 
автоматически с заданным временем перехода.

	p Переход осуществляется в оставшееся время при 
нажатии кнопки [AUTO], пока используется рычаг 
микшера.

Автоматическая настройка времени перехода 
производится с помощью следующих операций с меню:

[5] Time >
	 BKGD

Выберите единицы отображения с помощью следующих 
операций с меню:

[12] Config >
	 Operate > Time Unit

Sec Время отображается в количестве секунд.
Frame Время отображается в количестве кадров.

Можно задать любой период времени от 0 до 999f. 
Время, которое можно задать при использовании секунд 
в качестве единицы отображения, зависит от формата 
системы.

59.94i макс. 33s09f 29.97p макс. 33s09f
50i макс. 39s24f 25p макс. 39s24f
59.94p макс. 16s39f 24p макс. 41s15f
50p макс. 19s49f 23.98p макс. 41s15f

	p Даже если в качестве настройки функции рычажка 
фейдера выбраны “KEY1”, “BKGD+KEY1” или “No 
Assign”, целью для выполнения автоматических 
переходов служит фон.

Переход с обрезанием

При нажатии кнопки [CUT] переход выполняется 
немедленно.

	p Даже если в качестве настройки функции рычажка 
фейдера выбраны “KEY1”, “BKGD+KEY1” или “No 
Assign”, фон всегда служит целью для выполнения 
резких переходов.

Основные действия



31

Основные действия

Сдвиг

Выбор эффекта сдвига

Выберите шаблон сдвига с помощью следующих 
операций с меню:

[1] WIPE >
	 BKGD Pattern

<Таблица эффектов сдвига>
Шаблоны и значения сдвига

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

Выбор направления сдвига

Выберите направление сдвига для фоновых переходов с 
помощью следующих операций с меню:

[1] WIPE >
	 BKGD Transition > Direction

(Переходы со вставкой задаются при помощи меню. 
Заданное здесь направление не имеет для них силы.)
 См. “Переходы со вставкой”.

A

N

B

B

A

B

A

B

A

B

R

A

A B

A

N/R

B

A B

При выборе [Normal]:
	� Вытеснение осуществляется в нормальном 

направлении.
При выборе [Reverse]:
	 Вытеснение осуществляется в обратном направлении.
При выборе [N/R]:
	� По завершении перехода нормальное направление 

вытеснение заменяется на обратное, и наоборот. 

Оформление эффекта сдвига (граница, 
плавность)

По краям сдвигаемых кадров можно добавить границы, А 
также ввести эффект плавности для фоновых переходов.

Настройка границ и эффекта плавности

1	Выберите вкл./выкл. границ с помощью следующих 
операций с меню:

[1] WIPE >
	 BKGD Transition > Border > Border

2	Установите ширину границ с помощью следующих 
операций с меню:

[1] WIPE >
	 BKGD Transition > Border > Width

3	Настройте эффект плавности с помощью следующих 
операций с меню:

[1] WIPE >
	 BKGD Transition > Border > Soft

Если в качестве установки для пункта меню Border была 
выбрана опция “On”, в качестве величины эффекта 
плавности будет указано отношение интенсивности 
эффекта плавности к ширине границы. 
Если к сдвигу нужно добавить только эффект плавности, 
выберите опцию “Off” в качестве установки для пункта 
меню Border.

Настройка цвета границы

Отрегулируйте параметры цвета, насыщенности и яркости 
границ с помощью следующих операций с меню:

[1] WIPE >
	 BKGD Transition > Border Color > Hue

[1] WIPE >
	 BKGD Transition > Border Color > Sat

[1] WIPE >
	 BKGD Transition > Border Color > Lum
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 Для вызова предустановленного цвета
Выберите предустановленный цвет с помощью 
следующих операций с меню и нажмите шкалу OSD/TIME:

[1] WIPE >
	 BKGD Transition > Border Color > Load

	p При нажатии шкалы OSD/TIME установленные 
прежде значения будут отменены и заменены 
предустановленными значениями цвета.

	p Для сохранения значений, установленных перед 
вызовом предустановленного цвета, обратитесь к 
пункту “Память кадров”.

Настройка начального положения эффекта 
вытеснения

Начало сдвига можно установить в любом желаемом 
положении.

Целевые шаблоны:
9, 10, 11, 12, 13

1	Установите положение начала сдвига с помощью 
следующих операций с меню:

[1] WIPE > 
	 BKGD Transition > Position > X-Position

[1] WIPE > 
	 BKGD Transition > Position > Y-Position

[1] WIPE > 
	 Key1 Transition > Position > X-Position

[1] WIPE > 
	 Key1 Transition > Position > Y-Position

Данная установка возможна только при выборе 
целевого шаблона для фонового шаблона или шаблона 
вставки.

2	С помощью либо рычага регулятора, либо нажав 
на кнопку [AUTO] проверьте выполнения эффекта 
вытеснения.  
(Если, например для положений X и Y выбрано 
значение –50, следующий кадр (или вставка) 
появляются из левого нижнего угла экрана и 
вытеснение происходит до тех пор, пока кадр (или 
вставка) не переместятся к центру экрана.)

<Диапазон настройки параметров X-Pos, Y-Pos>

Y-Position

X-Position

		   Внутри области экрана
		   За пределами области экрана

Основные действия
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Вставка
При этой операции происходит смешивание фоновой 
картинки с другим изображением. 
Можно выполнить настройку параметров вставки и 
добавить края для комбинированного изображения.

В качестве материалов для создания фоновых 
изображений имеются входы Key1 и Key2.
На рисунке ниже приведены настройки для приоритета 
(положение изображения) по умолчанию.

<Установки приоритета по умолчанию>

Key1

Key2

Фоновое изображение

Можно задать приоритетность для входов Key1 и Key2.
 См. “Установка приоритетности”.

Комбинированная работа эффектов замещения 
представлена на рисунке ниже.

<Как работает их комбинация>

HSW10

HSW10

Фон

Источник 
вставки

Заполнение 
вставки

Изображение 
на выходе Инверсия

Выбор типа вставки
1	Выберите целевую вставку (Key1/Key2) с помощью 

следующих операций с меню:

[3] Key >
	 Key Select

2	Выберите тип вставки с помощью следующих операций 
с меню:

[3] Key >
	 Key Type

Lum(ChromaOff)
(яркостная 
вставка · 
цветность выкл./
автовставка)

Служит для создания сигналов вставки 
из яркостной компоненты исходного 
ключевого сигнала. 

Lum(ChromaOn)
(яркостная 
вставка · 
цветность выкл./
автовставка)

Служит для формирования сигналов 
вставки из компонент яркости или 
цветности вставляемого сигнала.

Linear
(линейная 
вставка/ключ 
EXT)

Служит для создания сигналов вставки 
из яркостной компоненты исходного 
ключевого сигнала. 
Используется в том случае, если 
сигнал заполнения вставки и исходный 
ключевой сигнал отличаются друг от 
друга.

Chroma
(вставка 
цветности/
автовставка)

Служит для формирования сигналов 
вставки с помощью заданного тона 
вставляемого сигнала в качестве 
опорного.

Full
(полная вставка/
автовставка)

Служит для формирования сигналов 
вставки с помощью изображений на 
полном экране в качестве исходных 
сигналов.

Поскольку вставка яркости и цветовая вставка 
функционируют как собственные вставки, в качестве 
исходных сигналов используются вставляемые 
сигналы. Для полной вставки в качестве исходных 
сигналов используются изображения на полном экране. 
Если в качестве вставки была выбрана вставка 
яркости, цветовая вставка или полная вставка, сигналы 
вставки не изменятся даже в случае переключения 
исходных сигналов.
Для линейной вставки в качестве исходного сигнала 
вставки используйте материал с черным фоном и 
белыми символами или фигурами. 
Материал, не являющийся черно-белым не может 
правильно комбинироваться.
Материал с белым фоном и черными символами и т.д., 
можно использовать в качестве вставки, обратив его 
цвета с помощью функции инверсии вставки.
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3	При выборе яркостной вставки, компоненту 

цветности можно добавить для генерации сигналов 
автоматической вставки. (Такой подход нельзя 
использовать для линейной вставки.) 
Выберите яркость (Chroma On) или яркость (Chroma 
Off) для определения типа вставки.

Chroma On В дополнение к яркостной компоненте для 
генерации сигналов вставки используется 
также компонента цветности.
Такая настройка служит для использования 
в качестве сигналов вставки цвета с 
компонентой малой яркости (например, при 
формировании символов синего цвета).

Chroma Off Сигналы вставки генерируются только с 
помощью компоненты яркости.

4	Выберите тип заполнения с помощью следующих 
операций с меню:

[3] Key >
	 Fill

Bus В качестве ключевого сигнала заполнения 
используется сигнал шины.

Matte В качестве сигнала заполнения вставки 
служит внутренний сигнал маски.

Выбор материала вставки

Выбор сигнала заполнения и сигнала источника 
вставки

Нажмите кнопку [KEY] в области выбора шины AUX и 
включите селектор выбора сигнала вставки (индикатор 
светится желтым цветом) и сигнала заполнения 
(индикатор светится зеленым цветом).

<Выбор сигнала заполнения вставки>
Когда индикатор кнопки [KEY] светится желтым цветом, 
нажмите один из переключателей коммутации шины 
AUX от 1 до 6 для выбора источника сигнала заполнения 
вставки.
Индикатор кнопки выбранной точки микширования AUX 
загорится желтым цветом. (Он будет светиться красным 
цветом, если выбранный сигнал выводится с разъема 
PGM.)

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

		   Светится желтым цветом

<Выбор источника сигнала вставки>
Когда индикатор кнопки [KEY] светится зеленым цветом, 
нажмите один из переключателей коммутации шины AUX 
от 1 до 6 для выбора источника сигнала вставки.
Индикатор кнопки выбранной точки микширования AUX 
загорится зеленым цветом. (Он будет светиться красным 
цветом, если выбранный сигнал выводится с разъема 
PGM.)
Поскольку вставка яркости и цветовая вставка 
функционируют как собственные вставки, в качестве 
исходных сигналов используются вставляемые сигналы. 
Если в качестве вставки была выбрана вставка яркости 
или цветовая вставка, сигналы вставки не изменятся 
даже в случае переключения исходных сигналов.

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

		   Светится зеленым цветом



35

Выбор сочетания сигнала заполнения вставки и 
сигнала источника вставки

1	Выберите целевую вставку (Key1/Key2) с помощью 
следующих операций с меню:

[3] Key >
	 Key Select

2	Установите сопряжение сигналов вставки с помощью 
следующих операций с меню:

[3] Key >
	 Key Signal Coupling

3	Установите заполнение/источник с помощью 
следующих операций с меню:

[12] Config >
	  Key Source Signal Coupling > Fill/Source

	p Если для Fill/Source выбрана установка Fill to Source, 
выберите, что использовать в качестве источника 
для заполнения.
	p Или же, если выбрана установка Source to Fill, 
выберите, что использовать в качестве заполнения 
для выбранного источника.

<Сопряжение сигналов вставки>
Когда кнопка [KEY] горит янтарным цветом, можно 
выбрать сигнал заполнения вставки, а когда она горит 
зеленым цветом, можно выбрать сигнал источника 
вставки.

Key Signal Coupling

Independent Если выбрана установка Fill to Source, можно 
задать источник, связанный с заполнением, 
отдельно от других параметров KEY.
Если выбрана установка Source to Fill, можно 
задать источник, связанный с заполнением, 
отдельно от других параметров KEY.

Coupling Следуйте настройкам элементов, отличных 
от Fill/Source, в рамках сопряжение сигналов 
вставки.

<Задать источник>
При выборе сигнала заполнения вставки сигнал источника 
вставки также переключается автоматически.

<Задать заполнение>
При выборе сигнала источника вставки сигнал заполнения 
вставки переключается автоматически.

Выбор цвета матового заполнения

Отрегулируйте параметры цвета, насыщенности и яркости 
матового заполнения с помощью следующих операций с 
меню:

[3] Key >
	 Fill Matte > Hue

[3] Key >
	 Fill Matte > Sat

[3] Key >
	 Fill Matte > Lum

■  Для вызова предустановленного цвета
Выберите предустановленный цвет с помощью 
следующих операций с меню и нажмите шкалу OSD/TIME:

[3] Key >
	 Fill Matte > Load

	p При нажатии шкалы OSD/TIME установленные 
прежде значения будут отменены и заменены 
предустановленными значениями цвета.

	p Для сохранения значений, установленных перед 
вызовом предустановленного цвета, обратитесь к 
пункту “Память кадров”.

Основные действия
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Переходы со вставкой
1	Выберите режим перехода с помощью следующей 

операций с меню:

[12] Config >
	 Operate > Fader

Вы можете задать цель перехода при нажатии на 
рычажок фейдера следующим образом:

BKGD Фоновый переход
KEY1 Основной переход
BKGD+KEY1 Фоновый переход и переход вставки будут 

выполняться одновременно
No Assign При нажатии на рычаг фейдера переход не 

выполняется

2	Выберите тип перехода (MIX/WIPE) с помощью 
следующей операций с меню:

[3] WIPE > 
	 Key1 Transition > Type

При выборе WIPE выберите шаблон сдвига с помощью 
следующих операций с меню:

[1] WIPE >
	 Key1 Pattern

<Таблица эффектов сдвига>
Шаблоны и значения сдвига

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

3	Настройте время перехода с помощью следующей 
операций с меню:

[5] Time >
	 Key1

[5] Time >
	 Key2

Настройте время перехода идентичное фоновому 
переходу.

4	Установите направление сдвига с помощью следующих 
операций с меню:

[3] WIPE >
	 Key1 Transition > Keyout Pattern

Normal Картинка выходящего замещения движется в 
том же направлении, что и картина входящего 
замещения.

Reverse Картинка выходящего замещения движется 
в противоположном направлении, по 
отношению к картинке входящего замещения.

<Примеры шаблонов>

Эффект 1
Эффект 2

Шаблоны сдвигов 9 
– 16

Key in

Key out 
(нормальное)

Key out 
(реверсное)

: Обозначены области объединения вставок.

	p Шаблоны сдвигов 9 – 16 соответствуют примеру 
шаблона 2.

5	Выполнение перехода. 
Используйте рычажок фейдера, чтобы выполнить 
переход вручную.

Автоматический переход со вставкой

При нажатии кнопки [KEY ON] в блоке перехода переход 
будет автоматически выполнен при наступлении 
установленного времени перехода.
Во время включения индикатор кнопки [KEY ON] мигает 
красным цветом, а по завершении перехода (плавного 
введения) он светится красным цветом непрерывно.
Если нажать кнопку [KEY ON] после полного завершения 
включения изображения, будет выполнен обратный 
переход изображения (выключение).
Во время выключения индикатор кнопки [KEY ON] мигает 
красным цветом, а по завершении перехода он гаснет. 
Если кнопку [KEY ON] нажать во время выполнения 
перехода, направление перехода изменяется на 
противоположное.

Основные действия
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Предварительный просмотр вставки

Картинки предварительного просмотра вставки могут 
выводиться на монитор для проверки и настройки.

Установите предпросмотр с помощью следующих 
операций с меню:

[3] Key >
	 PVW

Соединение меню

PVW изображения
Для параметра PVW выбрано значение OFF:

Состояние PGM отображается в PVW.
Однако оно не отражается в состоянии перехода.

Для параметра PVW выбрано значение ON:
При установке для PVW значения “On” изображения 
PGM отображаются после PVW.

Фон PVW
Изображения BKGD для PVW будут PST независимо от 
настроек.

Когда вы нажимаете пользовательскую кнопку, 
назначенную для включения/ выключения, она 
переключается между включением (кнопка загорается) и 
выключением (кнопка гаснет).
(Соответствующие параметры пользовательских кнопок – 
KEY1_PVW/KEY2_PVW.)

Меню Пользовательская 
кнопка

При нажатии 
пользовательской кнопки

On Горит Off: гаснет

Off Гаснет On: горит

Настройка яркостной и линейной вставок

Эти процедуры выполняются для настройки параметров 
ключа яркости и линейного ключа.

1	Настройте четкость вставки с помощью следующих 
операций с меню:

[3] Key >
	 Key Adjust > Clip

[3] Key >
	 Key Adjust > Gain

[3] Key >
	 Key Adjust > Density

2	Настройте инверсию вставки с помощью следующих 
операций с меню:

[3] Key >
	 Key Adjust > Invert

При выборе опции “On”, происходит инверсия 
внутреннего сигнала вставки.

Parameter Описание настройки Диапазон 
настройки

Clip Опорный уровень генерации 
сигналов вставки

От 0.0 до 
108.0

Gain Амплитуда вставки От 0.0 до 
200.0

Density Плотность вставки От 0.0 до 
100.0

Invert Инверсия сигнала вставки On, Off

Основные действия



38

Основные действия

Настройка ключа цветности

Как изменить параметры цветовой вставки.

Прежде чем приступить к настройкам, выберите 
“Цветность” в качестве типа вставки, используя пункт 
меню ниже.

[3] Key >
	 Key Type

Для цветовой вставки создается сигнал вставки, 
использующий определенный цветовой оттенок в 
качестве эталона. 
Например, сигнал вставки создается путем определения 
цвета фона по изображению человека, стоящего на фоне, 
имеющем определенный цвет, и добавляется другой фон.

В этом устройстве используется система, область которой 
обозначена прямоугольной рамкой. Результат усреднения 
цветов пикселей внутри этой области используется в 
качестве эталонного цвета цветовой вставки (эталон 
вставки), а максимальное отклонение от среднего 
значения используется в качестве радиуса овала 
цветовой вставки.
Могут быть сгенерированы цветовые вставки, 
соответствующие образцу цветовой области (область   
на рисунке).



Y

Цветовая вставка овальной 
формы

Цветность
Радиус оттенка

Радиус насыщенности
Оттенок

Выполнение автоматической выборки

При указании области, в которую должен быть вставлен 
фон, производится выборка компонентов цветности.

■ Marker

[4] ChromaKey >
	 Marker

Этот элемент используется для установки маркера 
выборки в положение ВКЛ. для отображения маркера на 
изображении PVW.

■ Marker Pos

[4] ChromaKey >
	 Marker Position

Этот элемент используется для настройки координат X, Y 
и размера маркера выборки.

■ Sample

[4] ChromaKey >
	 Sample

Нажмите на шкалу OSD/TIME, чтобы отобрать 
компоненты цветности области, отмеченной маркером 
выборки.

	p Когда отбор завершен, выводится изображение, 
полученное путем объединения цветовой вставки с 
изображением PVW. (Перевод функций PVW вставки в 
положение ВКЛ.)
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Другие настройки цветовой вставки

■ Marker Aspect

[4] ChromaKey >
	 Marker Aspect

Этот элемент используется для изменения соотношения 
сторон маркера образца.

■ Ref Adjust

[4] ChromaKey >
	 Ref Adjust

Этот элемент позволяет изменить цвет, который будет 
использоваться в качестве эталонной цветовой вставки, 
из выбранных цветов.

Hue (Hue) Оттенок, который будет 
использоваться в качестве эталонного

Sat (Saturation) Насыщенность цвета, которая будет 
использоваться в качестве эталонной

Lum (Luminance) Яркость, которая будет 
использоваться в качестве эталонной

	p После завершения автоматического отбора 
отображаются отобранные значения.

■ Y-Influence

[4] ChromaKey >
	 Y-Influence

Этот элемент используется для установки степени 
воздействия компонента Y (яркость). 
Чем выше установленное значение, тем больше 
воздействие, а при установке на “0” компонент яркости не 
оказывает никакого воздействия.

■ Radius

[4] ChromaKey >
	 Radius

Данный элемент используется для установки диапазона 
цветности.

Hue (цветность-радиус) Диапазон определяемого 
оттенка

Sat (насыщенность-
радиус)

Диапазон определяемой 
насыщенности

	p После завершения автоматического отбора 
отображаются отобранные значения.

■ Soft

[4] ChromaKey >
	 Soft

Данный элемент используется для установки эффекта 
плавности на границе определяемого цвета.

■ Cancel

[4] ChromaKey >
	 Cancel

Данный элемент используется для регулирования 
приглушения цвета.
Приглушение цвета регулируется, если цвет фона 
накладывается на изображение заполнения.

Настройка цветовой вставки
Настройка цветовой вставки выполняется с помощью 
действий, приведенных ниже.

1	��Запустите автоматический отбор и выберите цвет.
2	��Используя “Radius”, выполните настройку так, 

чтобы цвет фона был полностью определен.
3	�Используя “Soft”, точно отрегулируйте границу 

сигнала вставки.

Примечание
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Оформление эффектов вставки

По краям вставки можно добавить границы, тени и другие 
краевые эффекты.

Настройка краев вставки

1	Выберите тип кромки с помощью следующей операций 
с меню:

[3] Key >
	 Edge > Type

Off Краевой эффект отсутствует.
Border По всему краю вставки добавляется граница.
Drop Добавляется диагональная граница.
Shadow Добавляется тень.
Outline Добавляется контур (только граница без 

заполнения).

Border Drop

OutlineShadow

2	Настройте ширину кромки с помощью следующих 
операций с меню:

[3] Key >
	 Edge > Width

3	Выберите направление (45°) для добавления “Drop” и 
“Shadow” с помощью следующих операций с меню:

[3] Key >
	 Edge > Direction

(Сверху)

(Снизу)

(Справа)(Слева)

225180 270

135 315

4590 0

4	Выберите плотность кромки с помощью следующих 
операций с меню:

[3] Key >
	 Edge > Density

Выбор установок заполнения краев

Можно установить материалы, которые будут вставлены в 
качестве краев.

Выберите материал кромки с помощью следующих 
операций с меню:

[3] Key >
	 Edge > Fill

Color Используется цвет, установленный при 
использовании пункта Edge Color.

CBGD1
Используется цветной фон.CBGD2

Still1 Используется видеопамять неподвижных 
изображений (Still1).

Still2 Используется видеопамять неподвижных 
изображений (Still2).

Настройка цвета границы

Отрегулируйте параметры цвета, насыщенности и яркости 
кромки с помощью следующих операций с меню:

[3] Key >
	  Edge > Color > Hue

[3] Key >
	  Edge > Color > Sat

[3] Key >
	  Edge > Color > Lum

■  Для вызова предустановленного цвета
Выберите предустановленный цвет с помощью 
следующих операций с меню и нажмите шкалу OSD/TIME:

[3] Key >
	  Edge > Color > Load

	p При нажатии шкалы OSD/TIME установленные 
прежде значения будут отменены и заменены 
предустановленными значениями цвета.

	p Для сохранения значений, установленных перед 
вызовом предустановленного цвета, обратитесь к 
пункту “Память кадров”.
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Маскирование сигналов вставки

Приведенные ниже операции служат для маскирования 
сигналов вставки с помощью встроенных сигналов 
маскирования.

1	Установите режим маскировки с помощью следующих 
операций с меню:

[3] Key >
	 Mask > Size

Off Сигналы вставки не маскируются.
Manual Будет маскирована область, установленная с 

помощью подменю “Mask Adjust”.
4:3 Для сигналов будет установлено 

маскирование в формат кадра 4:3.

2	Настройте необходимость маскировки сигнала с 
помощью следующих операций с меню:

[3] Key >
	 Mask > Invert

On Сигнал маски инвертируется.
Off Сигнал маски не инвертируется.

3	Установите область маскировки с помощью следующих 
операций с меню:

[3] Key >
	 Mask > Position > Left

[3] Key >
	 Mask > Position > Top

[3] Key >
	 Mask > Position > Bottom

[3] Key >
	 Mask > Position > Right

Parameter Описание настройки Диапазон значений/
Исходное значение

Left Положение левого 
края вставки

От −50.00 до 50.00/
−25.00

Top Положение верхнего 
края вставки

От −50.00 до 50.00/
25.00

Bottom Положение нижнего 
края вставки

От −50.00 до 50.00/
−25.00

Right Положение правого 
края вставки

От −50.00 до 50.00/
25.00

Значение параметра Left не может превышать 
значения параметра Right (и наоборот) и, аналогично, 
Значение параметра Top не может превышать значения 
параметра Bottom (и наоборот).

<Настройки маскирования вставки> (на рисунке 
показаны значения, заданные по умолчанию)

0 

50 

-50 
500-50

TOP (25) 

BOTTOM (-25)

(25)
RIGHT

(-25)
LEFT  

Замаскированная область

Область, где сигнал вставки 
действителен

Диапазон видеосигнала

Установка приоритетности

Можно задать соответствующие положения изображений, 
когда изображения Key1 и Key2 накладываются друг на 
друга.

Установите относительное положение 2-го и 1-го 
элементов с помощью следующей операции с меню:

[3] Key >
	 Key Priority > Key*

*	� Отображается только меню, выбранное с помощью [3] 
Key > отображается Key Select.

1st Настройте верхнее изображение.

2nd Настройте нижнее изображение.

2nd:
 Key1

1st:
 Key2
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PinP (картинка в картинке)
С фоновой картинкой может комбинироваться другое 
изображение.
Данное устройство поддерживает PinP для 2 каналов, 
Key1 и Key2.

Выберите активно (вкл.)/неактивно (выкл.) для PinP с 
помощью следующих операций с меню:

[3] Key >
	 PinP > PinP

Выбор канала PinP и материала

Нажмите кнопку [Key1] или [Key2] из кнопок переключения 
шины AUX.

Нажатая кнопка загорится.
Состояние, при котором были выбраны материалы PinP, 
будет присвоено кнопкам коммутации шины AUX.

Выбранная кнопка пересечения шины AUX горит 
янтарным цветом. 
(Она будет гореть красным цветом, если выбранный 
сигнал является выходным сигналом PGM.)

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Выбор формы

В качестве формы, используемой для объединения 
изображений PinP, можно выбрать значение Square 
(квадрат), Circle (круг), Heart (сердце), Flower (цветок) или 
Star (звезда).

	p Эта функция действует только при установке для 
параметра [Full Key] значения [ON].

1	Выберите форму при объединении изображений с 
помощью следующей операции в меню:

[3] Key >
	 PinP > Shape

2	Выберите коэффициент пропускания (затемнение) 
при объединении изображений с помощью следующей 
операции в меню:

[3] Key >
	 PinP > Density

Включение/выключение Full Key

Выберите активно (вкл.)/неактивно (выкл.) для Full Key с 
помощью следующих операций с меню:

[3] Key >
	 PinP > Full Key

On Независимо от значений, заданных с 
помощью [3] Key > Key Type, изображения 
PinP создаются с помощью Full Key.

Off Изображения PinP создаются в соответствии 
со значениями, заданными в [3] Key > Key 
Type.

Настройка эффекта PinP

Настройка положения и размера PinP

Задайте координаты X и Y и размер с помощью 
следующих операций в меню:

[3] Key >
	 PinP > Position > X-Position

[3] Key >
	 PinP > Position > Y-Position

[3] Key >
	 PinP > Position > Size
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Связывание Key1 PinP и Key2 PinP

Для изображений Key1 PinP и Key2 PinP выполняются 
симметрические операции для оси, координаты которой 
были установлены. 
Эталоном служит изображение PinP в меню, в котором 
выполняются операции.

Связывание Key1 PinP и Key2 PinP

Выберите положение, которое будет использоваться в 
качестве ориентира, с помощью следующей операции в 
меню:

[3] Key >
	 PinP > Sync > Symmetry

Эталоном служит изображение PinP в меню, в котором 
выполняются операции.

При выборе значения “X” в пункте Symmetry
Координаты  будут симметричны оси X.

При выборе значения “Y” в пункте Symmetry
Координаты будут симметричны оси Y.

При выборе значения “Center” в пункте Symmetry
Координаты будут симметричны центральной оси.

При выборе значения “Same” в настройках 
Symmetry
Координаты одинаковы.

Копирование установок

Значение можно выполнить с помощью следующих 
операций с меню:

[3] Key >
	 PinP > Sync > Copy to Key

Установки Key1 PinP можно скопировать в Key2 PinP и, 
аналогично, установки Key2 PinP можно скопировать в 
Key1 PinP.

	p Отображаются имена источников, не выбранные в [3] 
Key > Key Select.

Установочное значение для Key1 PinP (или Key2 PinP) 
копируется и устанавливается в качестве значения для 
Key2 PinP (или Key1 PinP) при нажатии OSD/TIME с 
помощью следующей операции в меню:

Следующие настройки не копируются.
	p [3] Key > PinP > PinP
	p [3] Key > PinP > Shape
	p [3] Key > PinP > Density
	p [3] Key > PinP > Full Key
	p [3] Key > PinP > Trim > Trim
	p [3] Key > PinP > Trim > Pair
	p [3] Key > PinP > Trim > Preset

Примечание
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Оформление эффектов PinP

К PinP можно добавить эффект границы или сглаживания.

1	Установите вкл./выкл. границ с помощью следующих 
операций с меню:

[3] Key >
	 PinP > Border > Border

2	Установите ширину границ с помощью следующих 
операций с меню:

[3] Key >
	 PinP > Border > Width

3	Настройте эффект плавности с помощью следующих 
операций с меню: 
При установке значения “0.0” эффект плавности будет 
установлен в положение OFF.

[3] Key >
	 PinP > Border > Soft

Если в качестве установки для пункта меню Border 
была выбрана опция “On”, в качестве величины 
эффекта плавности будет указано отношение 
интенсивности эффекта плавности к ширине границы. 
Если к PinP нужно добавить только эффект плавности, 
выберите опцию “Off” в качестве установки для пункта 
меню Border.

4	Установите диапазон ширины границ с помощью 
следующих операций с меню:

[3] Key >
	 PinP > Border > Mode

Fix Ширина границы остается постоянной.

Variable Ширина границы изменяется для 
соответствия размеру PinP.

Настройка цвета границы

Отрегулируйте параметры цвета, насыщенности и яркости 
границ с помощью следующих операций с меню:

[3] Key >
	 PinP > Border > Color > Hue

[3] Key >
	 PinP > Border > Color > Sat

[3] Key >
	 PinP > Border > Color > Lum

■  Для вызова предустановленного цвета
Выберите предустановленный цвет с помощью 
следующих операций с меню и нажмите шкалу OSD/TIME:

[3] Key >
	 PinP > Border > Color > Load

	p При нажатии шкалы OSD/TIME установленные 
прежде значения будут отменены и заменены 
предустановленными значениями цвета.

	p Для сохранения значений, установленных перед 
вызовом предустановленного цвета, обратитесь к 
пункту “Память кадров”.

Настройки обрезки
1	Установите вкл./выкл. обрезки с помощью следующих 

операций с меню:

[3] Key >
	 PinP > Trim > Trim

On Выполняется обрезка.
Off Без обрезки

2	Установите тип обрезки с помощью следующих 
операций с меню:

[3] Key >
	 PinP > Trim > Preset

16:9 Автоматическая обрезка в формате 16:9
12:9 Автоматическая обрезка в формате 12:9
9:9 Автоматическая обрезка в формате 9:9
7:9 Автоматическая обрезка в формате 7:9
6:9 Автоматическая обрезка в формате 6:9
Manual Обрезка с использованием значения 

формата, заданного в подменю Trim.

3	Установите вкл./выкл. пар с помощью следующих 
операций с меню:

[3] Key >
	 PinP > Trim > Pair

On Параметры изменяются таким образом, что 
Left и Right обрезка, а также Top и Bottom 
обрезка имеют равные значения. 
(Такой режим обеспечивает симметрию 
сверху-вниз и справа-налево.)

Off Настройки пары не выполняются.



45

Основные действия

Key1 и Key2 могут быть связаны.

Кнопка [KEY1 ON] и кнопка [KEY2 ON] Вкл./выкл. (кнопка 
загорается/кнопка гаснет) могут быть связаны между 
собой.

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

Установите вкл./выкл. для определения наличия 
связывания для каждой из кнопок с помощью следующих 
операций с меню:

[3] Config >
	 Key1/2 Link

	p При выборе “Off” связи нет.

Связывание вставок

4	Установите значения обрезки с помощью следующих 
операций с меню:

[3] Key >
	 PinP > Trim > Adjust > Left

[3] Key >
	 PinP > Trim > Adjust > Top

[3] Key >
	 PinP > Trim > Adjust > Bottom

[3] Key >
	 PinP > Trim > Adjust > Right

Parameter Описание настройки Диапазон значений/
Исходное значение

Left Значение обрезки 
слева

От −50.00 до 50.00/
−50.00

Top Значение обрезки 
сверху

От −50.00 до 50.00/
50.00

Bottom Значение обрезки 
снизу

От −50.00 до 50.00/
−50.00

Right Значение обрезки 
справа

От −50.00 до 50.00/
50.00

<Настройки обрезки> (на рисунке показаны значения, 
заданные по умолчанию)

0

60

-60
600-60

TOP (50)

BOTTOM (-50)

(-50)
LEFT

(50)
RIGHT

Область обрезки

Область, где PinP действует

Исходный размер PinP
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FTB (от Fade до Black)
Пользователь может выполнить уход в затемнение из 
программного изображения до черного экрана/белого 
экрана/стоп-кадра/экрана с цветным фоном или выход 
из затемнения до программного изображения из черного 
экрана/белого экрана/стоп-кадра/цветного фона.

1	Задайте длительность перехода. 
Настройте время перехода идентичное каждому 
фоновому переходу с помощью следующих операций с 
меню:

[5] Time >
	 FTB > Trans Time

 См. раздел “Автоматический переход”.

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

2	Если нажать кнопку [FTB ON] в области переходов, 
на экране выполняется уход в затемнение до экрана 
настроек за установленное время перехода.
Во время затухания индикатор кнопки [FTB ON] мигает 
красным цветом, и загорается красным, когда переход 
(затухание) завершен, и отображается черный экран.* 
При нажатии кнопки [FTB ON] с отображением 
черного экрана инициируется постепенное изменение 
изображения программы. 
Если нажать кнопку [FTB ON] после полного 
завершения убывающего перехода, будет выполнен 
обратный переход FTB картинки (плавное нарастание). 
При нажатии кнопки [FTB ON] в любое время во время 
перехода изменяется направление перехода.

*: �В состоянии FTB коммутационная кнопка, которая 
обычно светится красным, будет светиться желтым.

Выбор изображения

Можно выбрать изображение, которое будет 
использоваться для затухания.

Выберите изображение для затухания с помощью 
следующей операции меню:

[5] Time >
	 FTB > Source

Still1 Используется видеопамять неподвижных 
изображений (Still1).

Still2 Используется видеопамять неподвижных 
изображений (Still2).

CBGD1
Используется цветной фон.CBGD2

White Белый фон
Black Черный фон

Отключение звука

Вы можете выбрать, следует ли синхронизировать 
затухание звука с затуханием изображения.

Выберите, следует ли отключать звук с помощью 
следующей операции меню:

[5] Time >
	 FTB > Mute

Off Отсутствие затухания звука при затухании 
изображения.

On Затухание звука во время затухания 
изображения.
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Внутренние сигналы цветности

Данным устройством поддерживается два набора внутренних цветных сигналов.

Настойка цветного фона

Можно установить цветной фон, который будет 
передаваться по шине.
Для этого есть два метода: по одному из них задаются 
параметры Hue (оттенок), Sat (насыщенность) и 
Lum (яркость), а по другому методу вызываются 8 
предустановленных цветов (белый, желтый, бирюзовый, 
зеленый, малиновый, красный, синий и черный). 
Можно также выполнить настройку параметров Hue, Sat и 
Lum вызванных цветов.

Настройка цветов

1	Выберите целевой цветовой фон (CBGD1/CBGD2) с 
помощью следующих операций с меню:

[2] CBGD >
	 CBGD Select

2	Отрегулируйте параметры (цвета, насыщенности и 
яркости) с помощью следующих операций с меню:

[2] CBGD >
	 CBGD Main > Hue

[2] CBGD >
	 CBGD Main > Sat

[2] CBGD >
	 CBGD Main > Lum

■  Для вызова предустановленного цвета
Выберите предустановленный цвет с помощью 
следующих операций с меню и нажмите шкалу OSD/TIME:

[2] CBGD >
	 CBGD Main > Load

	p При нажатии шкалы OSD/TIME установленные 
прежде значения будут отменены и заменены 
предустановленными значениями цвета.

	p Для сохранения значений, установленных перед 
вызовом предустановленного цвета, обратитесь к 
пункту “Память кадров”.

Установка эффекта размывания

Можно установить эффект градации для цветных фонов.

Выбор эффекта размывания и установка цветов

1	Настройте эффект размывания (градации) с помощью 
следующих операций с меню:

[2] CBGD >
	 CBGD Wash > Wash

On Эффект градации будет добавлен.
Off Эффект градации не будет добавлен.

2	Настройте цвет размывания (градации) с помощью 
следующих операций с меню:

[2] CBGD >
	 CBGD Wash > Color

Dual Будет добавлена двухцветная градация. 
(Это приведет к градации двух цветов, а 
именно, цвета “CBGD1 Main” и цвета “CBGD1 
Sub”.)

Rainbow Эффект цветной градации радуги будет 
добавлен.

3	Если выбрано значение “Двойной”, отрегулируйте 
параметры (цвета, насыщенности и яркости) 
дополнительного цвета с помощью следующей 
операции меню:

[2] CBGD >
	 CBGD Sub > Hue

[2] CBGD >
	 CBGD Sub > Sat

[2] CBGD >
	 CBGD Sub > Lum
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Регулировка форм волны для размывания

1	Настройте форму градации с помощью следующих 
операций с меню:

[2] CBGD >
	 CBGD Wave > Pattern

Sine Будут выбраны синусные волны.
Saw Будут выбраны зубчатые волны.

2	Настройте цикл градации с помощью следующих 
операций с меню:

[2] CBGD >
	 CBGD Wave > Cycle

3	Настройте фазу градации с помощью следующих 
операций с меню:

[2] CBGD >
	 CBGD Wave > Phase

4	Настройте угол градации с помощью следующих 
операций с меню:

[2] CBGD >
	 CBGD Wave > Angle

Установка движений размывания

1	Настройте движение градации с помощью следующих 
операций с меню:

[2] CBGD >
	 CBGD Move > Move

Off Движение не установлено.
Roll Градации будут прокручиваться.
Rotation Градации будут вращаться.

2	Настройте скорость движения с помощью следующих 
операций с меню:

[2] CBGD >
	 CBGD Move > Speed
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Внутренний сигнал цветовых полос

Устройство поддерживает 1 внутренний сигнал цветовых полос.

Выбор сигнала цветовых полос

Можно задать тип встроенной цветовой полосы для 
входов Type1 – 3 с помощью следующих операций с 
меню:

[12]Config >
	 CBAR > Type

Type1

Type2

Type3

	p Цветовая полоса предназначена для настройки 
цветовой фазы. Ширина и положение полосы могут 
отличаться от других моделей.

Установка движения сигнала цветовых 
полос

Скорость движения сигнала цветовых полос можно задать 
на 2 уровнях.

Задайте скорость движения, осуществив следующее 
управление меню:

[12] Config >
	 CBAR > Move

Normal Сигнал цветовых полос движется быстро.
Low Сигнал цветовых полос движется медленно.
Off Сигнал цветовых полос не движется.

Настройки тестовых тональных сигналов

Можно задать настройки для вывода тестовых тональных 
сигналов (1 кГц) с сигналами цветовых полос.

Установите настройки, связанные с выводом тестовых 
тональных сигналов, с помощью следующих операций с 
меню:

[12] Config >
	 CBAR > Test Tone

Normal Тестовые тональные сигналы выводятся с 
нормальной громкостью (–12 дБ).

Low Тестовые тональные сигналы выводятся с 
пониженной громкостью (–20 дБ).

Off Тестовые тональные сигналы не выводятся.
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Встроенный сигнал тестового шаблона
Данное устройство может выводить сигнал тестового 
шаблона.
Это позволяет проверять такие факторы, как формат 
кадра на подключенных устройствах.
Выбирается сигнал тестового шаблона с углом обзора, 
который соответствует формату системы, установленному 
на данном устройстве.
Он загружается в Still1 или Still2 в видеопамяти и может 
использоваться как внутренний источник.

<Тестовый шаблон, если режим системы – 1080>

<Тестовый шаблон, если режим системы – 720>

1	Выберите устройство, на которое будет выводиться 
тестовый сигнал, выполнив следующую операцию:

[6] Still >
	 Still Select

2	Нажмите на шкалу OSD/TIME (Выполнить) в 
следующем меню, чтобы загрузить в выбранную 
видеопамять:

[6] Still >
	 Test Pattern > Load
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Переключение выхода шины AUX

Выбор выходных материалов AUX

Можно выбрать выходные сигналы шин AUX (AUX1, 
AUX2).

1	Нажмите одну из кнопок [AUX1], [AUX2] среди кнопок 
выбора шины AUX. 
Выбранная кнопка подсвечивается янтарным цветом.

2	Нажмите одну из кнопок пересечения шины AUX. 
Выбранный сигнал выводится на кнопку [AUX1], 
[AUX2].
AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Кнопка с выбранными сигналами AUX1 загорается желтым 
цветом.

<Сигналы, которые можно выбрать с помощью шины 
AUX>
Название сигнала Описание сигнала
IN1 Входной сигнал 1 SDI/HDMI

IN2 Входной сигнал 2 SDI

IN3 Входной сигнал 3 SDI

IN4 Входной сигнал 4 SDI

IN5 Входной сигнал 2 HDMI

IN6 Входной сигнал 1 IP

IN7 Входной сигнал 2 IP

IN8 Входной сигнал 3 IP

IN9 Входной сигнал 4 IP

PGM Программный сигнал видео

PVW Сигнал видео предварительного 
просмотра

CLN Чистый сигнал

MV Выходной сигнал многоканального 
просмотра

KeyOut Выходной сигнал вставки

Black Сигнал черного

CBGD1, CBGD2 Цветной фон 1, 2

CBAR Цветовая полоса

Still1, Still2 Видеопамять (неподвижные изображения) 
1, 2

	p Если сигнал шины AUX, для которой выбрано значение 
“MV”, был выбран и отображен на субэкране в режиме 
многоканального просмотра, изображения будут 
циклически повторяться, как будто два зеркала были 
поставлены друг напротив друга.

Переходы AUX1/2

Переход MIX выполняется при переключении выходного 
сигнала, установленного для AUX1/2.

1	Нажмите кнопку [AUX1] или [AUX2] из кнопок 
переключения шины AUX. 
Выбранная кнопка и соответствующая кнопка 
пересечения шины AUX загорятся янтарным цветом.

2	Нажмите кнопку пересечения шины AUX для 
переключения выходного сигнала. 
Будет начат переход MIX на период времени перехода, 
установленного в меню Time. 
Во время выполнения перехода кнопка AUX источника 
перехода будет гореть зеленым цветом, а кнопка AUX 
назначения перехода будет мигать янтарным цветом. 
По завершении выполнения перехода кнопка AUX 
источника перехода погаснет, а кнопка AUX назначения 
перехода будет гореть янтарным цветом. 
Кроме того, при выборе другого сигнала посреди 
процесса перехода выполнение перехода будет 
продолжено с данного момента выбора.
AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Мигает желтым цветом (во время 
выполнения перехода).Светится 

зеленым цветом.

	p Переход для шины AUX при вызове из памяти кадров 
связан с временем наплыва в памяти кадров.
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Настройка включения/выключения 
перехода AUX1/2

Можно настроить время перехода AUX1/2 и включение/
выключение перехода.

1	Настройте время перехода с помощью следующей 
операций с меню:

[5] Time >
	 AUX1 Bus Trans > Trans Time

[5] Time >
	 AUX2 Bus Trans > Trans Time

Можно задать любой период времени от 0 до 999f. 
Время, которое можно задать при использовании 
секунд в качестве единицы отображения, зависит от 
формата системы.

59.94i макс. 33s09f 29.97p макс. 33s09f

50i макс. 39s24f 25p макс. 39s24f

59.94p макс. 16s39f 24p макс. 41s15f

50p макс. 19s49f 23.98p макс. 41s15f

2	Настройте активно/неактивно для перехода с помощью 
следующих операций с меню:

[5] Time >
	 AUX1 Bus Trans > Transition

[5] Time >
	 AUX2 Bus Trans > Transition

On Enable
Off Disable

При выключении перехода выходные сигналы 
переключаются без перехода, когда переключаются 
выходные сигналы, установленные в AUX1/2.
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Память кадров

В памяти можно зарегистрировать и вызывать из нее шаблоны фоновых переходов, размер PinP, ширину границы и 
другие видеоэффекты. Используемая для этого память называется памятью кадров.
Посредством установки эффекта растворения можно обеспечить плавную смену переключения с текущих изображений 
на изображения или операции, зарегистрированные в памяти кадров.

Элементы памяти могут быть зарегистрированы и вызваны

Пункт Выбор материала Переход Шаблон Меню
BKGD  Шина PGM/A

 Шина PST/B
 Значение фейдера 
 Направление сдвига

 �Шаблоны BKGD  
(MIX, WIPE)

 [1] WIPE

Key1  Шина Key1 Fill
 Шина Key1 Source

 Key1 вкл./выкл.
 Значение фейдера 
 Направление сдвига

 �Шаблоны KEY  
(MIX, WIPE)

 [1] WIPE
 [3] Key
 [4] ChromaKey

Key2  Шина Key2 Fill
 Шина Key2 Source

 Key2 вкл./выкл.  [3] Key

AUX1  Шина AUX1

AUX2  Шина AUX2

CBGD  [2] CBGD

Хранение установок в памяти (Хранение)

Изображения и операции, которые необходимо 
зарегистрировать, можно установить, а затем 
зарегистрировать в памятях.

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	С помощью данного устройства настройте 
изображения или операции, которые необходимо 
занести в память.

2	Установите элемент, который будет зарегистрирован в 
памяти, с помощью следующих меню:

[7] Shot Memory >
	 Target Select > BKGD

[7] Shot Memory >
	 Target Select > Key1

[7] Shot Memory >
	 Target Select > Key2

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

 �См. раздел “Элементы памяти могут быть 
зарегистрированы и вызваны”.

3	Нажмите кнопку [SHOT MEM]. 
Кнопка [SHOT MEM] загорается желтым цветом.

4	Нажмите и удерживайте кнопку AUX BUS (1 – 12) с 
номером памяти, который нужно зарегистрировать. 
(Прибл. 1 секунда)
Кнопка выбора шины AUX для номера памяти 
загорается зеленым, когда регистрация завершена.

	p Кнопки выбора шины AUX 1 – 6 действуют как кнопки 
7 – 12, когда вы нажимаете кнопку [SHIFT].

	p Кнопки выбора шины AUX, которые светятся зеленым 
или желтым цветом, уже зарегистрированы в памяти.

5	Повторите указанные выше действия для регистрации 
других типов установок в памятях.
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Вызов операций, сохраненных в памяти 
(Вызов)

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	Выберите цель, которую необходимо вызвать из 
памяти, с помощью следующих меню:

[7] Shot Memory >
	 Target Select > BKGD

[7] Shot Memory >
	 Target Select > Key1

[7] Shot Memory >
	 Target Select > Key2

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

 �См. раздел “Выбор объектов для регистрации и 
воспроизведения”.

2	Включите следующее меню, чтобы использовать 
коммутационные кнопки на панели управления для 
выбора материала, а не использовать материал, 
зарегистрированный в “Выборе материала”.

[7] Shot Memory >
	 XPT Disable

 �См. раздел “Выбор объектов для регистрации и 
воспроизведения”.

3	Нажмите кнопку  [SHOT MEM]. 
Кнопка [SHOT MEM] загорается желтым цветом.

4	Нажмите кнопку AUX BUS (1 – 12) с номером памяти, 
который нужно вызвать.

	p Кнопки выбора шины AUX 1 – 6 действуют как кнопки 
7 – 12, когда вы нажимаете кнопку [SHIFT].
	p При использовании памяти кадров будут вызваны 
видеоэффекты, и начнется воспроизведение. 
Во время воспроизведения кнопка выбора шины AUX 
с номером памяти загорается желтым цветом.

Обратитесь к “Настройка пользовательских кнопок” при 
вызове операций с памятью с помощью пользовательских 
кнопок

Удаление операций, хранящихся в памяти 
(Удаление)

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	Нажмите и удерживайте кнопку [SHOT MEM].
Кнопка [SHOT MEM] мигает желтым цветом.
Кнопки выбора шины AUX, в которых зарегистрирована 
память, также мигают зеленым или желтым цветом.

2	Нажмите и удерживайте (около 1 сек.) кнопку AUX BUS 
(1 – 12) с номером памяти, который нужно удалить.
Нажатая кнопка выбора шины AUX выключается.

	p Кнопки выбора шины AUX 1 – 6 действуют как кнопки 
7 – 12, когда вы нажимаете кнопку [SHIFT].
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Выбор объектов для регистрации и 
воспроизведения

Выбор цели и элемента “Выбор материала” при 
регистрации памяти

При создании памяти снимков вы выбираете элементы, 
которые должны быть сохранены.

Установите Вкл. для элементов, которые будут 
сохранены, с помощью следующих операций с меню:

[7] Shot Memory >
	 Target Select > BKGD > Target

[7] Shot Memory >
	 Target Select > Key1 > Target

[7] Shot Memory >
	 Target Select > Key2 > Target

On Запишите целевую настройку в память.
Off Не регистрируйте целевую настройку в 

памяти.

[7] Shot Memory >
	 Target Select > BKGD > XPT

[7] Shot Memory >
	 Target Select > Key1 > XPT

[7] Shot Memory >
	 Target Select > Key2 > XPT

On Зарегистрируйте “Выбор материала” в 
памяти.

Off Не регистрируйте “Выбор материала” в 
памяти.

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

On Запишите целевую настройку в память.
Off Не регистрируйте целевую настройку в 

памяти.

Выбор цели и элемента “Выбор материала” при 
воспроизведении памяти

При воспроизведении видеозаписи в памяти вы 
выбираете элемент, который должен быть воспроизведен, 
и пункт “Выбор материала”.

Установите Вкл. для элементов, которые будут 
воспроизводиться, с помощью следующих операций с 
меню:

[7] Shot Memory >
	 Target Select > BKGD > Target

[7] Shot Memory >
	 Target Select > Key1 > Target

[7] Shot Memory >
	 Target Select > Key2 > Target

On Воспроизведение цели.
Не воспроизводится, если не 
зарегистрировано в памяти.

Off Цель не воспроизводится.

[7] Shot Memory >
	 Target Select > BKGD > XPT

[7] Shot Memory >
	 Target Select > Key1 > XPT

[7] Shot Memory >
	 Target Select > Key2 > XPT

On Воспроизводит элемент “Выбор материала”.
Не воспроизводится, если не 
зарегистрировано в памяти.

Off Не воспроизводится элемент “Выбор 
материала”.

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

On Воспроизведение цели.
Не воспроизводится, если не 
зарегистрировано в памяти.

Off Цель не воспроизводится.

[7] Shot Memory >
	 XPT Disable

On Не воспроизводятся элементы “Выбор 
материала” BKGD, Key1 и Key2.

Off Воспроизводятся элементы “Выбор 
материала” BKGD, Key1 и Key2.
Не воспроизводится, если не 
зарегистрировано в памяти.
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Установка эффекта растворения (память 
кадров)

Переключение между текущим изображением и 
изображением или операцией, хранящимися в памяти 
кадров, можно выполнять плавно.

1	Установите эффект при переключении изображений с 
помощью следующей операции меню:

[7] Shot Memory >
	 Effect

Cut Изображения переключаются с 
использованием эффекта перехода.

Dissolve Изображения переключаются с 
использованием эффекта растворения.

	p Установите время для эффекта размывания с 
помощью следующей операции меню:

[5] Time >
	 Effect Dissolve

2	Выберите эффект при изменении цветов с помощью 
следующей операции меню:

[7] Shot Memory >
	 Hue Path

Оттенки устанавливаются для перечисленных ниже 
цветов.

	p Цвета цветного фона
	p Цвета границ
	p Цвета краев
	p Цвета матового изображения вставки

Short Цвета будут изменены в направлении 
уменьшения оттенка на вектороскопе.

Long Цвета будут изменены в направлении 
увеличения оттенка на вектороскопе.

CW Оттенок будет изменяться по часовой стрелке 
на вектороскопе.

CCW Оттенок будет изменяться против часовой 
стрелки на вектороскопе.

	p Нажатая кнопка выбора шины AUX загорается желтым 
цветом при переключении работы.

	p При изменении значения пункта Effect с “Dissolve” 
на “Cut” во время переключения операции, эффект 
растворения будет отключен, и изображения будут 
немедленно переключены на изображения выбранной 
памяти кадров.

	p Во время переключения операций операция рычага 
микшера отменяется.

	p Другие операции с памятью не могут быть вызваны во 
время переключения операции.

Основные действия
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Видеопамять
Устройство может сохранять неподвижные изображения в 
памяти (Still) по двум каналам.

	p В видеопамятях можно сохранять изображения с 
сигналами вставки (неподвижные изображения и 
движущиеся изображения).

	p Данные видеопамяти можно сохранить в USB-память и 
считать с нее.

	p Если системный формат данного устройства 
изменяется с 1080 на 720, сохраненные видеоданные 
удаляются. 
Перед изменением системного формата сохраните 
видеозаписи на USB-накопитель или в файл проекта.

■ Ввод/вывод видеопамяти
Входные материалы изображений можно выбрать из 
выходных сигналов шин AUX (AUX1, AUX2).

<Системы изображений для видеопамятей>

Still2

Still1

AUX1, AUX2:
	 �Выбираются с 

помощью меню

AUX1, AUX2:
	 �Выбираются с 

помощью меню

Видео

Вставка

Видео

Вставка

Запись неподвижных изображений (Still)
1	Выберите “Still1” или “Still2” с помощью следующей 

операций с меню:

[6] Still >
	 Still Select

2	Установите изображения, которые будут записываться 
в видеопамять, с помощью следующей операции меню:

[6] Still >
	  Capture Setting > Video

AUX1, AUX2 Выходные сигналы шин AUX (AUX1, AUX2) 
записываются в качестве материала.

3	Установите отображение с помощью следующих 
операций с меню:

[6] Still >
	  Capture Setting > Review

On После записи изображений будут отображены 
(приблизительно в течение 2 секунд) 
изображения из видеопамяти, записанные 
через шину AUX.

Off Дисплей просмотра не отображается.

4	Неподвижное изображение записывается 
одновременно с нажатием кнопки OSD/TIME 
(Выполнить) в следующем меню.

[6] Still >
	  Capture
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USB-память
Данные видеопамяти и данные настройки этого устройства можно сохранить как файл проекта на USB-память.
И наоборот, эти данные можно загружать из карты памяти в устройство.
Кроме того, можно обновлять программное обеспечение устройства.

	p Сохранение файла неподвижного изображения с высоким качеством изображения на USB-накопителе может занять 
некоторое время.

Видеопамять (данные неподвижного изображения Still1, Still2):
<Поддерживаемые форматы файлов>

Bitmap (bmp), JPEG (jpg), TARGA (tga), TIFF (tif), GIF (gif), PNG (png)

	p Данное устройство поддерживает 24-битные несжатые или 32-битные несжатые файлы TARGA. 
При загрузке в устройство файлов TARGA каких-либо других типов, черные изображения будут отображаться в 
виде пиктограмм, и устройство не сможет распознать файлы.
	p Имейте в виду, что сохранение неподвижных изображений видеопамяти на карте памяти в формате GIF приведет к 
ухудшению качества изображения.

<Применимые размеры> 
HD/1080i:	 1920×1080
HD/1080p:	1920×1080

HD/720p: 1280×720

	p Размер изображений конвертируется автоматически, если он не соответствует какому-либо из “применимых 
размеров”.
	p Изображения, которые не соответствуют ни одному из “применимых размеров”, выводятся по центру без изменения 
их размера. Если размер большой, то элементы, выступающие за пределы этого размера, обрезаются. Если 
размер невелик, незаполненные части затемняются.

Данные файла проекта (Проект):
“Данные файла проекта” относятся ко всем данным, сохраненным в устройстве, кроме данных, приведенных ниже.
Можно сохранить файлы проектов.

Дата, время, сетевые установки

Программное обеспечение для обновления (Обновление):
Будет загружено программное обеспечение для обновления. 
Данное программное обеспечение можно получить в разделе “Service and Support” на домашней странице, адрес 
которой приведен ниже:

	 https://pro-av.panasonic.net/en/
Для выполнения обновления выполните действия в инструкции, которая находится в загруженном файле.

Файл журнала (Log):
Можно сохранить файлы журнала, которые хранятся в устройстве.

	qОтносительно USB-памяти
С этим прибором можно использовать только USB-память, соответствующую стандартам USB 2.0.
Обязательно отформатируйте USB-память с помощью данного устройства.
Используйте карты памяти, форматированные в системе FAT или exFAT. 
(USB-память, отформатированная в системе NTFS, не распознается.)

Работа с данным устройством была подтверждена для следующих устройств USB-памяти:
	p KIOXIA TransMemory U301 (32 ГБ, 64 ГБ, 128 ГБ)
	p SanDisk Cruzer Glide CZ600 (32 ГБ, 64 ГБ, 128 ГБ)

Для получения последней информации, недоступной в данной Инструкции по эксплуатации, посетите следующие 
веб-сайты.
https://pro-av.panasonic.net/en/

	p Карты флэш-памяти запрещается использовать или хранить в следующих условиях
	 •	При воздействии высокой температуры/влажности;
	 •	При вероятности попадания воды; или
	 •	При воздействии электрического заряда.
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Данные хранятся в указанных ниже папках в USB-памяти.
Если необходимо загрузить данные, сначала сохраните данные в соответствующих папках, а затем загрузите файлы.

<Конфигурация папок с данными>
Тип данных Пункт Save Папка хранения Расширение

Файл проекта (проект) Project (*1) “HS\COMM\PROJECT” 001, 002, … (*3)

Видеопамять (файл стоп-кадра) Still1, Still2 (*2) “HS\COMM\IMAGE” bmp, tga, png, jpg(jpeg), tif(tiff), gif

Файл обновления – “HS\HSW10\UPDATE” 10d

Файл журнала Log “HS\HSW10\LOG” log

Загрузить файл TEXT (стр. 26) “HS\HSW10\TEXT” txt (*4)

*1	� Файл проекта сохраняет установочные данные, данные памяти снимков и данные неподвижного изображения, выбранные с 
помощью следующей операции меню:

[18] USB Memory >
	  Save > Setup

[18] USB Memory >
	  Save > Shot

[18] USB Memory >
	  Save > Still

*2	� Если данные неподвижных изображений с присоединенными сигналами вставки хранятся в видеопамяти, выберите “tga” или “png” 
в качестве формата файла. 
Данные неподвижных изображений какого-либо другого формата файла невозможно сохранить с прикрепленными сигналами 
вставки.

*3	� Файл проекта сохраняется в папке, созданной в качестве папки имени файла под папкой HS\COMM\PROJECT.   
В случае большого размера файла проекта, файл разделяется на части и в конце имени каждого файла добавляется расширение с 
порядковым номером (001, 002 и т. д.).

*4	� При выборе [Load TEXT] вы можете загрузить текстовый файл (.txt), который был сохранен в папке "HS\HSW10\TEXT” на USB-
накопителе, отформатированном данным устройством, и использовать содержимое для установки в виде символьной строки.[Load 
TEXT] невозможно выбрать, если USB-накопитель не подключен.

Меры предосторожности при обращении с USB-памятью
	p “Отсоедините” USB-накопитель перед его извлечением.  
Если USB-накопитель удален без отсоединения, переход может приостановиться или содержимое, сохраненное в 
USB-накопителе, может быть потеряно.

	p Данные, хранящиеся в USB памяти, могут быть утеряны, например, в результате неправильной установки 
USB памяти или выполнения неправильных операций, например. Важные данные рекомендуется хранить на 
компьютере или другом устройстве.

Примечания при работе с exFAT
	p Отметка времени, отображаемая при использовании exFAT, может отличаться от указанной на компьютере.  
Это устройство работает с часовым поясом UTC, поэтому, если вы используете компьютер, работающий, например, 
в часовом поясе Японии (UTC +9), на дисплее временной метки на компьютере будет разница в 9 часов.
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Форматирование USB-памяти

Перед использованием USB-накопителя на данном 
устройстве необходимо сначала отформатировать 
USB-накопитель на данном устройстве. Выполнение 
форматирования означает, что USB-память 
отформатирована и создан выделенный каталог. (Все 
файлы, сохраненные на USB-накопителе, будут удалены.)

1	Вставьте USB-накопитель в USB-разъем устройства 
(тип разъема-A).

2	Нажмите на шкалу OSD/TIME (Выполнить) в 
следующем меню для форматирования.

[18] USB Memory >
	 Format

Элемент отображается серым цветом, если USB-
накопитель не вставлен.

	p Чтобы отформатировать, выберите “YES” на экране 
подтверждения.
	p Для отмены выберите “NO”.

Отформатируйте USB-накопитель, чтобы использовать 
его в данном устройстве.

Сохранение данных в USB-памяти
1	Вставьте USB-накопитель, который был 

отформатирован на данном устройстве, в USB-разъем 
(разъем-A).

2	Выберите данные для сохранения в USB-памяти с 
помощью следующей операции меню:

[18] USB Memory >
	 Save > Save Type

При сохранении стоп-кадров:
Выберите формат файла для сохранения 
неподвижных изображений с помощью следующей 
операции меню:

[18] USB Memory >
	 Save > File Format

При сохранении файлов проектов:
Установите Вкл. для элементов, которые будут 
сохранены как проектный файл, с помощью 
следующих операций с меню:

[18] USB Memory >
	 Save > Setup

[18] USB Memory >
	 Save > Shot

[18] USB Memory >
	 Save > Still

3	Нажмите на шкалу OSD/TIME (Выполнить) в 
следующем меню, чтобы отобразить экран выбора 
файла.

[18] USB Memory >
	 Save > Save

�Для получения информации о местах назначения, куда 
сохраняются данные, обратитесь к <Конфигурация 
папок с данными>.

	p Имейте в виду, что сохранение неподвижных 
изображений видеопамяти в USB памяти в формате 
GIF приведет к ухудшению качества изображения.

	p Для имен файлов можно использовать буквенно-
цифровые знаки и символы.  
Файлы с использованием других знаков отобразить 
на этом устройстве невозможно.
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Основные действия

Загрузка данных из USB-памяти

1	Вставьте USB память, на которой хранятся данные, в 
слот для USB памяти (коннектор-А). 
Загрузите файл из соответствующей папки.  
Данные, записанные в других папках, не распознаются 
устойством.
Для получения информации о местах назначения, куда 
сохраняются данные, обратитесь к <Конфигурация 
папок с данными>.

2	Нажмите на шкалу OSD/TIME (Выполнить) в 
следующем меню, чтобы отобразить экран выбора 
файла.

[18] USB Memory >
	 Load > Load

<Пример содержимого экрана выбора файла>

3	Выберите тип файла для загрузки с помощью 
следующей операции меню:

[18] USB Memory >
	 Load > Load Type

4	Чтобы выбрать имя файла для загрузки, нажмите OSD/ 
TIME.
Если в имени загружаемого файла более 11 символов, 
может отображаться сокращенное имя файла. 
Если имя загружаемого файла содержит 33 символа 
и более, оно не будет отображаться на экране выбора 
файлов.

	p Для имен файлов можно использовать буквенно-
цифровые знаки и символы.  
Файлы с использованием других знаков отобразить 
на этом устройстве невозможно.

5	Чтобы загрузить файл, нажмите OSD/ TIME.

Отображение информации о USB-памяти

1	Вставьте USB память, на которой хранятся данные, в 
слот для USB памяти (коннектор-А).

2	Отображение следующих меню:

[18] USB Memory >
	 Free

[18] USB Memory >
	 Total

Free Отобразится оставшееся свободное место в 
USB-памяти.

Total Отображается емкость карты памяти.
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Основные действия

Внутреннее хранилище

Данные настройки для этого устройства можно сохранить как файл проекта во внутреннем хранилище.
Кроме того, в это устройство можно также загрузить данные настройки из внутреннего хранилища.

	p Сохранение файла неподвижного изображения с высоким качеством изображения во внутреннем хранилище может 
занять некоторое время.

	p Указанные ниже данные можно выбрать и сохранить или загрузить как файл проекта.
Установочные данные, данные отснятой памяти, неподвижная видеопамять.

	p Дату, время и настройки сети сохранить невозможно.

Экран управления файлами проекта

Отображение следующих меню:

[14] Project

	p С помощью этого экрана меню можно выполнять 
загрузку, сохранение, удаление и переименование 
файлов проекта во внутреннем хранилище.  
Также можно посмотреть последние загруженные 
данные для файла проекта.

Сохранение файлов проекта во 
внутреннем хранилище
1	Выберите файл, который необходимо сохранить, с 

помощью следующих меню:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

	p Файл проекта, который уже был сохранен, можно 
перезаписать.
	p Файлы с включенным значком защиты перезаписать 
невозможно.

2	Нажмите OSD/TIME (Выполнить) в элементе Save для 
сохранения файла проекта во внутреннем хранилище.

Загрузка файлов проекта из внутреннего 
хранилища
1	Выберите файл, который необходимо загрузить, с 

помощью следующих меню:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

2	Нажмите OSD/TIME (Выполнить) элемента Загрузить, 
чтобы сохранить файл проекта во внутреннем 
хранилище.

3	Целевой файл можно защитить с помощью настройки 
Защиты.

	p Файлы проекта, для которых включен пункт защиты, 
не могут быть перезаписаны, удалены или изменены 
их имена.

Удаление файлов проекта из внутреннего 
хранилища
1	Выберите файл, который необходимо удалить, с 

помощью следующих меню:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

2	Нажмите OSD/TIME (Выполнить) в пункте Удалить, 
чтобы удалить файл проекта из внутреннего 
хранилища.

	p Невозможно удалить файлы, для которых включен 
пункт защиты.

3	Целевой файл можно защитить с помощью настройки 
Защиты.

	p Файлы проекта, для которых включен пункт защиты, 
не могут быть перезаписаны, удалены или изменены 
их имена.
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Основные действия

Изменение имен файлов проекта, 
сохраненных во внутреннем хранилище
1	Выберите файл проекта, для которого вы хотите 

изменить название, с помощью следующих операций 
меню:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

2	Вы можете изменить название файлов проекта, 
сохраненных во внутреннем хранилище, с помощью 
элемента Имя.

	p Имя файла может содержать не более 32 символов.
<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

3	Целевой файл можно защитить с помощью настройки 
Защиты.

	p Файлы проекта, для которых включен пункт защиты, 
не могут быть перезаписаны, удалены или изменены 
их имена.
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Настройка входных/выходных сигналов

Установки входного сигнала
Доступны следующие входы:

Название 
логического 

входа

Название 
физического 

входа
Ограничения

IN1 SDI IN1/HDMI IN1 SDI/HDMI взаимоисключающие, упрощенные UC/DC, с 
масштабированием

IN2 SDI IN2 Упрощенные UC/DC

IN3 SDI IN3 С UC/DC

IN4 SDI IN4 С UC/DC

IN5 HDMI IN2 С масштабированием

IN6 LAN SRT/NDI|HX

IN7 LAN SRT/NDI|HX

IN8 LAN NDI, оснащен совместимостью с альфа, в это время IN9 
отключен

IN9 LAN NDI

При настройке входных сигналов сначала выберите нужный входной сигнал в следующих меню:

[10] Input >
	  IN1 > SDI/HDMI

[10] Input >
	  INx > Streaming Mode



65

Настройка входных/выходных сигналов
<Перечень установок входного сигнала>

Входной 
разъем

Меню настроек и страница в этом руководстве

Status FS Остановка Ограничен Название
Повышающий/
понижающий 

преобразователь
C/C HDMI Status

P66 P67 P67 P68 P68 P68 P69 P71
SDI 
IN 1    –  –  –

SDI 
IN 2    –  –  –

SDI 
IN 3    –    –

SDI 
IN 4    –    –

HDMI 
IN 1 – –    –  

HDMI 
IN 2 – –    –  

IP IN1 – – – –  – – –

IP IN2 – – – –  – – –

IP IN3 – – – –  – – –

IP IN4 – – – –  – – –

Входной 
разъем

Меню настроек и страница в этом руководстве

Вход HDMI Масштаб SRT Status Вход SRT NDI Status Вход NDI Настройка 
камеры

P70 P70 P72 P72 P74 P73 P101
SDI 
IN 1 – – – – – – 

SDI 
IN 2 – – – – – – 

SDI 
IN 3 – – – – – – 

SDI 
IN 4 – – – – – – 

HDMI 
IN 1   – – – – 

HDMI 
IN 2   – – – – 

IP IN1 – – *1 *1 *2 *2 

IP IN2 – – *1 *1 *2 *2 

IP IN3 – – – –   

IP IN4 – – – –   

: можно установить.
	 —: нельзя установить.

*1	 Только для настроек SRT
*2	 Только для настроек NDI/NDI|HX
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Настройка входных/выходных сигналов

Настройки для разъемов исключительного 
входа

Задайте исключительный вход для входных разъемов SDI 
(SDI IN 1)/входных разъемов HDMI (HDMI IN 1).

Установите тип входного сигнала, осуществив следующее 
управление меню:

[10] Input >
	  IN1 > SDI/HDMI

SDI IN Выбор ввода сигнала SDI через разъем 
SDI IN 1 для IN1. Даже если сигналы HDMI 
вводятся, они не выводятся на данное 
устройство.

HDMI IN Выбор ввода сигнала HDMI через разъем 
HDMI IN1 для IN1. Даже если сигналы SDI 
вводятся, они не выводятся на данное 
устройство.

Проверка состояния входных сигналов

Можно проверить состояние входных сигналов.

Для входных сигналов SDI

Отображение следующих меню:

[10] Input >
	  INx > Status Information

Устройство автоматически определяет параметры 
входных сигналов и отображает указанную ниже 
информацию.

Format Отображается информация о формате 
изображений для вводимого сигнала SDI.

Audio Отображается информация о звуке для 
вводимого сигнала SDI.

Status Detect:
Формат входного сигнала соответствует 
формату системы этого устройства.
Unsupported:
Формат входного сигнала не соответствует 
формату системы этого устройства.
Not Detect:
Видеосигнал на устройство не поступает.

Для входных сигналов HDMI

Отображение следующих меню:

[10] Input >
	  INx > Status Information

Устройство автоматически определяет параметры 
входных сигналов и отображает указанную ниже 
информацию.

Size Отображается информация о разрешении 
для вводимого сигнала HDMI.

Dot Clock Отображается информация о частоте 
пикселизации для вводимого сигнала HDMI.

H-Frequency Отображается информация о частоте 
строчной развертки для вводимого сигнала 
HDMI.

V-Frequency Отображается информация о частоте 
вертикальной развертки для вводимого 
сигнала HDMI.

Status Detect:
Формат входного сигнала соответствует 
формату системы этого устройства.
Unsupported:
Формат входного сигнала не соответствует 
формату системы этого устройства.
Not Detect:
Видеосигнал на устройство не поступает.

Для входных сигналов SRT

 �См. раздел “Отображение информации о входном 
сигнале SRT”.

Для входных сигналов NDI

 �См. раздел “Отображение информации о входном 
сигнале NDI”.
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Настройка входных/выходных сигналов

Настройка кадрового синхронизатора 
входного сигнала

Для каждого из входов SDI можно включить (On) или 
отключить (Off) кадровый синхронизатор.
Кадровый синхронизатор входа HDMI постоянно 
находится во включенном состоянии On. 
Его нельзя переключить из состояния On в состояние Off 
или наоборот.

Задайте кадровый синхронизатор входного сигнала, 
осуществив следующее управление меню:

[10] Input >
	 INx > FS Mode

Off Кадровый синхронизатор выключается. В 
этом случае будет действовать функция 
строчного синхронизатора.
С помощью функции строчного 
синхронизатора автоматически 
настраиваются фазы входных видеосигналов 
в соответствии с фазами сигналов строчной 
синхронизации.

Normal Включается функция кадрового 
синхронизатора. В случае ввода сигнала, 
формат которого отличается от формата 
системы, экран чернеет.

Auto Включается функция кадрового 
синхронизатора. Даже в случае ввода 
сигнала, формат которого отличается от 
формата системы, экран не чернеет.
В таком случае выходной видеосигнал может 
прерываться.

	p Если фаза выходного сигнала имеет значение 
[0H], нельзя выбрать значение “выкл.” в качестве 
параметра FS. 
Если для пункта FS задано значение “Off”, оно 
меняется на Normal.
	p При вводе сигналов отображения 3G-SDI Level B 
установите для настройки кадрового синхронизатора 
значение “Auto”.

Установка длительности задержки

Входные сигналы можно задерживать.
	p Данная настройка применима к входным сигналам на 
входах от SDI IN1 до 4.

	p Она не влияет на внедренные аудиоданные.

Установите величину задержки, осуществив следующее 
управление меню:

[10] Input >
	 INx > FS Delay

Замораживание входных сигналов

Входные сигналы SDI/HDMI могут быть заморожены и 
использованы в таком виде. 
При замораживании каких-либо из входов 
соответствующие сигналы на выход не поступают.

Настройка функции замораживания

1	Определите действие при замораживании, осуществив 
следующее управление меню:

[10] Input >
	  INx > Freeze Select

Frame Происходит покадровое замораживание 
изображения.

Field Происходит полукадровое замораживание 
изображения.
Этот режим служит для замораживания 
подвижных изображений.
Однако, при чередовании сигналов 
диагональные линии и движущиеся 
части изображения будут отображаться с 
“зазубринами”.

	p При замораживании изображения можно также 
установить параметры кадра или поля.

2	Замораживайте и отпускайте входные изображения, 
осуществив следующее управление меню:

[10] Input >
	  INx > Freeze

	p При переключении с “Disable” на “Enable” сигналы 
изображений замораживаются.

	p При переключении с “Enable” на “Disable” сигналы 
изображений перестают быть замороженными.  
При заморозке сигналов, для которых установлен 
выход на многооконные дисплеи, перед названием 
источника отображается метка “F”.

	p Если устройство работает в режиме отключенной 
(Off) функции кадровой синхронизации, то при 
выполнении замораживания входных сигналов может 
происходить искажение выходных изображений, 
однако замораживание не влияет негативно на 
входные замороженные изображения.

	p Если при использовании переключателя, когда для 
функции кадрового синхронизатора установлено 
значение OFF, установлено значение “Enable” в 
качестве установки замораживания, для функции 
кадрового синхронизатора будет автоматически 
установлено значение ON.
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Настройки ограниченного диапазона

На данном устройстве можно задать настройки для 
полного и ограниченного диапазонов, чтобы они 
подходили уровням тонов HDMI подключенных устройств, 
например, камер.

[10] Input >
	 INx > Limited

Off Выберите, если уровни тонов входа HDMI 
соответствуют полному диапазону.

On Выберите, если уровни тонов входа HDMI 
соответствуют ограниченному диапазону.

	p Полный диапазон: вход HDMI поддерживает RGB от 
0 до 255.
	p Ограниченный диапазон: вход HDMI поддерживает 
RGB от 16 до 235. Это также называется 
видеодиапазоном.

Установка названий материалов

Входным сигналам можно присваивать названия 
материалов.
Данные названия можно выбирать из установок по 
умолчанию или пользовательских установок.

Определите тип названия материала, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Name Type

Default
(установки по 
умолчанию)

Следующие названия материалов 
выбираются автоматически:
Шина IN1 до 9

User
(пользовательские 
установки)

Устанавливаются названия 
материалов, содержащие до 32 
символов.

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

Настройка повышающего 
преобразователя

Выберите настройки для SDI IN3, SDI IN4, встроенных в 
указанную ниже дополнительную плату:

1	Настройте чувствительность определения движения 
изображения, осуществив следующее управление 
меню:

[10] Input > 
	 INx > Up/Down Converter > Move Detect

1 Для фиксированных изображений

3 Стандартный

5 Для подвижных изображений

2	Настройте уровень резкости границ изображения, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Up/Down Converter > Sharp

1 Нерезкие края

3 Стандартный

5 Резкие края

Настройка входных/выходных сигналов
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Цветокорректор

Задайте настройки встроенных в SDI/HDMI 
цветокорректоров.

Настройки цветокорректора

Включите (вкл.)/выключите (выкл.) для цветокорректора, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Color Correct > C/C

Управление обработкой

1	Установите значение усиления сигнала Y, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Color Correct > C/C Process > Y-Gain

2	Установите значение уровня гашения, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Color Correct > C/C Process > Pedestal

3	Установите значение усиления насыщенности, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Color Correct > C/C Process > C-Gain

4	Установите величину изменения оттенка, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Color Correct > C/C Process > Hue
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Установка входных сигналов HDMI

Задайте настройки входных сигналов HDMI
На вход могут подаваться сигналы с приведенными ниже разрешениями.

<Таблица совместимости входных сигналов HDMI>

Входные сигналы HDMI
Формат системы

1080/ 
59.94p

1080/ 
50p

1080/ 
29.97p

1080/ 
25p

1080/ 
24p

1080/ 
23.98p

1080/ 
59.94i

1080/ 
50i

720/ 
59.94p

720/ 
50p

1080/59.94p 
(1920 x 1080)/ 
59,94 Гц, 60 Гц

 – – – – –  –  –

1080/50p 
(1920 x 1080)/50 Гц –  – – – – –  – 

1080/29.97p 
(1920 x 1080)/ 
29,97 Hz

– –  – – – – – – –

1080/25p 
(1920 x 1080)/25 Гц – – –  – – – – – –

1080/24p 
(1920 x 1080)/24 Гц – – – –  – – – – –

1080/23.98p 
(1920 x 1080)/ 
23,98 Hz

– – – – –  – – – –

1080/59.94i 
(1920 x 1080)/ 
59,94 Гц, 60 Гц

 –  – – –  –  –

1080/50i 
(1920 x 1080)/50 Гц –  –  – – –  – 

720/59.94p 
(1280 x 720)/59,94 Гц, 60 Гц  – – – – –  –  –

720/50p 
(1280 x 720)/50 Гц –  – – – – –  – 

WSXGA+ 
(1680 x 1200)/60 Гц          

SXGA 
(1280 x 1024)/60 Гц          

WXGA 
(1280 x 768)/60 Гц          

XGA 
(1024 x 768)/60 Гц          

: можно установить.
—: нельзя установить.

	p В случае подачи на вход сигналов с какими-либо другими разрешениями или частотами, корректно импортировать 
сигналы невозможно.  
Изображения, выводимые в таком случае, могут быть черными или поврежденными.

	p Эти устройства несовместимы с HDCP (системой защиты цифрового широкополосного контента).

Определите режим масштабирования, осуществив следующее управление меню:

[10] Input >
	 INx > Scale

Fit-V Коэффициент формы входных изображений сохраняется неизменным, а размер 
изображений увеличивается или уменьшается в соответствии с разрешением по 
вертикали.

Fit-H Коэффициент формы входных изображений сохраняется неизменным, а размер 
изображений увеличивается или уменьшается в соответствии с разрешением по 
горизонтали.

Full Размер входных изображений увеличивается или уменьшается в соответствии с 
системным разрешением.
(Коэффициент формы входных изображений не сохраняется. Степень увеличения или 
уменьшения изображения в вертикальном и в горизонтальном направлениях различны.)
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Отображение информации о входном сигнале HDMI

Данные пункты используются для отображения информации, относящейся к изображениям входного сигнала HDMI. 
Изменить информацию невозможно.

Отображение следующих меню:

[10] Input >
	 INx > Status Information

Size В данном пункте указано количество пикселей в изображениях.
Dot Clock В данном пункте указана частота синхросигнала изображений.
H-Frequency В данном пункте указана частота горизонтальной развертки изображений.
V-Frequency В данном пункте указана частота вертикальной развертки изображений.
Status Detect:

Формат входного сигнала соответствует формату системы этого устройства.
Unsupported:
Формат входного сигнала не соответствует формату системы этого устройства.
Not Detect:
Видеосигнал на устройство не поступает.

Поддерживаемые форматы перечислены ниже.

<Поддерживаемые форматы HDMI>

Входной сигнал HDMI
Частота 

синхросигнала 
(МГц)

Частоты
Горизонтальный 

(кГц)
Вертикальный 

(Гц)
XGA 1024×768 Цифровой 65,0 48,36 60,00

WXGA 1280×768 Цифровой 79,5 47,78 59,87

SXGA 1280×1024 Цифровой 108,0 63,98 60,02

WSXGA+ 1680×1050 Цифровой 146,2 65,29 59,95

720/59.94p 1280×720 Цифровой 74,25/1,001 44,96 60,00/1,001

720/50p 1280×720 Цифровой 74,25 37,50 50,00

1080/59.94i 1920×1080 Цифровой 74,25/1,001 33,72 60,00/1,001

1080/50i 1920×1080 Цифровой 74,25 28,13 50,00

1080/23.98p 1920×1080 Цифровой 74,2 27,0 24,00/1,001

1080/24p 1920×1080 Цифровой 74,2 27,0 24,00

1080/25p 1920×1080 Цифровой 74,2 28,1 25,00

1080/29.97p 1920×1080 Цифровой 74,2 33,7 30,00

1080/59.94p 1920×1080 Цифровой 148,5/1,001 67,50/1,001 60,00/1,001

1080/50p 1920×1080 Цифровой 148,5 56,25 50,00

	p Если формат входных сигналов не поддерживается, импортировать сигналы надлежащим образом может быть 
невозможно, и может появиться черное изображение или искаженное изображение.
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Настройка входного сигнала SRT

Для данного устройства поддерживается ввод до 
2 сигналов SRT.

См. настройки SRT для входов с поддержкой SRT в 
разделе “Установки входного сигнала”.
При настройке входных сигналов SRT сначала выберите 
нужный входной сигнал в следующем меню:

[10] Input > 
	 INx > Streaming Mode

1	Задайте режим подключения, осуществив следующее 
управление меню:

[10] Input >
	 INx > Mode

Caller Определите при установке URL-адреса 
сервера и номера порта источника передачи, 
отправляющего запросы на начало передачи 
с данного устройства.

Listener Определите при установке резервного порта 
при начале передачи извне.

2	Задайте URL-адрес сервера и номер порта источника 
передачи, осуществив следующее управление меню 
(только для звонящего):

[10] Input >
	 INx > Server URL

	p Допускается установка в диапазоне от 1 до 
254 символов.

[10] Input >
	 INx > Server Port

3	Установите номер резервного порта для этого 
устройства, осуществив следующее управление меню 
(только для слушателя):

[10] Input >
	 INx > Port

	p При выборе недоступного порта отображается 
сообщение.

4	Задайте идентификатор потока, осуществив 
следующее управление меню:

[10] Input >
	 INx > Stream ID

	p Допускается установка до 512 символов.
5	Задайте целевые параметры режима шифрования для 

переданных изображений, осуществив следующее 
управление меню:

[10] Input >
	 INx > Encryption

Disable Полученные изображения не 
расшифровываются. Возможна работа с 
незашифрованными изображениями.

Enable Полученные изображения 
расшифровываются.

.

6	Задайте фразу для расшифровки полученных 
изображений, осуществив следующее управление меню:

[10] Input >
	 INx > Passphrase

	p Допускается установка в диапазоне от 10 до 
79 символов.

Отображение информации о входном 
сигнале SRT

Вы можете проверить состояние сигнала SRT, 
подаваемого на данное устройство.
Отображение следующих меню:

[10] Input > 
	 INx > Status Information

Устройство автоматически определяет параметры 
входного сигнала SRT и отображает следующую 
информацию:

Format Отображается информация о формате 
изображений для вводимого сигнала SRT.

Sampling Rate Отображается информация о частоте 
дискретизации для входящего сигнала SRT.

Audio Channel Отображается информация об объемном 
звучании для входящего сигнала SRT.

Compress Отображается информация о формате 
сжатия для входящего сигнала SRT.

Level Отображаются уровни, обозначающие разрешение 
H.264/H.265 и верхний предел частоты кадров.

Status Detect:
Формат входного сигнала соответствует 
формату системы этого устройства.
Unsupported:
Формат входного сигнала не соответствует 
формату системы этого устройства.
Not Detect:
Видеосигнал на устройство не поступает.

Установка названий материалов (входной 
сигнал SRT)

Входным сигналам можно присваивать названия материалов.
Данные названия можно выбирать из установок по 
умолчанию или пользовательских установок.

Определите тип названия материала, осуществив 
следующее управление меню:

[10] Input >
	 INx > Name Type

Default
(установки по 
умолчанию)

Определите названия типов 
материалов из перечисленных: 
Шина IN1 до 9

User
(пользовательские 
установки)

Устанавливаются названия 
материалов, содержащие до 32 
символов.

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /
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NDI/NDI|HX

Данное устройство поддерживает вход 2 сигналов HB и 
2 сигналов HX, т.е. всего до 4 сигналов NDI/NDI|HX.

NDI|HX

Данное устройство поддерживает NDI|HX версии 1 и 
NDI|HX версии 2.
NDI|HX версии 1 и NDI|HX версии 2 поддерживают H.264 
в качестве стандарта сжатия изображений. NDI|HX версии 
2 также поддерживает H.265.

Настройка входного сигнала NDI

См. настройки NDI для входов с поддержкой NDI в 
разделе “Установки входного сигнала”.
При настройке входных сигналов NDI сначала выберите 
нужный входной сигнал в следующем меню:

[10] Input >
	 INx > Streaming Mode

1	Выберите режим поиска источников входа NDI в сети, 
осуществив следующее управление меню:

[10] Input >
	 INx > Scan Mode

HB/HX v2 Выполняется поиск источников входных 
сигналов NDI или NDI|HX версии 2.

HX v1 Выполняется поиск источников входных 
сигналов NDI|HX версии 1.

2	Нажмите диск OSD/TIME (Выполнить) в следующем 
меню, чтобы выполнить поиск устройства:

[10] Input >
	 INx > Scan

	p Результаты поиска отображаются в виде списка в 
формате MACHINE NAME(SOURCE NAME).
	p Машинный поиск в сети может занять некоторое 
время.

3	Выберите комбинацию устройства, которое будет 
установлено в качестве источника входного сигнала, 
и источника изображения NDI, а затем подтвердите с 
помощью диска OSD/TIME.

	p Это можно отменить, выбрав “None”.

Настройки протокола приема

Задайте протокол для использования с передатчиком 
NDI.

1	Задайте протокол для использования с передатчиком 
NDI, осуществив следующее управление меню:

[10] Input >
	 INx > Protocol

TCP Установка TCP в качестве протокола 
для использования с передатчиком NDI. 
(Значение по умолчанию) 
Позволяет передавать данные при помощи 
sTCP.

UDP Установка UDP в качестве протокола для 
использования с передатчиком NDI. 
Позволяет передавать данные при помощи 
UDP и sTCP.

	p Вышестоящий протокол выбирается путем 
согласования с настройками протокола на стороне 
передачи NDI.

	p sTCP (однопутевой TCP): способ связи, 
ориентированный на соединение, который 
гарантирует точную доставку данных, но скорость 
передачи данных ниже по сравнению с UDP.

	p UDP: способ связи без установления соединения, 
обеспечивающий высокоскоростную передачу 
данных, но надежность этих данных ниже, чем у 
TCP.

	p При выполнении многоадресных передач 
необходимо задать постоянный протокол UDP.

Примечания
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Отображение информации о входном 
сигнале NDI

Вы можете проверить состояние сигнала NDI, 
подаваемого на данное устройство.
Отображение следующих меню:

[10] Input >
	 INx > Status Information

Устройство автоматически определяет параметры 
входного сигнала NDI и отображает следующую 
информацию:

Format Отображается информация о формате 
изображений для вводимого сигнала NDI.

Sampling 
Rate

Отображается информация о частоте 
дискретизации для входящего сигнала NDI.

Audio 
Channel

Отображается информация об объемном 
звучании для входящего сигнала NDI.

Frame Data Отображается информация о цвете для 
входящего сигнала NDI.

Compress Отображается информация о формате 
сжатия для входящего сигнала NDI.

Streaming 
Mode

Отображается информация о формате для 
входящего сигнала NDI.

Level Отображаются уровни, обозначающие 
разрешение H.264/H.265 и верхний 
предел частоты кадров. Эти данные не 
отображаются для NDI с высокой пропускной 
способностью.

Status Detect:
Формат входного сигнала соответствует 
формату системы этого устройства.
Unsupported:
Формат входного сигнала не соответствует 
формату системы этого устройства.
Not Detect:
Видеосигнал на устройство не поступает.

Установка названий материалов (входной 
сигнал NDI)

Входным сигналам можно присваивать названия 
материалов.
Данные названия можно выбирать из установок по 
умолчанию или пользовательских установок.

Определите тип названия материала, осуществив 
следующее управление меню:

[10] Input >
	 INx > Name Type

Default
(установки по 
умолчанию)

Следующие названия материалов 
выбираются автоматически:
Шина IN1 до 9

User
(пользовательские 
установки)

Устанавливаются названия 
материалов, содержащие до 32 
символов.

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

Входные настройки для материала с 
альфа-каналом

Данное устройство поддерживает входные сигналы NDI и 
сигналы с альфа-каналом, переключаясь между ними для 
использования в качестве материала.
Поддерживается ввод не более 1 набора сигналов NDI 
с альфа-каналом, с настройками, указанными в таблице 
ниже, возможными при переключении режима ввода:

Настройки альфа-канала
Отключен Включен

IN8 Заполнение Заполнение
IN9 Заполнение Вставка

Включите/выключите для альфа-канала, осуществив 
следующее управление меню:

[10] Input >
	 INx > Alpha Setting > Use alpha

Группы настроек

Задав для отправителей и получателей NDI группы, к 
которым каждый из них принадлежит, можно указать 
группу для поиска при выполнении машинного поиска.
Можно указать несколько групп, разделяя их запятыми.
Эта функция недоступна для NDI|HX версии 1.

1	Включите/выключите для функции поиска группы, 
осуществив следующее управление меню:

[10] Input >
	 INx > Group > Group

Enable Функция поиска группы включена.
Disable Функция поиска группы отключена. (Значение 

по умолчанию)

2	Введите название группы, осуществив следующее 
управление меню:

[10] Input >
	 INx > Group > Group Name

	p Можно ввести строку длиной не более 64 символов.
<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /
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Настройки сервера обнаружения

Можно настроить функцию автоматического поиска 
источников NDI для централизованной регистрации на 
внешнем сервере.
Включение этой настройки эффективно, если в 
сети имеется большое количество источников NDI и 
желательно избежать увеличения трафика, или если 
многоадресная передача невозможна или нежелательна.

1	Выберите, нужно ли устанавливать внешний сервер, 
осуществив следующее управление меню:

[10] Input >
	 INx > Use Discovery server > 

Use Discovery server

Enable Настройки внешнего сервера включены.
Disable Настройки внешнего сервера отключены. 

(Значение по умолчанию)

2	Введите IP-адрес внешнего сервера, осуществив 
следующее управление меню:

[10] Input >
	 INx > Use Discovery server >

Discovery server IP

Настройки порта RTSP

Можно задать порт и URL-адрес запроса для данного 
устройства в соответствии с настройками порта RTSP 
подключаемой камеры.
Эта функция действует для NDI|HX версии 1.

1	Введите номер порта RTSP, соответствующего 
настройкам камеры, осуществив следующее 
управление меню:

[10] Input >
	 INx > RTSP > Port

	p Номера портов 10668, 10669 и 10670 использовать 
невозможно.

2	Введите URL-адрес запроса, соответствующего 
настройкам камеры, осуществив следующее 
управление меню:

[10] Input >
	 INx > RTSP > Request URL

	p Введите строку длиной не более 255 символов.
<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

3	После ввода порта и URL-адреса запроса нажмите 
диск OSD/TIME (Выполнить) в следующем меню, чтобы 
обновить настройки с учетом изменений:

[10] Input >
	 INx > RTSP > Connect

Настройки входного сигнала аналогового 
аудио

Данное устройство поддерживает ввод аналогового аудио 
по двум входным каналам (левый и правый каналы) 
устройства.

1	Включите ввод аналогового аудио, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Analog IN > Audio

Off Ввод аналогового аудио выключен.
On Ввод аналогового аудио включен.

2	Установите уровень громкости аналогового аудио, 
осуществив следующее управление меню:

[15] Ancillary/Audio >
	 Analog IN > Input Type

LINE Установка в соответствии с уровнем 
громкости линейного входа.

MIC Установка в соответствии с уровнем 
громкости входа микрофона.

3	Задайте усиление, осуществив следующее управление 
меню:

[15] Ancillary/Audio >
	 Analog IN > Gain

	p Можно установить усиление в пределах от –36 до 12 
дБ.

4	Установите величину задержки, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Analog IN > Delay (ms)

	p Можно установить величину в пределах от 0 до 512 
мс.
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Установки выходного сигнала
Доступны следующие выходы:

<Выход (общий)>
Название 

логического выхода
Название 

физического выхода Ограничения

OUT1 SDI OUT1

OUT2 SDI OUT2

OUT3 HDMI OUT

OUT4 LAN SRT/RTMP/NDI

OUT5 LAN SRT/RTMP/NDI

OUT6 USB STREAM OUT Определенное 
назначение UVC

Перед выполнением установки выходных сигналов сначала выберите выходные сигналы, которые необходимо 
настроить, с помощью подменю Output.

[11] Output > 
	 OUT4 > Streaming Mode

[11] Output > 
	 OUT5 > Streaming Mode

<Перечень установок выходного сигнала>

Выходной 
разъем

Меню настроек и страница в этом руководстве

Assign Видеовыход 
SDI

Видеовыход 
HDMI

Понижающий 
преобразователь Масштаб Видеовыход 

SRT
Видеовыход 

NDI
Видеовыход 

RTMP
Видеовыход 

UVC
P77 – P77 – P77 P78 P79 P81 P81

SDI OUT 
1   – – – – – – –

SDI OUT 
2   – – – – – – –

HDMI 
OUT  –  –  – – – –

IP(OUT4)  – – – –    –

IP(OUT5)  – – – –    –

UVC 
OUT  – – – – – – – 

: можно установить.
	 —: нельзя установить.
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Назначение выходных сигналов

Назначьте выходные сигналы на каждый из выходов.

Установите тип выходного сигнала, осуществив 
следующее управление меню:

[11] Output >
	 OUTx > Assign

PGM Изображение, к которому применяется 
вытеснение, смешивание, вставка, передняя 
вставка или другой эффект, выводится на 
основной линейный выход переключателя.

PVW Выход для предварительного просмотра, 
который позволяет проверить следующую 
операцию перед ее выполнением.

CLN Выводится чистый сигнал (изображение, 
полученное в результате удаления вставки, 
передней вставки или другого эффекта из 
сигнала PGM).

AUX1, AUX2 Выводятся сигналы, выбранные 2 линиями 
шин AUX (AUX1, AUX2).

MV Выводятся сигналы многоканального 
просмотра. 
Несколько входных сигналов и выходных 
сигналов уменьшаются в размере и 
выводятся на один экран.

KeyOut Выводится сигнал вставки.

Настойка выходных сигналов HDMI

Задайте настройки выходных сигналов HDMI

1	Установите тип выходного сигнала, осуществив 
следующее управление меню:

[11] Output >
	 OUT3 > Assign

 См. раздел “Назначение выходных сигналов”.
2	Определите выходное разрешение видео, осуществив 

следующее управление меню:

[11] Output >
	 OUT3 > Size

Auto Информация об оборудовании места 
назначения выходного сигнала записывается 
с помощью сигналов HDMI, а изображения 
выводятся с оптимальным разрешением.

XGA (1024 × 768) / 60 Гц
WXGA (1280 × 768) / 60 Гц
SXGA (1280 × 1024) / 60 Гц
WXGA+ (1680 × 1050) / 60 Гц
Native Вывод в таком же формате, как и формат 

системы.

3	Установите выходное цветовое пространство, 
осуществив следующее управление меню:

[11] Output >
	 OUT3 > Color

Auto Информация об устройстве для объекта 
соединения получается с помощью сигнала 
HDMI, и соответственно для вывода используется 
оптимальное цветовое пространство.

RGB Для цветового пространства задается формат RGB.
YUV444 Для цветового пространства задается формат Y, 

Cb, Cr 4:4:4. (При этом методе для каждого из 4 
горизонтальных пикселей число выборок каждого 
пикселя составляет 4 для компоненты яркости и 2 
для цветоразностных компонент)

YUV422 Для цветового пространства задается формат 
Y, Cb, Cr 4:2:2. 
(При этом методе для каждого из 2 
горизонтальных пикселей производится 
выборка 1 пикселя для цветоразностных 
компонент и выборка каждого пикселя для 
компоненты яркости)

4	Определите режим масштабирования, осуществив 
следующее управление меню:

[11] Output >
	 OUT3 > Scale

Fit-V Коэффициент формы выходных изображений 
сохраняется, а размер изображений на 
выходе увеличивается или уменьшается в 
соответствии с разрешением по вертикали. 
(Те области экрана, в которых нет 
изображения, заполняются черным цветом. 
Области изображений, выходящие за 
пределы экрана, обрезаются.)

Fit-H Коэффициент формы выходных изображений 
сохраняется, а размер изображений на 
выходе увеличивается или уменьшается в 
соответствии с разрешением по горизонтали.
(Те области экрана, в которых нет 
изображения, заполняются черным цветом. 
Области изображений, выходящие за 
пределы экрана, обрезаются.)

Full Размер изображений на выходе 
увеличивается или уменьшается в 
соответствии с разрешением системы.

Full80% Размер выходного изображения 
увеличивается или уменьшается в 
соответствии с 80% от размера разрешения 
системы.

Full90% Размер выходного изображения 
увеличивается или уменьшается в 
соответствии с 90% от размера разрешения 
системы.

	p Формат кадра не сохраняется при установке Full, 
Full80% или Full90%. 
Степень увеличения или уменьшения изображения 
в вертикальном и в горизонтальном направлениях 
различны.

5	Настройте чувствительность определения движения 
изображения, осуществив следующее управление 
меню:

[11] Output >
	 OUT3 > Move Detect

1 Для фиксированных изображений

3 Стандартный

5 Для подвижных изображений
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Настойка выходных сигналов SRT

Для данного устройства поддерживается вывод до 2 
сигналов SRT.

Выполните назначение выходных сигналов SRT.

1	Установите тип выходного сигнала, осуществив 
следующее управление меню:

[11] Output >
	 OUTx > Assign

 См. раздел “Назначение выходных сигналов”.
2	Задайте режим подключения, осуществив следующее 

управление меню:

[11] Output >
	 OUTx > Mode

Caller Определите при установке URL-адреса 
сервера и номера порта цели передачи, 
отправляющего запросы на начало передачи 
с данного устройства.

Listener Определите при установке резервного порта 
при начале передачи извне.

3	Определите URL-адрес, порт и идентификатор потока, 
осуществив следующее управление меню (только для 
звонящего):

[11] Output >
	 OUTx > Destination URL

[11] Output >
	 OUTx > Destination Port

[11] Output >
	 OUTx > Stream ID

Destination URL URL-адрес подключенного сервера
Destination Port Порт подключенного сервера
Stream ID Идентификатор потока подключенного 

сервера

	p Для разрешения доменного имени подключенного 
сервера необходимы установки DNS.

	p Для URL-адреса места назначения допускается 
установка в диапазоне от 1 до 254 символов.

<Символы, доступные для URL-адреса места 
назначения>

От A до Z, от a до z, от 0 до 9, -, .

	p Для идентификатора потока допускается установка 
до 512 символов.

<Символы, доступные для идентификатора 
потока>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

4	Установите резервный порт, осуществив следующее 
управление меню (только для слушателя):

[11] Output >
	 OUTx > Port

	p При выборе недоступного порта отображается 
сообщение.

5	Задайте ограничение TTL/HOP, осуществив следующее 
управление меню:

6	Установите время с момента отправки изображений 
до момента их воспроизведения на принимающем 
устройстве, осуществив следующее управление меню:

[11] Output >
	 OUTx > Latency(ms)

	p Заданное время может не обеспечиваться в 
зависимости от пропускной способности сети.

7	Задайте целевые параметры режима шифрования для 
передаваемых изображений, осуществив следующее 
управление меню:

[11] Output >
	 OUTx > Encryption

Disable Изображения передаются без шифрования.
AES128 Изображения передаются с шифрованием 

AES-128.
AES256 Изображения передаются с шифрованием 

AES-256.

8	Задайте фразу для расшифровки зашифрованных 
изображений, осуществив следующее управление меню:

[11] Output >
	 OUTx > Passphrase

	p Допускается установка в диапазоне от 10 до 
79 символов.

9	Выберите H.264 или H.265 в качестве формата 
изображения, осуществив следующее управление меню:

[11] Output >
	 OUTx > Codec

:	�Задайте целевые параметры режима контроля 
скорости передачи данных для формата изображений, 
осуществив следующее управление меню:

[11] Output >
	 OUTx > Rate Control Mode

CBR Передача осуществляется со скоростью передачи 
данных, установленной в качестве целевой.

VBR Передача осуществляется со скоростью 
передачи данных, близкой к установленной 
в качестве целевой, с установленной 
максимальной скоростью передачей данных 
в соответствующем пункте.
Фактическая скорость передачи 
данных определяется в зависимости от 
передаваемого видео.

;	�Задайте целевую скорость передачи данных, 
осуществив следующее управление меню:

[11] Output >
	 OUTx > Target bit rate

<	�Установите максимальную скорость передачи данных, 
осуществив следующее управление меню (только для 
VBR):

[11] Output >
	 OUTx > Max bit rate



79

Настройка входных/выходных сигналов

Настойка выходных сигналов NDI

Для данного устройства поддерживается вывод до 
2 сигналов NDI.
Вывод NDI|HX невозможен.

Для сигналов NDI имеется 1 выход High Bandwidth и 
1 выход Low Bandwidth, и они выводятся постоянно при 
каждом выводе NDI.

NDI|HX

Это устройство может выводить только сигналы NDI. Оно 
не может выводить сигналы NDI|HX версии1/2.

Назначение выходных сигналов NDI

Выполните назначение выходных сигналов NDI.

Установите тип выходного сигнала, осуществив 
следующее управление меню:

[11] Output >  
	 OUTx > Assign

 См. раздел “Назначение выходных сигналов”.

Общие настройки выходных сигналов NDI

На этом устройстве можно задать с помощью строк 
символов параметры Machine Name и Source Name, 
отображаемые при поиске с приемника NDI.

1	Задайте отображаемое название для приемника NDI, 
осуществив следующее управление меню:

[11] Output > 
	 OUTx > Machine Name

	p Можно ввести строку длиной не более 20 символов.
2	Задайте отображаемое название для приемника NDI, 

осуществив следующее управление меню:

[11] Output > 
	 OUTx > Source Name

	p Можно ввести строку длиной не более 32 символов.
<Символы, которые можно использовать в именах 
файлов>

От A до Z, от a до z, от 0 до 9, пробел, -, _

Настройки протокола передачи NDI

Задайте протокол для использования с приемником NDI.

1	Задайте протокол для использования с приемником 
NDI, осуществив следующее управление меню:

[11] Output > 
	 OUTx > Protocol

TCP В качестве протокола для использования с 
приемником NDI задан TCP. (Значение по 
умолчанию)
Позволяет передавать данные при помощи 
sTCP.

UDP В качестве протокола для использования с 
приемником NDI задан UDP.
Позволяет передавать данные при помощи 
UDP и sTCP.

	p Вышестоящий протокол выбирается путем 
согласования с настройками протокола на стороне 
передачи NDI.

	p sTCP (однопутевой TCP): способ связи, 
ориентированный на соединение, который 
гарантирует точную доставку данных, но скорость 
передачи данных ниже по сравнению с UDP.

	p UDP: способ связи без установления соединения, 
обеспечивающий высокоскоростную передачу 
данных, но надежность этих данных ниже, чем у 
TCP.

	p При выполнении многоадресных передач 
необходимо задать постоянный протокол UDP.

Примечания
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Настройки многоадресной передачи NDI

Задайте, нужно ли включить или отключить 
многоадресную передачу для приемника NDI.
Когда должны быть включены многоадресные передачи, 
они выполняются в соответствии с настройками 
IP-адреса, маски подсети и лимита TTL/HOP.
С помощью этого устройства можно выполнять 
многоадресные передачи в пределах одной подсети.

1	Включите или выключите для многоадресных передач, 
осуществив следующее управление меню:

[11] Output >  
	 OUTx > Multicast > Multicast

Enable Многоадресная передача на приемник NDI 
включена.

Disable Многоадресная передача на приемник NDI 
отключена. (Значение по умолчанию)

2	Задайте IP-адрес, маску подсети и TTL, осуществив 
следующее управление меню:

[11] Output > 
	 OUTx > Multicast > IP Address

[11] Output > 
	 OUTx > Multicast > Subnet Mask

[11] Output > 
	 OUTx > Multicast > TTL/HOP Limit

Группы настроек NDI

Задав для отправителей и получателей NDI группы, к 
которым каждый из них принадлежит, можно указать 
группу для поиска при выполнении машинного поиска.
Можно указать несколько групп, разделяя их запятыми.

1	Включите/выключите для функции поиска группы, 
осуществив следующее управление меню:

[11] Output > 
	 OUTx > Group > Group

Enable Функция поиска группы включена.
Disable Функция поиска группы отключена. (Значение 

по умолчанию)

2	Введите название группы, осуществив следующее 
управление меню:

[11] Output > 
	 OUTx > Group > Group Name

	p Можно ввести строку длиной не более 64 символов.
<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

Настройки сервера обнаружения NDI

Можно настроить функцию автоматического поиска 
источников NDI для централизованной регистрации на 
внешнем сервере.
Включение этой настройки эффективно, если в 
сети имеется большое количество источников NDI и 
желательно избежать увеличения трафика, или если 
многоадресная передача невозможна или нежелательна.

1	Включите/выключите для настроек внешнего сервера, 
осуществив следующее управление меню:

[11] Output > 
	 OUTx > Use Discovery server > 

Use Discovery server

Enable Настройки внешнего сервера включены.
Disable Настройки внешнего сервера отключены. 

(Значение по умолчанию)

2	Введите IP-адрес для настроек внешнего сервера, 
осуществив следующее управление меню:

[11] Output > 
	 OUTx > Use Discovery server > 

Discovery server IP
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Настойка выходных сигналов RTMP

Для данного устройства поддерживается вывод до 
2 сигналов RTMP.

Выполните назначение выходных сигналов RTMP.

1	Установите тип выходного сигнала, осуществив 
следующее управление меню:

[11] Output > 
	 OUTx > Assign

 См. раздел “Назначение выходных сигналов”.
2	Установите URL-адрес и ключ потоковой передачи 

сервера, осуществив следующее управление меню:

[11] Output > 
	 OUTx > Server URL

[11] Output > 
	 OUTx > Stream Key

Server URL URL-адрес подключенного сервера
Stream Key Ключ потоковой передачи подключенного 

сервера

	p Для разрешения доменного имени подключенного 
сервера необходимы установки DNS.
	p Для URL-адреса сервера допускается установка в 
диапазоне от 1 до 254 символов.
	p Для ключа потоковой передачи допускается 
установка до 512 символов.

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

3	Задайте целевые параметры режима контроля 
скорости передачи данных для формата изображений, 
осуществив следующее управление меню:

[11] Output > 
	 OUTx > Rate Control Mode

CBR Передача осуществляется со скоростью 
передачи данных, установленной в качестве 
целевой.

VBR Передача осуществляется со скоростью 
передачи данных, близкой к установленной 
в качестве целевой, с установленной 
максимальной скоростью передачей данных 
в соответствующем пункте.
Фактическая скорость передачи 
данных определяется в зависимости от 
передаваемого видео.

4	Задайте целевую скорость передачи данных, 
осуществив следующее управление меню:

[11] Output > 
	 OUTx > Target bit rate

5	Установите максимальную скорость передачи данных, 
осуществив следующее управление меню (только для 
VBR):

[11] Output > 
	 OUTx > Max bit rate

Настойка выходных сигналов UVC

Данное устройство поддерживает вывод UVC (класс USB 
для видео) и UAC (класс USB для аудио).
При подключении разъема USB (разъем типа-C) к 
компьютеру это устройство можно использовать в 
качестве веб-камеры.
Для подключения этого устройства к компьютеру 
используйте кабель USB, поддерживающий USB3.0.

Выполните назначение выходных сигналов UVC.

1	Установите тип выходного сигнала, осуществив 
следующее управление меню:

[11] Output > 
	 OUTx > Assign

 См. раздел “Назначение выходных сигналов”.
2	Установите разрешение выходного сигнала, 

осуществив следующее управление меню:

[11] Output > 
	 Mode

Normal Вывод с разрешением 1080.
720p Вывод с разрешением 720.

	p При формате системы 720/59.94p или 50p, этот 
параметр отображается серым цветом, а сигнал 
выводится с разрешением 720. 

Если в результате изменения настроек формата 
системы меняется формат вывода, на компьютере 
необходимо будет перезапустить приложение, 
принимающее изображения UVC.

Примечание
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Настройки вывода аналогового аудио

На данном устройстве присутствует 1 разъем для 
наушников [  ] (Φ3,5 мм стерео мини-гнездо).

Назначьте аналоговые выходные сигналы

1	Установите тип выходного сигнала, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Analog OUT > Assign

PGM Осуществляет вывод аудиоданных 
выбранного источника.

PVW
AUX1, 2
CLN

2	Отрегулируйте громкость при помощи диска громкости 
мониторинга.  
Значения можно просмотреть в следующем меню:

[15] Ancillary/Audio >
	 Analog OUT > Volume

3	Вывод аналогового звука можно заглушить вне 
зависимости от установленной громкости мониторинга.  
Установите в следующем меню:

[15] Ancillary/Audio >
	 Analog OUT > Mute

Off Вывод звука не заглушен.
On Вывод звука заглушен.

Значение громкости 2 означает отсутствие 
изменения громкости.

Настройка входных/выходных сигналов
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Настройка входных/выходных сигналов

Отправка операций для сигналов SRT/RTMP

Запуск и остановка операций для сигналов SRT/RTMP осуществляются кнопкой [STREAM].

OFF

Нажать и удерживать  
(1 секунда)

Нажать и  
удерживать  
(1 секунда)

Нажать и удерживать  
(1 секунда)

Короткое нажатие
Короткое нажатие

Короткое нажатие
В эфире Ожидание

OFF Изначальная установка с момента включения 
питания. Сигналы не отправляются. Кнопка 
[STREAM] выключена.

Ожидание Отправляются изображения, установленные 
для этого режима. Кнопка [STREAM] загорится 
зеленым цветом.

В эфире Отправляются изображения, установленные 
для этого режима. Кнопка [STREAM] загорится 
красным цветом.

Нажатие кнопки [SHIFT] изменяет цель операции.

[SHIFT] не нажат IP OUT1
[SHIFT] нажат IP OUT2

Состояние IP OUT1/2 может быть связано при помощи 
следующего управления меню:

[11] Output >
	 OUTx > Streaming Link

Кроме того, можно назначить сигнал изображения для 
ожидания во время вывода SRT/RTMP, осуществив 
следующее управление меню:

[11] Output >
	 OUTx > Assign STDBY

 См. раздел “Назначение выходных сигналов”.
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Можно выбрать сигналы синхронизации, которые будут 
использоваться системой.
Внешняя синхронизация:

Служит для синхронизации по внешнему 
синхросигналу (gen-lock). 
Опорный входной сигнал проходит через цепь 
обратной связи на выход.

BB Сигнал синхронизации черного поля 
(фаза вертикальной развертки 0H)

Tri-level sync Трехуровневый синхросигнал (фаза 
вертикальной развертки 0H)

Internal Служит для синхронизации внутренним 
опорным сигналом (INT). 
Сигнал REFOUT (синхросигнал черного 
поля) выводится через два опорных 
разъема.

	p В данном устройстве поддерживаются сигналы 
синхронизации для частот полей, которые являются 
аналогичными сигналам системного формата.

1	Выберите сигнал синхронизации, осуществив 
следующее управление меню, и нажмите диск OSD/
TIME, чтобы подтвердить выбранное содержимое:

[13] System > 
	 Reference > Sync Select

2	Состояние внешней синхронизации отображается в 
следующем меню:

[13] System > 
	 Reference > Status

Locked Синхронизация внешними синхросигналами 
или внутренними опорными сигналами.

UnLock Без синхронизации внешними 
синхросигналами или внутренними опорными 
сигналами.

Настройка входных/выходных сигналов

Настройка сигналов синхронизации
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Можно выполнить настойку фазы выходных 
видеосигналов.

1	Выберите “0H” или “1H”, осуществив следующее 
управление меню:

[13] System > 
	 Output Phase > System

0H Выходные видеосигналы выводятся в 
качестве синхронных системных опорных 
сигналов Reference. 
Функция кадровой синхронизации включена 
(ON) для всех входных сигналов. 

1H Выходные видеосигналы выводятся в 
качестве синхронных системных опорных 
сигналов Reference с задержкой на 1H. 
Если включена (ON) функция кадрового 
синхронизатора, выходные видеосигналы 
передаются с задержкой 1 кадр + 1H.

2	Отрегулируйте H phase, осуществив следующее 
управление меню:

[13] System > 
	 Output Phase > H-Phase

Пункт H-Phase можно регулировать в диапазоне от 
–0.50H до +0.49H.

	p В меню отображаются разные установки в 
зависимости от формата системы.

3	Отрегулируйте V phase, осуществив следующее 
управление меню:

[13] System > 
	 Output Phase > V-Phase

Пункт V-Phase можно регулировать в диапазоне от 
–100H до +100H.

Настройка входных/выходных сигналов

Настройка фазы выходного сигнала
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Настройка входных/выходных сигналов

Вспомогательные настройки для шины AUX, PGM и PVW
Установите функцию, позволяющую передачу 
вспомогательных данных V и внедренных аудиоданных 
входного сигнала SDI/HDMI.

Установка для выходных сигналов шин AUX (AUX1, 
AUX2)

1	Выберите On/Off, осуществив следующее управление 
меню:

[15] Ancillary/Audio > 
	 Ancillary > AUX

Off Вспомогательные данные и внедренные 
аудиоданные выходных сигналов шины AUX 
(AUX1, AUX2) не передаются.

On Вспомогательные данные и внедренные 
аудиоданные выходных сигналов шины AUX 
(AUX1, AUX2) передаются.

Установка для программных выходных сигналов

2	Выберите On/Off, осуществив следующее управление 
меню:

[15] Ancillary/Audio > 
	 Ancillary > PGM

Off Вспомогательные данные и внедренные 
аудиоданные выходных сигналов PGM не 
передаются.

On Вспомогательные данные и внедренные 
аудиоданные выходных сигналов PGM 
передаются.

Установка для выходных сигналов 
предварительного просмотра

3	Выберите On/Off, осуществив следующее управление 
меню:

[15] Ancillary/Audio > 
	 Ancillary > PVW

Off Вспомогательные данные и внедренные 
аудиоданные выходных сигналов PVW не 
передаются.

On Вспомогательные данные и внедренные 
аудиоданные выходных сигналов PVW 
передаются.

Настройка для чистых выходных сигналов

4	Выберите On/Off, осуществив следующее управление 
меню:

[15] Ancillary/Audio > 
	 Ancillary > CLN

Off Вспомогательные данные и внедренные 
аудиоданные выходных сигналов CLN не 
передаются.

On Вспомогательные данные и внедренные 
аудиоданные выходных сигналов CLN 
передаются.

Установка для выходных сигналов 
многоканального просмотра

5	Выберите PGM/PVW/Off, осуществив следующее 
управление меню:

[15] Ancillary/Audio > 
	 Ancillary > MV

PGM Вспомогательные данные и внедренные 
аудиоданные PGM передаются на все 
выходы MV.

PVW Вспомогательные данные и внедренные 
аудиоданные PVW передаются на все 
выходы MV.

Off Вспомогательные данные и внедренные 
аудиоданные не передаются через какие-
либо выходы MV.

	p В случае сочетания вставок их аудиоданные также 
накладываются.

	p Данные VANC не передаются, если формат входного 
сигнала отличается от формата системы.

Примечания
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Настройка входных/выходных сигналов

Настройки звука для шины AUX, PGM и PVW

Выберите один элемент аудиоданных каждого входного сигнала и выполните настройки функции пропускания для 
каждого из выходных сигналов.
Для каждого выходного сигнала можно выбрать только 1 входной сигнал из указанных ниже.
От IN1 до 9 Пропускаются внедренные аудиоданные каждого входного сигнала.

Analog Пропускаются внедренные аудиоданные разъема аудиовхода.

Follow Video Пропускаются внедренные аудиоданные во входных сигналах, 
выбранных шиной.

OFF Внедренные аудиоданные не пропускаются.

Чтобы эта функция была доступна, необходимо включить вспомогательные настройки для каждой шины.

Настройка звука для выходных сигналов шин AUX 
(AUX1, AUX2)

1	Определите входной сигнал, который будет 
пропускаться через аудиоданные, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Audio Assign > AUX1

[15] Ancillary/Audio >
	 Audio Assign > AUX2

Настройка звука для выходных сигналов 
программы

2	Определите входной сигнал, который будет 
пропускаться через аудиоданные, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Audio Assign > PGM

Настройка звука для выходных сигналов просмотра

3	Определите входной сигнал, который будет 
пропускаться через аудиоданные, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Audio Assign > PVW

Настройка звука для чистых выходных сигналов

4	Определите входной сигнал, который будет 
пропускаться через аудиоданные, осуществив 
следующее управление меню:

[15] Ancillary/Audio >
	 Audio Assign > CLN
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Настройка отображения нескольких картинок

Установка разбивки экрана

Для структуры экрана можно выбрать один из 10 нижеуказанных шаблонов.
Многооконный дисплей этого устройства поддерживает MV.

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit
9Split 10-aSplit 10-bSplit 12Split 16Split

Субэкранам от 1 до 16 можно назначить отображение перечисленных ниже сигналов.

Сигналы, которые можно назначить
От IN1 до 9, Black, CBGD1, CBGD2, CBAR, Still1V, Still1K, Still2V, Still2K, PGM, PVW, CLN, Key Out, AUX1, AUX2, Clock, Analog IN, IP 
OUT1, IP OUT2*1

*1 Состояние отображается, если IP OUT1(OUT4) или IP OUT2(OUT5) установлены на SRT или RTMP.
В отличие от кодирования изображений, отображаемая скорость передачи данных рассчитывается с приоритетом 
на интервал отображения. Это значит, что в некоторых случаях значение будет отличаться от установки вывода.

1	Задайте режим многооконного просмотра, осуществив следующее управление меню:

[9] MultiView >
	 Split

2	Задайте размер отображения в многооконном режиме, осуществив следующее управление меню:

[9] MultiView >
	 Size

Fit Размеры рамки разделения и разделенного экрана будут одинаковы.
SQ Размеры рамки разделения и разделенного экрана будут меньше, и за пределами разделенного 

экрана будут отображаться название материала, индикатор уровня и т. п.

3	Задайте название сигнала, отображаемое на субэкранах (от 1 до 16), осуществив следующее управление меню:

[9] MultiView >
	 Source Select

	p При выборе входных сигналов (от IN1 до 9) отображение названий материалов, установленных в следующих меню, 
зависит от знаков и символов:

[10] Input >
	 INx > Name Type

[10] Input >
	 INx > Name

	p При выборе шин AUX (AUX1, AUX2) в качестве входного сигнала название материала, отображаемое внутри скобок 
[  ], зависит от знаков и символов.
	p Если сигнал шины AUX, для которой выбрано значение “MV”, был выбран и отображен на субэкране в режиме 
многоканального просмотра, изображения будут циклически повторяться, как будто два зеркала были поставлены 
друг напротив друга.
	p 12 рамок разделения невозможно выбрать для 720p.
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<Режимы отображения>

43

21
21

53 4 21

53 4
21

64 53 21

64 53

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit

7 8 9

4 5 6

1 2 3
1

3 4 5 6

7 8 9 10

2

1

3 4 5 6

7 8 9 10

2

21

653 4 7

11108 9 12

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

9Split 10-aSplit 10-bSplit 12Split 16Split

Настройка отображения нескольких картинок
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Настройка отображения нескольких картинок

Настройка рамки разбиения и символы

Установите рамку, яркость символов и фона разделенных 
экранов для отображения на многоканальном дисплее.

1	Задайте яркость рамки разбиения и отображение 
рамки разбиения, осуществив следующее управление 
меню:

[9] MultiView > 
	 MV Frame

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100%

Выберите одну из этих установок для яркости 
рамки разбивки (шкала серого).

Off Рамка разбивки не отображается.

2	Задайте яркость символов и отображение символов, 
осуществив следующее управление меню:

[9] MultiView > 
	 MV Character

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100%

Выберите одну из установок яркости 
символов (шкала серого).

Off Символы не отображаются. 
Никакой символьный фон не отображается.

3	Задайте отображение фона символов (полутон) с 
помощью следующих операций с меню:

[9] MultiView > 
	 MV Label

On Символьный фон отображается.
Off Символьный фон не отображается.

	p Этот параметр доступен при включенном режиме Fit.

Установки сигнальных дисплеев

Установите наложение сигнальных дисплеев на рамку 
разбиения многоканального просмотра изображения.
На этом устройстве можно установить 2 сигнальные 
группы, и для каждой группы можно задать материалы.
Красный и зеленый сигналы можно отобразить на 
многооконном дисплее.

1	Выберите материал, который необходимо назначить 
на красный и зеленый индикаторы, осуществив 
следующее управление меню:

[13] System > 
	 Tally Settings > Tally Target > Red Tally

[13] System >
	 Tally Settings > Tally Target > Green Tally

Off Отсутствие сигнала
PGM Программный сигнал видео
PVW Сигнал видео предварительного просмотра
CLN Чистый сигнал
KeyOut Выходной сигнал вставки
AUX1 Выходной сигнал шины AUX1
AUX2 Выходной сигнал шины AUX2
IP OUT1 Выходной сигнал IP OUT1
IP OUT2 Выходной сигнал IP OUT2

2	Отображение следующих меню:

[9] MultiView > 
	 Red Tally

[9] MultiView > 
	 Green Tally

	p Красный и зеленый индикаторы, заданные в 
пункте  выше, можно задать для отображения на 
многооконном дисплее.

3	Установите наложение сигнальных дисплеев на рамку 
разбиения многоканального просмотра изображения.

IN1Левый 
ярлык

Правый 
ярлык

Окно

On Отображаются сигнальные индикаторы.
Off Символьные дисплеи не отображаются.
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Настройка отображения нескольких картинок

Изменение названий материалов 
(входного сигнала)

Названия материалов для входных сигналов (от IN1 до 9), 
задаваемые на многооконном дисплее, можно изменить.
Данные названия можно выбирать из установок по 
умолчанию или пользовательских установок.

1	Определите тип названия материала, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Name Type

Default
(установки по 
умолчанию)

Следующие названия материалов 
выбираются автоматически.  
Шина IN1 до 9

User
(пользовательские 
установки)

Устанавливаются названия 
материалов, содержащие до 
32 символов.

Процедура установки пользовательского типа

1	Установите название типа материала на “User”, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Name Type

2	Введите название материала, осуществив следующее 
управление меню:

[10] Input > 
	 INx > Name

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

Изменение названий материалов 
(выходного сигнала)

Названия материалов для выходных сигналов (AUX1, 
AUX2), задаваемые на многооконном дисплее, можно 
изменить.
Данные названия можно выбирать из установок по 
умолчанию или пользовательских установок.

Определите тип названия материала для AUX1 и AUX2, 
осуществив следующее управление меню:

[12] Config > 
	 AUX Name > AUX1 Type

[12] Config > 
	 AUX Name > AUX2 Type

Default
(установки по 
умолчанию)

Следующие названия материалов 
выбираются автоматически.  
AUX1, AUX2

User
(пользовательские 
установки)

Устанавливаются названия 
материалов, содержащие до 
32 символов.

Процедура установки пользовательского типа

1	Установите название типа материала на “User”, 
осуществив следующее управление меню:

[12] Config > 
	 AUX Name > AUX1 Type

[12] Config > 
	 AUX Name > AUX2 Type

2	Введите название материала, осуществив следующее 
управление меню:

[12] Config > 
	 AUX Name > AUX1 Name

[12] Config > 
	 AUX Name > AUX2 Name

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

Установка измерителей уровня

В каждом разделенном экране можно отобразить 
индикаторы уровня для аудиосигналов, передаваемых 
вместе с каждым входным и выходным сигналом.

Левый дисплей: канал 1 группы 1
Правый дисплей: канал 2 группы 1

Задайте отображение индикатора уровня, осуществив 
следующее управление меню:

[9] MultiView > 
	 Display > Level Meter

OFF Индикаторы уровня не отображаются.
IN ON Отображаются индикаторы уровня для 

входного сигнала (в том числе разъема 
аудиовхода) и цветовых полос.

OUT ON Отображаются индикаторы уровня для PGM/
PVW/CLN/AUX.

IN/OUT ON Отображаются индикаторы уровня для 
входного сигнала (в том числе разъема 
аудиовхода), цветовых полос и PGM/PVW/
CLN/AUX.
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Настройка отображения нескольких картинок

Установка меток входных сигналов

Статус входных сигналов может отображаться перед 
названиями материалов, отображаемыми на секциях 
разделенного экрана.

Метка “F”:
Данная метка появляется при замораживании 
входных сигналов.

Метка “ ! ”:
Данная метка появляется, если не поступают 
сигналы или если поступают сигналы в разных 
форматах.
 �При отображении метки “F” метка “!” не 

отображается.

Настройте отображение состояния входного сигнала, 
осуществив следующее управление меню:

[9] MultiView > 
	 Display > Input Status

On Статус входных сигналов отображается.
Off Статус входных сигналов не отображается.

Установка маркеров

Для материалов многоканального просмотра можно 
отображать маркеры безопасности.

1	Настройте отображение меток, осуществив следующее 
управление меню:

[9] MultiView > 
	 Display > Marker

4:3 Маркеры отображаются с форматом кадра 
4:3.

16:9 Маркеры отображаются с форматом кадра 
16:9.

Off Маркеры не отображаются.

2	Установите размер меток, осуществив следующее 
управление меню:

[9] MultiView > 
	 Display > Marker Size
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Системные параметры

Установка формата системы
Можно выбрать один формат системы (входного/
выходного сигнала).

Не изменяйте формат во время выполнения любой 
из перечисленных ниже операций:

	p Во время чтения с карты памяти или сохранения в 
память USB

	p Во время восстановления данных из видеопамяти 
или сохранении данных во внутреннем хранилище

	p Во время записи движущихся изображений или 
неподвижных изображений

Выберите формат, осуществив следующее управление 
меню, и нажмите диск OSD/TIME, чтобы подтвердить 
выбранное содержимое:

[13] System > 
	 System Format

Назначение сигналов точкам 
микширования

На кнопки точек микширования (от 1 до 12) можно 
назначить внешние входные видеосигналы и внутренние 
генерируемые сигналы.
Состояния назначения кнопок точек микширования от 1 
до 12 отображаются в меню назначения внешнего вывода 
OSD во время того, как кнопки точек микширования от 1 
до 12 удерживаются в нажатом положении.

Изменение текущего распределения сигналов, выбранных 
кнопками пересечения, будет оказывать влияние 
на положение светящихся кнопок пересечения для 
изменения в соответствии с назначенным изменением. 
Выходной сигнал изображений в это время останется без 
изменений.

В приведенной ниже таблице перечислены материалы, 
которые можно назначить.

Сигнал
Что 

появляется 
на дисплее

Description

Шина IN1 
до 9

Шина IN1 
до 9

Вход от 1 до 9
Информацию о расширенном 
назначении сигналов см. в 
разделе “Установки входного 
сигнала”.

Black Black Внутренний сгенерированный 
сигнал (черный)

CBGD1, 
CBGD2

CBGD1, 
CBGD2

Внутренний сгенерированный 
сигнал (цветной фон)

CBAR CBAR Внутренний сгенерированный 
сигнал (цветная полоса)

Still1V, 
Still1K, 
Still2V, 
Still2K

Still1V, 
Still1K, 
Still2V, 
Still2K

Видеопамять неподвижных 
изображений

CLN CLN CLN (только шина AUX и 
изображения на встроенном 
дисплее)

KeyOut KeyOut KeyOut (только шина AUX и 
изображения на встроенном 
дисплее)

None None Нет назначения

	p Изображение не изменяется при нажатии на любую из 
кнопок, которой присвоена функция “None”.

В приведенной ниже таблице указаны настройки, 
заданные по умолчанию.

Кнопка
Что 

появляется 
на дисплее

Кнопка
Что 

появляется 
на дисплее

XPT1 IN1 XPT7 IN7

XPT2 IN2 XPT8 IN8

XPT3 IN3 XPT9 IN9

XPT4 IN4 XPT10 CBAR

XPT5 IN5 XPT11 CBGD1

XPT6 IN6 XPT12 CBGD2

Настройка коммутации точек 
микширования

Можно настроить время коммутации точек микширования.
Данное переключение включает операции кнопок 
коммутации и кнопки [Cut].

Определите время переключения, осуществив 
следующее управление меню:

[8] XPT Assign > 
	 Switch Timing

Any Точка микширования переключается 
ближайшим полем. Эта настройка 
применяется для отображения живого видео.

Field1 Точка микширования переключается полем 1. 
Эта настройка применяется для 
редактирования.

Field2 Точка микширования переключается полем 2. 
Эта настройка применяется для 
редактирования.

Настройка точек микширования
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Назначение кнопок

Настройка пользовательских кнопок

Шести пользовательским кнопкам (от U1 до U6) 
пользователь может назначить несколько функций, 
которые можно установить с помощью пунктов меню.
Если пользовательской кнопке назначена какая-либо 
функция, ее индикатор светится желтым цветом, а если 
функция не назначена, индикатор не светится. 
Всякий раз при нажатии пользовательской кнопки, 
состояние назначения функции переключается между ON 
и OFF.

В приведенной ниже таблице перечислены функции, 
которые можно назначить пользовательским кнопкам (от 
U1 до U6).

Название 
функции

Описание функции

Key1 PVW Вывод изображения KEY1 для 
предварительного просмотра.

Key2 PVW Вывод изображения KEY2 для 
предварительного просмотра.

GPII-EN Включение и выключение GPI-In.

GPIO-EN Включение и выключение GPI-Out.

AUX Trans Включение и выключение переходов шины 
AUX.

AUX1 Trans Включение и выключение переходов шины 
AUX1.

AUX2 Trans Включение и выключение переходов шины 
AUX2.

Effect Dissolve Переключение эффекта растворения 
между значениями ON и OFF.

Capture Still1 Выходной сигнал с шин AUX (AUX1, AUX2) 
записывается в качестве материала в 
Still1.

Capture Still2 Выходной сигнал с шин AUX (AUX1, AUX2) 
записывается в качестве материала в 
Still2.

None Назначение отсутствует.

От Shot Memory1 
до 12

Вызов памяти снимков от 1 до 12.

XPT Disable Включение/выключение памяти снимков 
XPT Disable

■ Установки по умолчанию

Кнопка Название функции Кнопка Название функции
U1 Key1 PVW U4 Shot Memory2

U2 Key2 PVW U5 Shot Memory3

U3 Shot Memory1 U6 Shot Memory4

<Установка метода>
Выберите функции, которые необходимо назначить на 
кнопки от U1 до U6, осуществив следующее управление 
меню:

[12] Config >
	 User Button > User 1

[12] Config >
	 User Button > User 2

[12] Config >
	 User Button > User 3

[12] Config >
	 User Button > User 4

[12] Config >
	 User Button > User 5

[12] Config >
	 User Button > User 6
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Установка даты и времени
Пользователь может установить дату и время, которые 
будут использоваться при маркировке изображений в 
памяти USB. 
Проверьте установку даты и времени при использовании 
памяти USB.

Установка даты

1	Нажмите диск OSD/TIME в меню Date/Time > Date 
Setting, чтобы установить, в следующем порядке, год, 
месяц и день.

[13] System > 
	 Date/Time > Date Setting

2	Во время установки даты нажмите диск OSD/TIME, 
чтобы подтвердить год, месяц и день.

Установка времени

1	Нажмите диск OSD/TIME в меню Date/Time > Time 
Setting, чтобы установить, в следующем порядке, часы, 
минуты и секунды.

[13] System > 
	 Date/Time > Time Setting

2	Во время установки секунд нажмите диск OSD/TIME, 
чтобы подтвердить часы, минуты и секунды.
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Настройки сети для выполнения таких задач, как 
передача файлов изображений и обновление 
программного обеспечения через сеть.
Начальные установки сети следующие: IP-адрес: 
192.168.0.8, маска подсети: 255.255.255.0. 
При использовании хост-компьютера, установки которого 
соответствуют начальным настройкам, выполнять 
настройку через меню не нужно.

Ввод IP-адреса

Задайте IP-адрес, осуществив следующее управление 
меню:

[16] Network >
	 LAN > IP Address

Ввод маски подсети

Задайте маску подсети, осуществив следующее 
управление меню:

[16] Network >
	 LAN > Subnet Mask

Установка основного шлюза

Задайте основной шлюз, осуществив следующее 
управление меню:

[16] Network >
	 LAN > Default Gateway

Отображение адреса MAC

Отобразите MAC-адрес, осуществив следующее 
управление меню:

[16] Network >
	 LAN > MAC Address

Настройки сервера DNS

Установите основной и вторичный сервера DNS, 
осуществив следующее управление меню:

[16] Network >
	 Primary DNS > IP Address

[16] Network >
	 Secondary DNS > IP Address

	p Это необходимо для разрешения доменного имени с 
SRT или RTMP.

	p Если настройка не выполнена, этот пункт будет пустым.

Системные параметры

Сетевые установки
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Установка подсветки кнопок

Подсветка кнопок

Индикаторы кнопок могут быть подсвечены все время. 
Они позволят вам легко прочитать надписи около 
кнопок даже при работе с устройством в местах с низкой 
освещенностью.

1	Создайте установки для выбранной кнопки, осуществив 
следующее управление меню:

[12] Config > 
	 Button Illumination > Button Illumination > 

Lighting

От 80% до 
150%

Подсветка кнопок загорается. Яркость можно 
настроить в диапазоне от 80% до 150%.

2	Создайте установки для кнопки при выключенном 
устройстве, осуществив следующее управление меню:

[12] Config > 
	 Button Illumination > Button Illumination > 

XPT Color

Input Установите [Color Group1] по [Color Group8] 
для каждой Color Group IN, Color Group 
Internal, Color Group Still и Color Group Other 
материалов.

От Color 
Group1 до 8

Можно задать 8 разных цветов.

3	Создайте установки [R], [G], и [B] для подсветки кнопок, 
осуществив следующее управление меню:

[12] Config > 
	 Button Illumination > Button Color Group1

[12] Config > 
	 Button Illumination > Button Color Group2

[12] Config > 
	 Button Illumination > Button Color Group3

[12] Config > 
	 Button Illumination > Button Color Group4

[12] Config > 
	 Button Illumination > Button Color Group5

[12] Config > 
	 Button Illumination > Button Color Group6

[12] Config > 
	 Button Illumination > Button Color Group7

[12] Config > 
	 Button Illumination > Button Color Group8

4	Задайте следующую подсветку кнопок, которую нельзя 
установить в пункте 1, осуществив следующее 
управление меню:

[12] Config > 
	 Button Illumination > Button Illumination > 

Dimmer

USER1, USER2, USER3, Кнопка памяти кадра,
Кнопка SHIFT, Кнопка MENU

On Включение подсветки кнопок.
Off Выключение подсветки кнопок.
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Отображение состояния сигнализации

Сигналы тревоги о проблемах с питанием устройства 
или вентилятором охлаждения отображаются в меню 
назначения внешнего вывода OSD.

Отображение следующих меню:

[13] System >
	 Alarm > Power

[13] System >
	 Alarm > Fan

[13] System >
	 Alarm > Temperature

Состояние сигнала тревоги для источника питания 
отображается в пункте Power.
Состояние сигнала тревоги для охлаждающего 
вентилятора отображается в пункте Fan.
Состояние сигнализации для внутренней температуры 
отображается в пункте Temperature.

No Alarm Нет ошибок
Alarm Ошибка

Аварийное сообщение

При сигналах тревоги в меню назначения внешнего 
вывода OSD отображаются сообщения.
Эти сообщения отображаются только при показе меню 
OSD.

 Отображаемое 
аварийное 
сообщение

Тип проблемы Действие

ALARM ! Fan Stop. Отключение 
охлаждающего 
вентилятора

При нажатии 
OK аварийное 
сообщение будет 
очищено.
 �Немедленно 

обратитесь к 
дилеру.

ALARM ! Power 
Stop.

Падение 
напряжения 
источника питания

ALARM ! High 
temperature.

Повышение 
температуры 
внутри устройства

Отображение информации о версии

Отображение информации о версии ПО и аппаратного 
обеспечения устройства.

Отображение следующих меню:

[13] System >
	 System Information

	p Информация о версии системы устройства 
отображается в пункте System Version.

Системные параметры

Индикация состояний
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Инициализация установочных данных

Инициализация сбрасывают установочные данные до 
состояния заводских.
При инициализации данных настроек данные 
видеопамяти удаляются, но файл проекта, сохраненный 
во внутреннем хранилище, не удаляется.

<Пункты и данные, которые не инициализируются>
	p Перечисленные ниже пункты меню:

[13] System > 
	 Date/Time

[16] Network

1	Нажмите диск OSD/TIME (Выполнить) в следующем 
меню, чтобы выполнить инициализацию:

[13] System > 
	 Initial > Initial Settings

2	Для выполнения инициализации воспользуйтесь 
диском OSD/TIME, чтобы нажать “YES”.

	p Для отмены воспользуйтесь диском OSD/TIME, 
чтобы нажать “NO”.

Инициализация микшера

Инициализировать диапазон для выполнения перехода 
можно с помощью рычага микшера.
Инициализацию необходимо выполнить, пока переходы 
не закончены до конца, даже если переместить рычаг 
микшера до предела.

1	Нажмите диск OSD/TIME (Выполнить) в следующем 
меню, чтобы выполнить инициализацию:

[13] System > 
	 Initial > Initial Fader

2	Для выполнения инициализации воспользуйтесь 
диском OSD/TIME, чтобы нажать “YES”.

	p Для отмены воспользуйтесь диском OSD/TIME, 
чтобы нажать “NO”.

Системные параметры

Инициализация
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Функции связи с удаленными камерами
К этому устройству можно подключить по локальной сети не более 9 удаленных камер и управлять ими дистанционно.
Для получения информации о совместимости с подключаемыми удаленными камерами посетите страницу 
видеомикшера AV-HSW10 по следующему адресу:

https://pro-av.panasonic.net/en/

 Примеры соединений

Видеосигналы 
SDI/HDMI

Коммутирующий 
концентратор

Сетевые кабели

Компактный эфирный 
видеомикшер

AV-HSW10

Монитор 1

Монитор 2

Монитор Монитор

Сетевые кабели

Пульт дистанционного 
управления

Внешний 
источник питания 
постоянного тока

Внешний 
источник 
питания 
постоянного 
тока

Разъем LAN

Удаленная камера (не более 9)

	p Для соединения между устройством и удаленными камерами используйте коммутирующий концентратор с 
поддержкой GbE и сетевые кабели STP категории 5e или выше.

	p Кроме того, используйте сетевую структуру, в которой IP-адреса устройства и удаленных камер находятся в одной 
подсети.
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Функции связи с удаленными камерами
Функции управления для подключенных к этому устройству удаленных камер следующие:

	p Автоматическое определение IP-адреса
	p Возможно управлять индикаторами съемки подключенных удаленных камер, связанными с состоянием индикаторного 
сигнала этого устройства.

Настройки соединений с удаленными камерами

Выбор разъемов для подключения 
удаленных камер

Выберите сигнал входа, к которому подключена 
удаленная камера, в следующем меню:

[10] Input

	p Возможны указанные ниже настройки удаленных камер 
в соответствии со входом на разъемы от IN1 до 9.

Настройки IP-адресов

Автоматическая настройка

IP-адреса, заданные в подключенных удаленных камерах, 
можно сканировать и задать их в этом устройстве.

Сканируйте IP-адреса подключенных удаленных камер, 
осуществив следующее управление меню:

[10] Input >
	  INx > Camera Setting > Scan IP Address

	p Результаты сканирования отображаются в списке в 
пункте IP Address.

[10] Input > 
	 INx > Camera Setting > IP Address

	p Когда отобразится “Select From List”, с помощью 
диска OSD/TIME в пункте “IP-адрес” выберите 
IP-адрес подключенной удаленной камеры.
	p Если IP-адрес удаленной камеры обнаружить 
невозможно, отображается “Not Detected”.
	p Измените IP-адрес устройства или удаленной 
камеры и выполните настройку, чтобы не было 
совпадения.
	p Появляется сообщение об ошибке “Duplicate IP 
Address Detected. (ErrNo = – 650)”, если IP-адрес 
удаленной камеры совпадает с адресом другой 
камеры.

Ручная настройка

IP-адреса, заданные в подключенных удаленных камерах, 
можно напрямую задать в этом устройстве.

Введите IP-адреса подключенных удаленных камер, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Camera Setting > Edit IP Address

Настройки порта удаленной камеры

Задайте порты подключенных удаленных камер, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Camera Setting > Port

Настройки проверки подлинности для 
удаленной камеры
1	Задайте имя пользователя, используемое при проверке 

подлинности для подключенных удаленных камер, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Camera Setting > Edit User Name

2	Задайте пароль, используемый при проверке 
подлинности для подключенных удаленных камер, 
осуществив следующее управление меню:

[10] Input > 
	 INx > Camera Setting > Edit Password

<Символы, которые можно использовать в именах 
файлов>
От A до Z, от a до z, от 0 до 9, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /
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Проверка состояния подключения к 
удаленной камере
1	В следующем меню отображаются названия камеры, 

заданные в удаленных камерах.

[10] Input > 
	 INx > Camera Setting > Name

2	В следующем меню отображается состояние 
IP-соединений устройства и удаленных камер.

[10] Input > 
	 INx > Camera Setting > Network Status

No IP Address IP-адрес камеры не введен в меню Input.
Now 
Checking…

Устройство и удаленная камера 
обмениваются данными.

Connected Устройство и удаленная камера 
подключены.

Unauthorized Информация для проверки подлинности не 
введена или неверна.

Not Connected Произошла ошибка связи.

Настройки индикаторов съемки 
удаленных камер

Красный и зеленый сигналы индикатора съемки 
удаленных камер, подключенных к этому устройству, 
можно связать с красным и зеленым сигналами 
индикатора съемки этого устройства.

1	Установите связь между красным сигналом индикатора 
съемки на этом устройстве с красным сигналом 
индикатора съемки на удаленной камере, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Camera Setting > Red Tally

Enable Связь установлена.
Disable Связи нет.

2	Установите связь между зеленым сигналом индикатора 
съемки на этом устройстве с зеленым сигналом 
индикатора съемки на удаленной камере, осуществив 
следующее управление меню:

[10] Input > 
	 INx > Camera Setting > Green Tally

Enable Связь установлена.
Disable Связи нет.
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Установка GPI I/O
Пользователь может настроить функции, которые 
контролируются с внешних портов GPI для управления 
устройством.

1	Включите (On) или выключите (Off) контроль с портов, 
осуществив следующее управление меню:

[12] Config > 
	 GPI > GPI-In Setting > GPI-In Enable

[12] Config > 
	 GPI > GPI-Out Setting > GPI-Out Enable

2	Установите оповещение сигнала согласования через 
шину AUX, осуществив следующее управление меню:

[12] Config > 
	 GPI > GPI-In Setting > AUX Sel

[12] Config > 
	 GPI > GPI-Out Setting > AUX Tly Sel

3	Назначьте функции на каждый номер контакта, 
осуществив следующее управление меню:

[12] Config > 
	 GPI > GPI-In Port > Port1 Assign

[12] Config > 
	 GPI > GPI-In Port > Port2 Assign

[12] Config > 
	 GPI > GPI-In Port > Port3 Assign

[12] Config > 
	 GPI > GPI-In Port > Port4 Assign

[12] Config > 
	 GPI > GPI-In Port > Port5 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 1 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 2 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 3 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 4 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 5 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 6 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 7 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 8 Assign

 �Обратитесь к разделу “Управление с помощью 
входного порта GPI” и “Вывод через выходной порт 
GPI”.

	p Установки для пункта GPI-In Enable (или GPI-Out 
Enable) можно назначить одной из пользовательских 
кнопок.
 См. раздел “Настройка пользовательских кнопок”.
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	w Управление с помощью входного порта GPI

Назначаемая функция Описание назначенной функции Способ управления
KEY 1/2 ON Кнопка KEY1, KEY2 на блоке перехода

Управление осуществляется с 
помощью контактных входов (30 мс 
или более).

FTB ON Кнопка FTB на блоке перехода

BKGD AUTO Кнопка AUTO при выборе фона

BKGD CUT Кнопка CUT при выборе фона

KEY1 AUTO Кнопка AUTO при выборе вставки

KEY1 CUT Кнопка CUT при выборе вставки

REC Still1 Запись Still1

REC Still2 Запись Still2

От AUX XPT1 до 12 Кнопки коммутации (от 1 до 12), используемые для 
переключения шин AUX.
 �Выберите с помощью меню шины AUX (AUX1, AUX2), 

которыми необходимо управлять.

RTly DSBL Сигнал красной сигнальной информации не выводится Функции включаются с 
помощью контактных входов 
(или выключаются в открытом 
состоянии).

GTly DSBL Сигнал зеленой сигнальной информации не выводится

AUXTly DSBL Сигнал сигнальной информации AUX не выводится

No Assign Функция не назначена

	w Вывод через выходной порт GPI

Назначаемая функция Описание назначенной функции Output
CUT Выполнение перехода с вырезанием

Выводятся низкие импульсы  
(приблиз. от 50 до 60 мс).

KEY1 ON, KEY2 ON Начало перехода от вставки1 до 2

FTB ON Начало перехода FTB

BKGD CUT Выполнение перехода с вырезанием для фона

KEY1 CUT Выполнение перехода с вырезанием для вставки1

AUTO Текущее выполнение автоматического перехода

Выводится низкий уровень.BKGD AUTO Текущее выполнение автоматического перехода для фона

KEY1 AUTO Текущее выполнение автоматического перехода для вставки1

От RTly SDI IN1 до 4 Красная сигнальная информация для SDI от IN1 до IN4

Во время вывода сигнальной 
информации выводится низкий 
уровень.

RTly HDMI IN1, 2 Красная сигнальная информация для HDMI IN1, 2

От RTly IP IN1 до 4 Красная сигнальная информация для IP от IN1 до IN4

От GTly SDI IN1 до 4 Зеленая сигнальная информация для SDI от IN1 до IN4

GTly HDMI IN1, 2 Зеленая сигнальная информация для HDMI IN1, 2

От GTly IP IN1 до 4 Зеленая сигнальная информация для IP от IN1 до IN4

От AUXTly SDI IN1 до 4 При выборе SDI от IN1 до IN4 шиной AUX*
Выводится низкий уровень, когда 
выбраны входы.AUXTly HDMI IN1, 2 При выборе HDMI IN1, 2 шиной AUX*

От AUXTly IP IN1 до 4 При выборе IP от IN1 до IN4 шиной AUX*
No Assign Функция не назначена

*: Выберите с помощью меню шины AUX (AUX1, AUX2), сигналы которых необходимо выводить.
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Com

GPI Out
ALARM Out

Пример соединений GPI Out и ALARM
Убедитесь в том, что выполняются приведенные ниже 
условия.

Диэлектрическая прочность:	 Макс. 24 В 
постоянного напряжения Ток:	 Макс. 50 мА

AV-HSW10 (Макс. Напряжение: 24 В)

Светодиод индикации(Макс. ток: 50 мА)
Com

GPI In

+3.3 V

Пример соединений GPI In
Обеспечьте входные контакты.

AV-HSW10

TALLY/GPI

12345

12 11 10

678

15 14 13 9

Штырь № Название сигнала
1 GPI-Out1

9 GPI-Out8

2 GPI-Out2

10 GPI-In1

3 GPI-Out3

11 GPI-In2

4 GPI-Out4

12 GPI-In3

5 GPI-Out5

13 GPI-In4

6 ALARM Out

14 GPI-In5

7 GPI-Out6

15 GPI-Com

8 GPI-Out7

LAN

Соедините устройство и компьютер или устройство и внешнее устройство*.
*:	� С устройства можно управлять внешним устройством.

	p Используйте сетевой кабель прямого подключения или перекрестный кабель категории 5e или выше, экранированную 
витую пару, максимум 100 м.



106

Внешние интерфейсы

Управление с помощью внешних панелей

Это устройство позволяет выполнять следующие операции с внешних панелей (*), подключенных по IP-сети:
	p Выбор материалов для каждой шины
	p Выполнение видеопереходов
	p Воспроизведение данных из памяти кадров
	p Выбор точек коммутации для каждой шины

*: �Это устройство поддерживает панели серии LBP компании LAWO. За информацией о настройках и операциях 
панелей серии LBP обращайтесь в компанию LAWO.

Подготовка

С помощью сетевого кабеля подключите внешнюю панель 
к разъему LAN на задней стороне устройства.
Подключить можно не более 20 внешних панелей. 
Подключение нескольких внешних панелей выполняйте 
через концентратор.

Включение/выключение внешних панелей и 
данного устройства
При включении/выключении или перезапуске 
устройств обратите внимание на следующие моменты.

	p Если внешнюю панель невозможно подключить, 
даже когда прошло 3 минуты или более после 
перезапуска данного устройства, перезапустите 
внешнюю панель.

	p Если необходимо выключить внешнюю панель во 
время работы устройства, сначала переключите 
следующий пункт на «Выключено», после чего 
выключите внешнюю панель.

[17] External Interfaces >
	 External Panel Information > Active

Примечания

Настройки внешних панелей

Проверьте следующие настройки на этом устройстве, а 
затем выполните настройки на подключенных внешних 
панелях:

	p Значение адреса, задаваемое в следующем пункте, 
необходимо установить в соответствии с IP-адресом 
устройства, которое будет управляться внешней 
панелью:

[16] Network >
	 LAN > IP Address

	p Номер порта, задаваемый в следующем пункте, 
необходимо установить в соответствии с номером 
порта устройства, которое будет управляться внешней 
панелью:

[17] External Interfaces >
	 External Panel Information > Port No

Также задайте маску подсети и основной шлюз в 
следующих меню в соответствии с подключенной сетевой 
средой.

[16] Network >
	 LAN > Subnet Mask

[16] Network >
	 LAN > Default Gateway

Настройки на этом устройстве при 
подключении внешних панелей

Настройки номера порта получения

1	Включите/выключите для функций внешней панели, 
осуществив следующее управление меню:

[17] External Interfaces >
	 External Panel Information > Active

2	Установите номер порта получения, используемого 
этим устройством, осуществив следующее управление 
меню:

[17] External Interfaces >
	 External Panel Information > Port No

Возможный диапазон 
настройки

От 62000 до 65535

Значение по умолчанию 62010
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Настройки воспроизведения данных из памяти 
кадров

Задайте целевые параметры для воспроизведения 
данных из памяти кадров этого устройства с помощью 
операций на внешних панелях.

Задайте целевые параметры для воспроизведения 
данных из памяти кадров, осуществив следующее 
управление меню:

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

BKGD

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

Key1

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

Key2

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

AUX1

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

AUX2

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

CBGD

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

XPT

	p Для BKGD, Key, AUX, цветного фона и области точек 
коммутации можно отдельно задать значения On/Off.

Внешние интерфейсы
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Список идентификаторов шин и источников

При выполнении операций на внешних панелях подаются команды настройки точек коммутации, в которых указываются 
материалы (источник) для шин (место назначения).
Когда это устройство получает команду настройки точек коммутации от внешней панели, выбор материалов и 
видеопереходы выполняются в соответствии с комбинациями шины и материала, указанными в команде.
В этом разделе описываются идентификаторы (номера), используемые этим устройством для идентификации каждой 
шины и каждого материала.

Идентификаторы в общем можно отнести к 2 следующим типам:

1)	Обычные идентификаторы шин и материалов
Идентификаторы, указывающие шины внутри видеомикшера (PGM, AUX1 и т. п.) и материалы видеомикшера (IN1, 
CBGD1, STILL1-V и т. п.).
Используйте число в диапазоне от 1 до 512.

2)	Расширенные идентификаторы шин и материалов
Идентификаторы, используемые для воспроизведения видеопереходов, данных макропамяти и памяти кадров.
Когда это устройство получает команду настройки точек коммутации, в которой указывается одинаковый 
расширенный идентификатор для шины и материала, выполняется соответствующая функция.
Например, при получении команды, указывающей материал BKGD AUTO (ID: 522) для шины BKGD AUTO (ID: 522), 
выполняется переход AUTO.
Используйте число в диапазоне от 513 до 1024.

Выполняемые операции Указанная шина и материал
Переход с рирпроекцией ME KEY1 AUTO, KEY2 AUTO

Переход с рирпроекцией ME (CUT) KEY1 CUT, KEY2 CUT

Переход ME AUTO BKGD AUTO

Переход ME CUT BKGD CUT

Воспроизведение данных, сохраненных в памяти кадров От SHOTPLAY1 до SHOTPLAY12

Выбор точек коммутации для каждой шины От XPT1 до XPT12

	p За подробной информацией о том, как назначить идентификаторы операциям для каждой из кнопок на панелях серии 
LBP, обращайтесь в компанию LAWO.

Настройки для внешней панели (серии LBP компании LAWO), используемой в качестве внешнего интерфейса 
(ExtPanel)
При подключении нескольких (2 или более) внешних панелей обратите внимание на следующие моменты.

	p При создании данных конфигурации для нескольких внешних панелей создайте данные в одном и том же файле 
.snap.

	p Для каждой используемой внешней панели используйте одинаковые настройки параметров, лишь с разными 
названиями маршрутизатора.

Если не принять указанные выше меры и выполнить настройки расширенных идентификаторов шин/расширенных 
идентификаторов источников от 810 до 821 (от XPT1 до XPT12) для идентификаторов управления на нескольких 
внешних панелях, внешние панели могут работать неправильно.

Примечания
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Идентификатор шины

ID Шина ID Шина ID Шина ID Шина ID Шина
1 PGM 112 – 152 – 160 MV-8 168 MV-16
2 PVW 113 AUX1 153 MV-1 161 MV-9 169 –
3 KEY1-F 114 AUX2 154 MV-2 162 MV-10 …

4 KEY1-S 115 – 155 MV-3 163 MV-11 512 –

5 KEY2-F … 156 MV-4 164 MV-12
6 KEY2-S 149 – 157 MV-5 165 MV-13
7 – 150 VMEM-V 158 MV-6 166 MV-14

… 151 VMEM-K 159 MV-7 167 MV-15
–: Неиспользуемый идентификатор

Идентификатор источника
ID Источник ID Источник ID Источник ID Источник ID Источник
1 IN1 … … 201 PGM 232 IP OUT2
2 IN2 144 – 164 – 202 – 233 –
3 IN3 145 CBGD1 165 MV 203 PVW …

4 IN4 146 CBGD2 166 – 204 – 250 –

5 IN5 147 CBAR … … 251 CLOCK
6 IN6 148 Black 170 – 226 – 252 –
7 IN7 149 STILL1V 171 Key Out 227 AUX1 …

8 IN8 150 STILL1K 172 CLN 228 AUX2 512 –
9 IN9 151 STILL2V 173 – 229 –
10 Analog IN 152 STILL2K … 230 –
11 – 153 – 200 – 231 IP OUT1

–: Неиспользуемый идентификатор

Расширенный идентификатор шины
ID Шина ID Шина ID Шина ID Шина ID Шина

513 – 522 BKGD AUTO 714 SHOTPLAY5 … 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 – 818 XPT9

515 KEY2 AUTO 524 – 716 SHOTPLAY7 810 XPT1 819 XPT10
516 – … 717 SHOTPLAY8 811 XPT2 820 XPT11

517 – 709 – 718 SHOTPLAY9 812 XPT3 821 XPT12

518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 –
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 …

520 – 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 –
521 – 713 SHOTPLAY4 722 – 816 XPT7

–: Отправлен отключенный идентификатор (-1)

Расширенный идентификатор источника	
ID Источник ID Источник ID Источник ID Источник ID Источник

513 – 522 BKGD AUTO 714 SHOTPLAY5 … 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 – 818 XPT9
515 KEY2 AUTO 524 – 716 SHOTPLAY7 810 XPT1 819 XPT10
516 – … 717 SHOTPLAY8 811 XPT2 820 XPT11
517 – 709 – 718 SHOTPLAY9 812 XPT3 821 XPT12

518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 –
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 …

520 – 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 –
521 – 713 SHOTPLAY4 722 – 816 XPT7

–: Неиспользуемый идентификатор
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Внешние интерфейсы

Внешнее управление

<Общие сведения>
На устройстве можно переключать материалы для всех 
шин, а также передавать и получать информацию о 
названии материалов для всех шин этого устройства 
при подключении к сети внешних устройств, например 
контроллеров системы и сигнальных интерфейсов.
Также можно изменять настройки Key Signal Coupling с 
внешних устройств.
Можно передавать и получать сигнальную информацию 
и сведения об идентификаторах источников с 
использованием формата передачи, совместимого с 
протоколом TSL UMD V5.0,
При подключении по IP к пульту дистанционного 
управления камерой серии AW-RP производства 
Panasonic можно переключать материал, передавать 
сигнальную информацию, выполнять операцию помощи 
при фокусировке и получать названия материалов для 
шин устройства с помощью переключателя камер серии 
AW-RP.

	p Информацию о настройках шин управления и т. д. см. в 
инструкции по эксплуатации серии AW-RP.

<Подготовка>
С помощью сетевого кабеля подключите внешнее 
устройство к разъему LAN на задней стороне данного 
устройства.
Это устройство поддерживает 20 IP-соединений. 
Подключение нескольких внешних устройств выполняйте 
через концентратор. Задайте IP-адрес, не совпадающий с 
другими.
Проверьте сетевые настройки данного устройства в 
следующих меню:

[16] Network >
	 LAN > IP Address

[16] Network >
	 LAN >  Subnet Mask

Начальные установки следующие: IP-адрес: 
“192.168.0.50”, маска подсети: “255.255.255.0”.

<Установки>
1	Включите/выключите для функций внешнего 

управления, осуществив следующее управление меню:

[17] External Interfaces >
	 External Control Switcher > Active

2	Задайте сеть, осуществив следующее управление 
меню:

[17] External Interfaces >
	 External Control Switcher > Port No

3	Установите интервал передачи команд, осуществив 
следующее управление меню:

[17] External Interfaces >
	 External Control Switcher > Interval Time

4	Задайте параметры отправки уведомлений об 
изменении для источника передачи, осуществив 
следующее управление меню:

[17] External Interfaces >
	 External Control Switcher > Response

On Отправлять уведомление об изменении 
источнику передачи.

Off Не отправлять уведомление об изменении 
источнику передачи.

5	Установите IP-адрес подключенного внешнего 
устройства, осуществив следующее управление меню:

[17] External Interfaces >
	 External Control AUX Panel > IP AddressXX

6	Установите номер порта получения подключенного 
внешнего устройства, осуществив следующее 
управление меню:

[17] External Interfaces >
	 External Control AUX Panel > Port No

	p Задайте 60031 при подключении к пульту 
дистанционного управления камерой серии AW-RP.

7	Информация о параметре DMSG-CONTROL команд 
протокола TSL UMD V5.0

Настройки красного индикаторного сигнала 
выводятся при выводе сигнала RH.
Настройки зеленого индикаторного сигнала 
выводятся при выводе сигнала TXT.

8	При изменении названий материалов необходимо 
переключить следующий пункт на “User”:

[10] Input >
	 INx > Name Type

<Технические характеристики команд>
См. технические характеристики протокола связи для 
внешнего интерфейса AV-HSW10.
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Внешние интерфейсы

Настройки подключения панели 
программного обеспечения

Этим устройством и его настройками можно управлять 
дистанционно с помощью локального соединения 
для подключения ПК, на котором установленапанель 
программного обеспечения AV-SF10.
Выполните настройки информации о сертификации на 
данном устройстве, чтобы сертифицировать панель 
программного обеспечения.

	p При установке панели программного обеспечения на 
локальный ПК см. процедуры установки для AV-SF10.

	p Информацию об операциях на панели программного 
обеспечения см. в инструкции по эксплуатации AV-SF10.

1	Выполните следующие пункты меню, чтобы задать 
имя пользователя, используемое при проверке 
подлинности для панели программного обеспечения:

[13] System >
	 User Auth > User Name

	p Для имени пользователя допускается установка в 
диапазоне от 1 до 32 символов.

<Символы, доступные для имени пользователя>
От A до Z, от a до z, от 0 до 9, пробел, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > /

2	Выполните следующие пункты меню, чтобы задать 
пароль, используемый при проверке подлинности для 
панели программного обеспечения:

	p Пароль для проверки подлинности нужно ввести 
2 раза.

[13] System >
	 User Auth > Password

	p Для пароля допускается установка в диапазоне от 1 
до 32 символов.

<Символы, доступные для пароля>

От A до Z, от a до z, от 0 до 9
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<Общие сведения>
К данному устройству можно подключить несколько камер, а также переключаться между ними для их использования, 
но так как каждая камера обладает различными свойствами цветопередачи, при переключении возможен странный 
эффект. В связи с этим необходимо провести процесс калибровки, чтобы после индивидуальной настройки каждой 
камеры свойства цветопередачи дополнительных камер совпадали с основной камерой. Эта функция предназначена в 
качестве способа осуществить регулировку на данном устройстве, чтобы упростить калибровку свойств цветопередачи.

<Установки>
1	Используйте функции камер для осуществления 

регулировок на каждой отдельной камере. Это не 
относится к функциям данного устройства. Подробную 
информацию см. в инструкции по эксплуатации и т.д. 
используемого устройства.

2	Определите основную камеру, откалибруйте 24 точки 
цветовой мишени Macbeth в соответствии с метками 
или откалибруйте метки, после чего сделайте запись.

	p С этой функцией предполагается использование 
цифровой мишени Macbeth, но возможно 
использование и других цветовых мишеней.

3	Последовательно откалибруйте остальные камеры с 24 
точками цветовой мишени Macbeth таким же образом, 
как на основной камере, после чего используйте для 
калибровки запись основной камеры.

	p Параметры определяются посредством сравнения 
полученных 24 точек друг с другом, но для процесса 
калибровки характерно отсутствие абсолютно 
точного совпадения. Калибровка осуществляется для 
того, чтобы после нее снизить величину отклонений 
до минимально возможной.
	p Если настройки камеры будут изменены в связи с 
изменением условий и т.д., потребуется повторно 
воспользоваться данной функцией. В связи с 
этим мы рекомендуем ОТКЛЮЧИТЬ функции 
автоматической регулировки на камерах.

Автоматическая регулировка цветового тона
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Запись основной камеры

1	Определите нужный вход, осуществив следующее 
управление меню:

[19] Color Adjust > 
	 Target

2	Отобразите метки на нужном входе, осуществив 
следующее управление меню:

[19] Color Adjust > 
	 Marker

3	Установите положение меток, осуществив следующее 
управление меню:

[19] Color Adjust > 
	 Left

[19] Color Adjust > 
	 Top

[19] Color Adjust > 
	 Bottom

[19] Color Adjust > 
	 Right

[19] Color Adjust > 
	 Set capture points

Left Укажите левый край области, в которой 
необходимо сгенерировать точку.

Top Укажите верхний край области, в которой 
необходимо сгенерировать точку.

Bottom Укажите нижний край области, в которой 
необходимо сгенерировать точку.

Right Укажите правый край области, в которой 
необходимо сгенерировать точку.

Set capture 
points

В указанной области по генерируются 
24 точки, 6 из которых расположены 
вертикально, и 4 – горизонтально.

 

Left, Top 

Bottom, Right 

4	Отрегулируйте положение меток, осуществив 
следующее управление меню:

[19] Color Adjust > 
	 Points > Point x

5	Выберите место для записи цвета на позиции метки, 
осуществив следующее управление меню:

[19] Color Adjust > 
	 Parameter No

6	Нажмите диск OSD/TIME (Выполнить) в следующем 
меню, чтобы выполнить запись выбранного места:

[19] Color Adjust > 
	 Capture for Master

	p Если запись уже имеется, она будет перезаписана.
7	Задайте имя в записи, осуществив следующее 

управление меню:

[19] Color Adjust > 
	 Parameters > Parameter x > Name

	p Можно ввести строку длиной не более 16 символов.

Калибровка других камер
1	Определите нужный вход, осуществив следующее 

управление меню:

[19] Color Adjust > 
	 Adjust Target

2	Откалибруйте метки.
 См. пп.  по  в “Запись основной камеры”.

3	Выберите запись основной камеры, которая будет 
использоваться в качестве эталона для калибровки, 
осуществив следующее управление меню:

[19] Color Adjust > 
	 Parameter No

4	Нажмите диск OSD/TIME (Выполнить) в следующем 
меню, чтобы выполнить регулировку цвета:

[19] Color Adjust > 
	 Adjust Target

	p [19] Цветокорректор > Enable Color Adjust при этом 
автоматически переключается на “Enable”. Чтобы 
отключить калибровку, переключите на “Disable”.

Автоматическая регулировка цветового тона
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Внешний вид
Единица измерения: мм

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

POWER

AMB:F
GRN:S

PGM

PST

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4

1 7 2 8 3 9 4 10 5 11 6 12

USER 2 5 USER 3 SHOT MEM EXIT

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

MENU6

PGM PVW

SHIFT

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

U
S
B

LEVEL

175

254

67



115

Технические характеристики

Источник питания: Специальный адаптер переменного тока на постоянный ток ( ) 16 В
Потребляемый ток: 3,0 A (48 Вт)

 Данный знак обозначает информацию, относящуюся к технике безопасности.

Общие
Рабочая окружающая 
температура

От 0 °C до 40 °C

Рабочая окружающая 
влажность

От 10 % до 90 % (конденсация недопустима)

Температура хранения От 0 °C до 40 °C
Влажности при хранении От 10 % до 90 % (конденсация недопустима)
Вес Приблиз. 1,8 кг
Размеры
(Д × В × Ш)

254 мм × 67 мм × 175 мм (без выступающих деталей)

Разъемы видео
Разъемы <SDI IN 1> – 
<SDI IN 4>

4 линии
	p Разъемы: BNC × 4
	p Оснащены кадровым синхронизатором входного сигнала.
	p Разъемы <SDI IN 1> и <SDI IN 2> обладают упрощенными преобразователями формата, 
<SDI IN 3> и <SDI IN 4> обладают высокопроизводительными преобразователями 
формата.

	p Разъемы от <SDI IN 1> до <SDI IN 4> оснащены упрощенными цветокорректорами.
*  SDI IN 1 исключает HDMI IN 1.
3G-SDI 3G-SDI, соответствует стандарту SMPTE424M (совместим с Уровнем-A/

Уровнем-B)
	p 0,8 В [p-p] ± 10 % (75 Ω)
	p Автоматический уравнитель 100 м (при использовании кабеля)

HD-SDI HD-SDI, соответствует стандарту SMPTE292M
	p 0,8 В [p-p] ± 10 % (75 Ω)
	p Автоматический уравнитель 100 м (при использовании кабеля)

Разъемы <HDMI IN 1>, 
<HDMI IN 2>

2 линии, совместимы с HDMI1.4b
Входы для видеоформата:
720p/59,94 Гц, 720p/50 Гц, 1080i/59,94 Гц, 1080i/50 Гц, 1080p/59,94 Гц, 1080p/50 Гц, 
1080p/29,97 Гц, 1080p/25 Гц, 1080p/24 Гц, 1080p/23,98 Гц
Входы для формата ПК:
WSXGA+ (1680 × 1050, 60 Гц), SXGA (1280 × 1024, 60 Гц), WXGA (1280 × 768, 60 Гц), 
XGA (1024 × 768, 60 Гц)
Режим: Полный/вместить по горизонтали/вместить по вертикали 

	p Разъемы: HDMI × 2
	p Оснащены кадровым синхронизатором входного сигнала и упрощенным 
цветокорректорром.

	p Разъем HDMI IN обладает функцией масштабирования.
	p Данный разъем не поддерживает технологии HDCP.

*  HDMI IN 1 исключает SDI IN 1.
Разъемы <SDI OUT 1>, 
<SDI OUT  2>

2 линии
	p Разъемы: BNC × 2
	p Можно назначить PGM, PVW, CLN, MV, AUX1/2 и выключение.

3G-SDI 3G-SDI, соответствует стандарту SMPTE424M (совместим с Уровнем-A)
	p 0,8 В [p-p] ± 10 % (75 Ω)

HD-SDI HD-SDI, соответствует стандарту SMPTE292M
	p 0,8 В [p-p] ± 10 % (75 Ω)

Разъем <HDMI OUT> 1 линия, совместима с HDMI1.4b
	p Разъем: HDMI × 1
	p Оснащен функцией масштабирования.

Режим: Fit-V, Fit-H, Full, Full-90%, Full-80%
	p Можно назначить PGM, PVW, CLN, MV, AUX1/2 и выключение.
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Разъем <LAN> Совместим с 1000Base-T и AUTO-MDIX (для передачи/управления IP-сигналом)
	p Соединительный кабель: сетевой кабель (категории 5e или выше), макс. 100 м, 
рекомендуется использовать экранированную витую пару

	p Разъем: RJ-45
 Входной сигнал IP
Назначен от IN 6 по IN 9.

	p IN 6, IN 7: Выбор между SRT/NDI|HX (версия1/версия2).
	p IN 8, IN 9: Назначены на ввод NDI с высокой пропускной способностью.  
Поддерживает ввод альфа-канала NDI. В данном случае используется парно с IN 9.

 Выходной сигнал IP
Назначен на OUT 4 и OUT 5.

	p OUT 4, OUT 5: Выбор между SRT/NDI с высокой пропускной способностью/RTMP.
	p Можно назначить PGM, PVW, CLN, MV, AUX1/2, выключение.
	p Оснащен функциями масштабирования и преобразования i/p.*
	p Возможные выходные форматы: 
1920 × 1080/60кадр/с, 50кадр/с, 30кадр/с, 25кадр/с, 24кадр/с 
1280 × 720/60кадр/с, 50кадр/с

*  Планируется поддержка при обновлении встроенного ПО
Разъем <USB> Разъем для вывода UVC/UAC

Назначен на OUT 6.
	p Разъем: USB3.2 Gen1 TypeC, отсутствует возможность питания по шине USB
	p Можно назначить PGM, PVW, CLN, MV, AUX1/2 и выключение.
	p Оснащен функциями масштабирования и преобразования i/p.*
	p Возможные выходные форматы: 
1920 × 1080/60кадр/с, 50кадр/с, 30кадр/с, 25кадр/с, 24кадр/с 
1280 × 720/60кадр/с, 50кадр/с, 30кадр/с, 25кадр/с, 24кадр/с

*  Планируется поддержка при обновлении встроенного ПО
Формат системы 1080/59,94p, 50p, 29,97p, 25p, 24p, 23,98p, 59,94i, 50i

720/59,94p, 50p
Обработка сигнала R:G:B 4:4:4 8-бит / 4:2:2 10-бит (с HDMI)

Y:Cb:Cr 4:2:2 8-бит (с High Bandwidth NDI/UVC)
Y:Cb:Cr 4:2:0 8-бит (с NDI|HX/SRT/RTMP)
Y:Cb:Cr 4:2:2 10-битный

Номер ME 1ME

Разъемы аудио
Разъем <AUDIO IN> 	p L/1 и R/2

	p Разъем: Контакты гнезд
	p Оснащен внедренным функционалом для каждого выхода.
	p Оснащен функцией регулировки задержки/уровня.

Разъем <AUDIO OUT> Разъем для мониторинга в наушниках
	p Разъем: Φ3,5 мм TRS
	p Оснащен функцией регулировки выходной громкости.

Разъемы синхронизации
Разъемы <REF> 
Вход опорного сигнала

В режиме синхронизатора видеосигналов: Выбор между BB (черным полем), трехуровневой 
синхронизацией и внутренней синхронизацией

	p Вывод по сквозному каналу выполняется в режимах BB и трехуровневой синхронизации.
	p Если вывод по сквозному каналу использоваться не будет, обеспечьте оконечную нагрузку 75 Ом.
	p Разъемы: BNC×2
	p Поддерживаются такие же частоты полей, как и у формата системы.
	p Для 23,98 Гц и 24 Гц поддерживается только трехуровневый ввод или внутренняя 
синхронизация.

Время задержки 
видеосигнала

1 линия (H) Когда для настройки кадрового синхронизатора задано значение [Off] и ни 
повышающий, ни понижающий преобразователь не работает

1 кадр (F) Когда настройка кадрового синхронизатора включена, а повышающий и 
понижающий преобразователи работают

	p Если сигналы прошли через PinP, многоканальный просмотр, преобразователь с 
понижением частоты или HDMI IN/OUT, в каждом случае применяется максимальная 
задержка в 1 кадр.

Технические характеристики
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Технические характеристики
Разъемы управления
Разъем <LAN>, Совместим с 1000Base-T и AUTO-MDIX (для IP-управления)

	p Соединительный кабель: сетевой кабель (категории 5e), макс. 100 м, рекомендуется 
использовать экранированную витую пару

	p Разъем: RJ-45
Разъемы <TALLY GPI> INPUT: 5 входов, общего назначения, чувствительны к оптопаре

OUTPUT: 8 выходов, выбираются из сигналов согласования R/G, общего назначения 
ALARM: 1 выход, выход с открытым коллектором (отрицательная логика)

	p Разъемы: 15-контактный D-Sub
Разъем <USB> 	p Разъем: USB2.0, Type-A, с возможностью питания по шине USB

Используйте память USB для сохранения и загрузки файлов конфигурации и данных 
снимков, а также для обновлений прошивки.

Адаптер переменного тока

Номинальный входной ток: �100 В – 240 В переменного тока ( ) 50 Гц/60 Гц 
1,6 А – 0,9 А 

Номинальный выходной ток: 16 В постоянного тока ( ), 4,06 А

 Данный знак обозначает информацию, относящуюся к технике безопасности.
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Таблица меню настроек
№ Подменю Установочный пункт Установка

1 WIPE 1 BKGD 
Pattern

Диапазон настройки Выбрать каждый узор (страница 31)

Значение по умолчанию 5

2 BKGD 
Transition

Direction Диапазон настройки Normal, Reverse, N/R

Значение по умолчанию Normal

Border Диапазон настройки
Border

On, Off
Width

От 0.1 до 100.0

Значение по умолчанию Off 5.0

Диапазон настройки
Soft

От 0.0 до 100.0

Значение по умолчанию 0.0

Border Color
Диапазон настройки

Load

White, Yellow, Cyan, 
Green, Magenta, 
Red, Blue, Black Hue

От 0.0 до 359.9

Значение по умолчанию White 0.0

Диапазон настройки
Sat

От 0.0 до 100.0
Lum

От 0.0 до 108.0

Значение по умолчанию 0.0 100.0

Position Диапазон настройки X- 
Position

От –100.00 до 100.00 Y- 
Position

От –100.00 до 100.00

Значение по умолчанию 0.00 0.00

3 Key1 Pattern Диапазон настройки Выбрать каждый узор (страница 36)

Значение по умолчанию 5

4 Key1 
Transition

Type Диапазон настройки MIX, WIPE

Значение по умолчанию MIX

Keyout 
Pattern

Диапазон настройки Normal, Reverse

Значение по умолчанию Normal

Position Диапазон настройки X- 
Position

От –100.00 до 100.00 Y- 
Position

От –100.00 до 100.00

Значение по умолчанию 0.00 0.00

2 CBGD 1 CBGD Select Диапазон настройки CBGD1, CBGD2

Значение по умолчанию CBGD1

2 CBGD Main Load Диапазон настройки White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Значение по умолчанию Blue, Red

Hue Диапазон настройки От 0.0 до 359.9

Значение по умолчанию 120.0, 0.0

Sat Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 100.0

Lum Диапазон настройки От 0.0 до 108.0

Значение по умолчанию 100.0

3 CBGD Sub Load Диапазон настройки White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Значение по умолчанию White

Hue Диапазон настройки От 0.0 до 359.9

Значение по умолчанию 0.0

Sat Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 0.0

Lum Диапазон настройки От 0.0 до 108.0

Значение по умолчанию 100.0

4 CBGD Wash Wash Диапазон настройки On, Off

Значение по умолчанию Off

Color Диапазон настройки Dual, Rainbow

Значение по умолчанию Dual

Rainbow Sat Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 100.0

Rainbow Lum Диапазон настройки От 0.0 до 108.0

Значение по умолчанию 100.0
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Таблица меню настроек
№ Подменю Установочный пункт Установка

2 CBGD 5 CBGD Wave Pattern Диапазон настройки Sine, Saw

Значение по умолчанию Sine

Cycle Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 0.0

Phase Диапазон настройки От –180.0 до 180.0

Значение по умолчанию 0.0

Angle Диапазон настройки От 0.0 до 360.0

Значение по умолчанию 0.0

6 CBGD Move Move Диапазон настройки Off, Roll, Rotation

Значение по умолчанию Off

Speed Диапазон настройки От –50.0 до 50.0

Значение по умолчанию 1.0

3 Key 1 Key Select Диапазон настройки Key1, Key2

Значение по умолчанию Key1

2 Key Type Диапазон настройки Lum (ChromaOff), Lum (ChromaOn), Linear, Chroma, Full

Значение по умолчанию Linear

3 Fill Диапазон настройки Bus, Matte

Значение по умолчанию Bus

4 PVW Диапазон настройки Off, On

Значение по умолчанию Off

5 Key Adjust Clip Диапазон настройки От 0.0 до 108.0

Значение по умолчанию 0.0

Gain Диапазон настройки От 0.0 до 200.0

Значение по умолчанию 100.0

Density Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 100.0

Invert Диапазон настройки On, Off

Значение по умолчанию Off

6 Fill Matte Load Диапазон настройки White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Значение по умолчанию White

Hue Диапазон настройки От 0.0 до 359.9

Значение по умолчанию 0.0

Sat Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 0.0

Lum Диапазон настройки От 0.0 до 108.0

Значение по умолчанию 100.0

7 Edge Type Диапазон настройки Off, Border, Drop, Shadow, Outline

Значение по умолчанию Off

Width Диапазон настройки От 0 до 4

Значение по умолчанию 2

Direction Диапазон настройки 0, 45, 90, 135, 180, 225, 270, 315

Значение по умолчанию 0

Density Диапазон настройки 25%, 50%, 75%, 100%

Значение по умолчанию 100%

Fill Диапазон настройки Color, CBGD1, CBGD2, Still1, Still2

Значение по умолчанию Color
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Таблица меню настроек
№ Подменю Установочный пункт Установка

3 Key 7 Edge Color
Диапазон настройки

Load

White, Yellow, Cyan, 
Green, Magenta, 
Red, Blue, Black Hue

От 0.0 до 359.9

Значение по умолчанию Black 0.0

Диапазон настройки
Sat

От 0.0 до 100.0
Lum

От 0.0 до 108.0

Значение по умолчанию 0.0 0.0

8 Mask Size Диапазон настройки Off, Manual, 4:3

Значение по умолчанию Off

Invert Диапазон настройки On, Off

Значение по умолчанию Off

Position Диапазон настройки
Left

От –50.00 до 50.00
Top

От –50.00 до 50.00

Значение по умолчанию –25.00 25.00

Диапазон настройки
Bottom

От –50.00 до 50.00
Right

От –50.00 до 50.00

Значение по умолчанию –25.00 25.00

9 PinP PinP Диапазон настройки On, Off

Значение по умолчанию Off

Shape Диапазон настройки Square, Circle, Heart, Flower, Star

Значение по умолчанию Square

Density Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 100.0

Full Key Диапазон настройки On, Off

Значение по умолчанию On

Border Диапазон настройки
Border

Off, On
Width

От 0.1 до 100.0

Значение по умолчанию Off 5.0

Диапазон настройки
Soft

От 0.0 до 100.0
Mode

Fix, Variable

Значение по умолчанию 0.0 Fix

Диапазон настройки

Color

Load
White, Yellow, Cyan, Green, Magenta, 
Red, Blue, Black

Значение по умолчанию Black

Диапазон настройки
Hue

От 0.0 до 359.9

Значение по умолчанию 0.0

Диапазон настройки
Sat

От 0.0 до 100.0

Значение по умолчанию 0.0

Диапазон настройки
Lum

от 0.0 до 108.0

Значение по умолчанию 0.0

Position
Диапазон настройки X- 

Position

От –100.00 до 
100.00 Y- 

Position

От –100.00 до 
100.00

Значение по умолчанию 0.00 0.00

Диапазон настройки
Size

От 0.00 до 100.00

Значение по умолчанию 25.00
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Таблица меню настроек
№ Подменю Установочный пункт Установка

3 Key 9 PinP Trim Диапазон настройки
Trim

Off, On
Pair

Off, On

Значение по умолчанию Off Off

Диапазон настройки
Preset

16:9, 12:9, 9:9, 7:9, 6:9, Manual

Значение по умолчанию 16:9

Диапазон настройки

Adjust

Left
От –50.00 до 50.00

Значение по умолчанию –50.00

Диапазон настройки
Top

От –50.00 до 50.00

Значение по умолчанию 50.00

Диапазон настройки
Bottom

От –50.00 до 50.00

Значение по умолчанию –50.00

Диапазон настройки
Right

От –50.00 до 50.00

Значение по умолчанию 50.00

Sync
Диапазон настройки

Symmetry
Off, X, Y, Center, 
Same Copy to 

KEY

Execute

Значение по умолчанию Off

10 Key Signal 
Coupling

Диапазон настройки Coupling, Independent

Значение по умолчанию Coupling

11 Key Priority Key Диапазон настройки 1st, 2nd

Значение по умолчанию 2nd

4 ChromaKey 1 Marker Диапазон настройки On, Off

Значение по умолчанию Off

2 Sample Диапазон настройки Execute

Значение по умолчанию Execute

3 Marker 
Position

X-Position Диапазон настройки От –50.00 до 50.00

Значение по умолчанию 0.00

Y-Position Диапазон настройки От –50.00 до 50.00

Значение по умолчанию 0.00

Size Диапазон настройки От 1.00 до 80.00

Значение по умолчанию 10.00

4 Marker 
Aspect

Диапазон настройки От –50.00 до 50.00

Значение по умолчанию 0.00

5 Ref Adjust Hue Диапазон настройки От 0.0 до 359.9

Значение по умолчанию 354.0

Sat Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 100.0

Lum Диапазон настройки От 0.0 до 108.0

Значение по умолчанию 7.00

6 Y-Influence Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 0.0

7 Radius Hue Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 100.0

Sat Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 50.0

8 Soft Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 0.0

9 Cancel Диапазон настройки От 0.0 до 100.0

Значение по умолчанию 0.0
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Таблица меню настроек
№ Подменю Установочный пункт Установка

5 Time 1 BKGD Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

2 Key1 Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

3 Key2 Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

4 FTB Trans Time Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

Source Диапазон настройки Still1, Still2, CBGD1, CBGD2, White, Black

Значение по умолчанию Black

Mute Диапазон настройки Off, On

Значение по умолчанию Off

5 Effect 
Dissolve

Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

6 AUX1 Bus 
Trans

Transition Диапазон настройки Off, On

Значение по умолчанию Off

Trans Time Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

7 AUX2 Bus 
Trans

Transition Диапазон настройки Off, On

Значение по умолчанию Off

Trans Time Диапазон настройки От 0 до 999 (Frame)

Значение по умолчанию 1s00f

6 Still 1 Still Select Диапазон настройки Still1, Still2

Значение по умолчанию Still1

2 Key Status Диапазон настройки On, Off

Значение по умолчанию –

3 Capture Диапазон настройки Execute

Значение по умолчанию

4 Capture 
Setting

Video Диапазон настройки AUX1, AUX2

Значение по умолчанию AUX1

Key Enable Диапазон настройки On, Off

Значение по умолчанию On

Key Диапазон настройки AUX1, AUX2

Значение по умолчанию AUX1

Review Диапазон настройки On, Off

Значение по умолчанию On

5 Test Pattern Load Диапазон настройки Execute

Значение по умолчанию
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Таблица меню настроек
№ Подменю Установочный пункт Установка

7 Shot Memory 1 Target Select BKGD Диапазон настройки
Target

On, Off
XPT

On, Off

Значение по умолчанию On On

Key1 Диапазон настройки
Target

On, Off
XPT

On, Off

Значение по умолчанию On On

Key2 Диапазон настройки
Target

On, Off
XPT

On, Off

Значение по умолчанию On On

AUX1 Диапазон настройки On, Off

Значение по умолчанию On

AUX2 Диапазон настройки On, Off

Значение по умолчанию On

CBGD Диапазон настройки On, Off

Значение по умолчанию On

2 Effect Диапазон настройки Cut, Dissolve

Значение по умолчанию Dissolve

3 Hue Path Диапазон настройки Short, Long, CW, CCW

Значение по умолчанию Short

4 XPT Disable Диапазон настройки Off, On

Значение по умолчанию Off
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Таблица меню настроек
№ Подменю Установочный пункт Установка

8 XPT Assign 1 XPT1
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN1

2 XPT2
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN2

3 XPT3
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN3

4 XPT4
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN4

5 XPT5
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN5

6 XPT6
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN6

7 XPT7
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN7

8 XPT8
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN8

9 XPT9
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию IN9

10 XPT10
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию CBAR

11 XPT11
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию CBGD1

12 XPT12
Диапазон настройки

От IN1 до 9(**********), Black, CBGD1, CBGD 2, CBAR, 
Still1V, Still1K, Still2V, Still2K, CLN, Key Out, None

Значение по умолчанию CBGD2

13 Switch Timing Диапазон настройки Any, Field1, Field2

Значение по умолчанию Any
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Таблица меню настроек
№ Подменю Установочный пункт Установка

9 MultiView

**********: 
Название 
установленного 
в данный момент 
материала

1 Split
Диапазон настройки

4Split, 5-aSplit, 5-bSplit, 6-aSplit, 6-bSplit, 9Split, 10-aSplit, 
10-bSplit, 12Split, 16Split

Значение по умолчанию 10-aSplit

2 Size Диапазон настройки Fit, SQ

Значение по умолчанию SQ

3 Source Select Pos1 Source

Диапазон настройки

От IN1 до 9 (**********),
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию PGM

Pos2 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию PVW

Pos3 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN1

Pos4 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP-OUT1, IP-OUT2

Значение по умолчанию IN2

Pos5 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN3

Pos6 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN4

Pos7 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN5

Pos8 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN6

Pos9 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN7

Pos10 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN8
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Таблица меню настроек
№ Подменю Установочный пункт Установка

9 MultiView

**********: 
Название 
установленного 
в данный момент 
материала

3 Source Select Pos11 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию IN9

Pos12 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию Still1V

Pos13 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию Still2V

Pos14 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию CBAR

Pos15 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию CBGD1

Pos16 Source

Диапазон настройки

От IN1 до 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, 
PGM, PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, 
Analog IN, IP OUT1, IP OUT2

Значение по умолчанию CBGD2

4 MV Frame Диапазон настройки LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

Значение по умолчанию LUM75%

5 MV Character Диапазон настройки LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

Значение по умолчанию LUM75%

6 MV Label Диапазон настройки On, Off

Значение по умолчанию On

7 Red Tally Box Диапазон настройки On, Off

Значение по умолчанию Off

Label Left Диапазон настройки On, Off

Значение по умолчанию Off

Label Right Диапазон настройки On, Off

Значение по умолчанию Off

8 Green Tally Box Диапазон настройки On, Off

Значение по умолчанию Off

Label Left Диапазон настройки On, Off

Значение по умолчанию Off

Label Right Диапазон настройки On, Off

Значение по умолчанию Off
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Таблица меню настроек
№ Подменю Установочный пункт Установка

9 MultiView 9 Display Level Meter Диапазон настройки OFF, IN ON, OUT ON, IN/OUT ON

Значение по умолчанию OFF

Input Status Диапазон настройки On, Off

Значение по умолчанию On

Marker Диапазон настройки 4:3, 16:9, Off

Значение по умолчанию Off

Marker Size Диапазон настройки От 80 до 100%

Значение по умолчанию 95%

Верхний уровень
№ Подменю Установочный пункт Установка
10 Input 1 IN1(SDI1/

HDMI1)

Только 
отображение

Меню 
следующего 
уровня

Переход на нижний уровень A

2 IN2(SDI IN2)

3 IN3(SDI IN3)

4 IN4(SDI IN4)

5 IN5(HDMI IN2)

6 IN6(IP IN1) Переход на нижний уровень B

7 IN7(IP IN2)

8 IN8(IP IN3)

9 IN9(IP IN4)

Нижний уровень A
№ Подменю Установочный пункт Установка

SDI1/HDMI1 1 SDI/HDMI Диапазон настройки SDI, HDMI

Значение по умолчанию SDI

SDI IN XX 2 Status 
Information

Format

Только отображениеAudio

Status

3 FS Mode Диапазон настройки Off, Normal, Auto

Значение по умолчанию Auto

4 FS Delay
Диапазон настройки

От 0F до 6F

	p SDI IN1 от 0F до 2F.
Значение по умолчанию 0F

5 Freeze Диапазон настройки Disable, Enable

Значение по умолчанию Disable

6 Freeze Select Диапазон настройки Frame, Field

Значение по умолчанию Frame

7 Name Type Диапазон настройки Default, User

Значение по умолчанию Default

8 Name Диапазон настройки Можно установить 32 символа.

Значение по умолчанию

9 Up/Down 
Converter

Move Detect Диапазон настройки От 1 до 5

Значение по умолчанию 5

Sharp Диапазон настройки От 1 до 5

Значение по умолчанию 3
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Таблица меню настроек
№ Подменю Установочный пункт Установка

SDI IN XX 10 Color Correct C/C Диапазон настройки On, Off

Значение по умолчанию Off

C/C Process Диапазон настройки
Y-Gain

От 0.0 до 200.0
Pedestal

От –20.0 до 20.0

Значение по умолчанию 100.0 0.0

Диапазон настройки
C-Gain

От 0.0 до 200.0
Hue

От 0.0 до 359.9

Значение по умолчанию 100.0 0.0

11 Camera 
Setting

IP Address Диапазон настройки Выбор IP-адреса

Значение по умолчанию

Port Диапазон настройки От 1 до 65535

Значение по умолчанию 80

Edit IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Scan IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Edit User 
Name

Диапазон настройки

Значение по умолчанию

Edit Password Диапазон настройки ********

Значение по умолчанию

Name Диапазон настройки Название, зарегистрированное в камере

Значение по умолчанию

Network 
Status

Диапазон настройки
No IP Address, Now Checking…, Connected, 
Unauthorized, Not Connected

Значение по умолчанию No IP Address

Red Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable

Green Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable

HDMI IN XX 2 Status 
Information

Size

Только отображение

Dot Clock

H-Frequency

V-Frequency

Status

3 Freeze Диапазон настройки Disable, Enable

Значение по умолчанию Disable

4 Freeze Select Диапазон настройки Frame, Field

Значение по умолчанию Frame

5 Limited Диапазон настройки On, Off

Значение по умолчанию Off

6 Name Type Диапазон настройки Default, User

Значение по умолчанию Default

7 Название Диапазон настройки Можно установить 32 символа.

Значение по умолчанию

8 Scale Диапазон настройки Fit-V, Fit-H, Full

Значение по умолчанию Full

9 Color Correct C/C Диапазон настройки On, Off

Значение по умолчанию Off

C/C Process Диапазон настройки
Y-Gain

От 0.0 до 200.0
Pedestal

От –20.0 до 20.0

Значение по умолчанию 100.0 0.0

Диапазон настройки
C-Gain

От 0.0 до 200.0
Hue

От 0.0 до 359.9

Значение по умолчанию 100.0 0.0
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Таблица меню настроек
№ Подменю Установочный пункт Установка

HDMI IN XX 10 Camera 
Setting

IP Address Диапазон настройки Выбор IP-адреса

Значение по умолчанию

Port Диапазон настройки От 1 до 65535

Значение по умолчанию 80

Edit IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Scan IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Edit User 
Name

Диапазон настройки

Значение по умолчанию

Edit Password Диапазон настройки ********

Значение по умолчанию

Name Диапазон настройки Название, зарегистрированное в камере

Значение по умолчанию

Network 
Status

Диапазон настройки
No IP Address, Now Checking…, Connected, 
Unauthorized, Not Connected

Значение по умолчанию No IP Address

Red Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable

Green Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable
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Таблица меню настроек
Нижний уровень B
№ Подменю Установочный пункт Установка

IP IN1,2 1 Streaming 
Mode

Диапазон настройки NDI|HX, SRT (выбранный источник отображается ниже)

Значение по умолчанию NDI|HX

IP IN3,4 1 Streaming 
Mode

Диапазон настройки NDI

Значение по умолчанию NDI

NDI IN XX 2 Status 
Information

Format

Только отображение

Sampling Rate

Audio 
Channel

Frame Data

Compress

Streaming 
Mode

Status

3 Alpha 
Settings Use Alpha

Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Type
Только отображение

Alpha Signal

Key Source 
BKGD

Диапазон настройки White, Black

Значение по умолчанию White

4 Machine 
Name Только отображение

5 Source Name 

6 Scan Mode Диапазон настройки HB/HX v2, HX v1

Значение по умолчанию HB/HX v2

7 Scan Диапазон настройки Переход в другое меню (список результатов сканирования)

Значение по умолчанию

8 Protocol Диапазон настройки TCP, UDP

Значение по умолчанию TCP
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Таблица меню настроек
№ Подменю Установочный пункт Установка

NDI IN XX 9 Group Group Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Group Name Диапазон настройки Можно установить 64 символа.

Значение по умолчанию

10 Use Discovery 
server

Use Discovery 
server

Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Discovery 
server IP

Диапазон настройки Ввод IP-адреса

Значение по умолчанию

11 RTSP Port Диапазон настройки От 1 до 65535

Значение по умолчанию 554

Request URL Диапазон настройки Можно установить 255 символов.

Значение по умолчанию MediaInput/h264/stream_1

Connect Диапазон настройки Execute

Значение по умолчанию

12 Name Type Диапазон настройки Default, User

Значение по умолчанию Default

13 Name Диапазон настройки Можно установить 32 символа.

Значение по умолчанию

14 Camera 
Setting

Control Диапазон настройки Panasonic, NDI

Значение по умолчанию Panasonic

IP Address Диапазон настройки Выбор IP-адреса

Значение по умолчанию

Port Диапазон настройки От 1 до 65535

Значение по умолчанию 80

Edit IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Scan IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Edit User 
Name

Диапазон настройки

Значение по умолчанию

Edit Password Диапазон настройки ********

Значение по умолчанию

Name Диапазон настройки Название, зарегистрированное в камере

Значение по умолчанию

Network 
Status

Диапазон настройки
No IP Address, Now Checking…, Connected, 
Unauthorized, Not Connected

Значение по умолчанию No IP Address

Red Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable

Green Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable
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Таблица меню настроек
№ Подменю Установочный пункт Установка

SRT IN XX 2 Status 
Information

Формата

Только отображение

Видеоформат (1080/59.94p, и т.д.)

Sampling 
Rate

Audio 
Channel

Compress H.264/H.265

Status

3 Name Type Диапазон настройки Default, User

Значение по умолчанию Default

4 Name Диапазон настройки Можно установить 32 символа.

Значение по умолчанию

5 Mode Диапазон настройки Caller, Listener

Значение по умолчанию Caller

6 Server URL Диапазон настройки Ввод URL. От 1 до 254 символов

Значение по умолчанию

7 Server Port Диапазон настройки От 0 до 65535

Значение по умолчанию 30000

8 Stream ID Диапазон настройки Можно установить 512 символов.

Значение по умолчанию

9 Port Диапазон настройки От 1024 до 65535

Значение по умолчанию 2020

10 Encryption Диапазон настройки Disable, Enable

Значение по умолчанию Disable

11 Passphrase Диапазон настройки Можно установить от 10 до 79 символов.

Значение по умолчанию

12 Camera 
Setting

IP Address Диапазон настройки Выбор IP-адреса

Значение по умолчанию

Port Диапазон настройки От 1 до 65535

Значение по умолчанию 80

Edit IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Scan IP 
Address

Диапазон настройки Execute

Значение по умолчанию

Edit User 
Name

Диапазон настройки

Значение по умолчанию

Edit Password Диапазон настройки ********

Значение по умолчанию

Name Диапазон настройки Название, зарегистрированное в камере

Значение по умолчанию

Network 
Status

Диапазон настройки
No IP Address, Now Checking…, Connected, 
Unauthorized, Not Connected

Значение по умолчанию No IP Address

Red Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable

Green Tally Диапазон настройки Disable, Enable

Значение по умолчанию Enable
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Верхний уровень
№ Подменю Установочный пункт Установка
11 Output 1 OUT1(SDI 

OUT1)

Только 
отображение

Меню следующего 
уровня

Переход на нижний уровень A

2 OUT2(SDI 
OUT2)

Переход на нижний уровень A

3 OUT3(HDMI 
OUT)

Переход на нижний уровень B

4 OUT4(IP 
OUT1)

Переход на нижний уровень C

5 OUT5(IP 
OUT2)

Переход на нижний уровень C

6 OUT6(UVC 
OUT)

Переход на нижний уровень D

Нижний уровень A
№ Подменю Установочный пункт Установка

SDI OUT XX 1 Assign Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

Таблица меню настроек
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Нижний уровень B
№ Подменю Установочный пункт Установка

HDMI OUT 1 Assign Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию MV

2 Size Диапазон настройки Auto, XGA, WXGA, SXGA, WSXGA+, Native

Значение по умолчанию Auto

3 Color Диапазон настройки Auto, RGB, YUV444, YUV422

Значение по умолчанию Auto

4 Scale Диапазон настройки Fit-V, Fit-H, Full, Full90%, Full80%

Значение по умолчанию Full

5 Move Detect Диапазон настройки От 1 до 5

Значение по умолчанию 5

Нижний уровень C
№ Подменю Установочный пункт Установка

IP OUT XX 1 Streaming 
Mode

Диапазон настройки NDI, SRT, RTMP (выбранный источник показан ниже)

Значение по умолчанию NDI

2 Streaming 
Link

Диапазон настройки On, Off

Значение по умолчанию Off

NDI OUT XX 3 Assign Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

4 Machine 
Name

Диапазон настройки До 20 символов

Значение по умолчанию AV-HSW10

5 Source Name Только 
отображение

Диапазон настройки До 32 символов

Значение по умолчанию NDI Device xx

6 Protocol Диапазон настройки TCP, UDP

Значение по умолчанию TCP

7 Multicast Multicast Диапазон настройки Disable, Enable

Значение по умолчанию Disable

IP Address Диапазон настройки Ввод IP-адреса

Значение по умолчанию 239.192.0.30

Subnet Mask Диапазон настройки Ввод IP-адреса

Значение по умолчанию 255.0.0.0

TTL/HOP 
Limit

Диапазон настройки От 1 до 254

Значение по умолчанию 16

8 Group Group Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Group Name Диапазон настройки Можно установить 64 символа.

Значение по умолчанию

9 Use Discovery 
server

Use Discovery 
server

Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Discovery 
server IP

Диапазон настройки Ввод IP-адреса

Значение по умолчанию
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№ Подменю Установочный пункт Установка

SRT OUT XX 3 Assign Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

4 Assign 
STDBY

Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

5 Mode Диапазон настройки Caller, Listener

Значение по умолчанию Caller

6 Destination 
URL

Диапазон настройки Ввод URL. От 1 до 254 символов

Значение по умолчанию

7 Destination 
Port

Диапазон настройки От 0 до 65535

Значение по умолчанию 30000

8 Stream ID Диапазон настройки Можно установить 512 символов.

Значение по умолчанию

9 Port Диапазон настройки От 1024 до 65535

Значение по умолчанию 2020

10 TTL/HOP limit Диапазон настройки От 1 до 254

Значение по умолчанию 64

11 Latency(ms) Диапазон настройки От 0 до 9999

Значение по умолчанию 20

12 Encryption Диапазон настройки Disable, AES128, AES256

Значение по умолчанию Disable

13 Passphrase Диапазон настройки Можно установить от 10 до 79 символов.

Значение по умолчанию

14 Codec Диапазон настройки H.264, H.265

Значение по умолчанию H.264

15 Rate Control 
Mode

Диапазон настройки CBR, VBR

Значение по умолчанию CBR

16 Target bit rate Диапазон настройки 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Значение по умолчанию 14Mbps

17 Max bit rate Диапазон настройки 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Значение по умолчанию 14Mbps
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№ Подменю Установочный пункт Установка

RTMP OUT XX 3 Assign Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

4 Assign 
STDBY 

Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

5 Server Диапазон настройки От 1 до 3

Значение по умолчанию 1

6 Server URL Диапазон настройки Ввод URL. От 1 до 254 символов

Значение по умолчанию

7 Stream Key Диапазон настройки Можно установить 512 символов.

Значение по умолчанию

8 Timeout (sec) Диапазон настройки От 1 до 30

Значение по умолчанию 10

9 Codec Диапазон настройки H.264

Значение по умолчанию H.264

10 Rate Control 
Mode

Диапазон настройки CBR, VBR

Значение по умолчанию CBR

11 Target bit rate Диапазон настройки 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Значение по умолчанию 14Mbps

12 Max bit rate Диапазон настройки 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Значение по умолчанию 14Mbps

Нижний уровень D
№ Подменю Установочный пункт Установка

UVC OUT 1 Assign Диапазон настройки PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Значение по умолчанию PGM

2 Menu Out Диапазон настройки Off, On

Значение по умолчанию Off

3 Mode Диапазон настройки Normal, 720p

Значение по умолчанию Normal
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№ Подменю Установочный пункт Установка
12 Config 1 Operate Menu Out Диапазон настройки SDI OUT2, HDMI OUT, SDI2+HDMI

Значение по умолчанию SDI2+HDMI

Menu Size Диапазон настройки FULL, Upper-Left, Upper-Right, Lower-Right, Lower-Left

Значение по умолчанию FULL

Menu Back Диапазон настройки 70%, 80%, 90%, 100%

Значение по умолчанию 100%

Bus Mode Диапазон настройки A/B, PGM-A/PST-B, PGM-B/PST-A

Значение по умолчанию PGM-A/PST-B

Time Unit Диапазон настройки Sec, Frame

Значение по умолчанию Sec

Delegation Диапазон настройки On, Off

Значение по умолчанию On

Fader Диапазон настройки BKGD, KEY1, BKGD+KEY1, No Assign

Значение по умолчанию BKGD

2 Key1/2 Link Диапазон настройки Off, On

Значение по умолчанию Off

3 CBAR Type Диапазон настройки Type1, Type2, Type3

Значение по умолчанию Type1

Move Диапазон настройки Normal, Low, Off

Значение по умолчанию Off

Test Tone Диапазон настройки Normal, Low, Off

Значение по умолчанию Off

4 Button 
Illumination

Button 
Illumination

Диапазон настройки
Dimmer

Off, On

Значение по умолчанию Off

Диапазон настройки
Lighting

80%, 90%, 100%, 110%, 120%, 130%, 140%, 
150%

Значение по умолчанию 150%

Диапазон настройки XPT 
Color

Input, Color Group1, Color Group2, Color Group3, 
Color Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Input

Color Group 
IN

Диапазон настройки
IN1(***)

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN2(***)

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN3(***)

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN4(***)

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN5(***)

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN6(***)

Color Group1, Color Group2, Color Group3, Color Group4, 
Color Group5, Color Group6, Color Group7, Color Group8

Значение по умолчанию Color Group1
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№ Подменю Установочный пункт Установка
12 Config 4 Button 

Illumination
Color Group 
IN Диапазон настройки

IN7(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN8(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
IN9(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Color Group 
Internal Диапазон настройки

Black

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
CBGD1

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
CBGD2

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
CBAR

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Color Group 
Still Диапазон настройки

Still 1V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
Still 1K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
Still 2V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
Still 2K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1
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№ Подменю Установочный пункт Установка
12 Config 4 Button 

Illumination
Color Group 
Other Диапазон настройки

CLN

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки Key 
Out

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки
STREAM

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки AUX 
BUS 
DELEG

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Диапазон настройки AUX 
SOURCE

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Значение по умолчанию Color Group1

Button Color 
Group1

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.1 0.1

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0.1

Button Color 
Group2

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.1 0.1

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0.0

Button Color 
Group3

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.0 0.1

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0,1

Button Color 
Group4

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.0 0.1

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0,0

Button Color 
Group5

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.1 0.0

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0.1

Button Color 
Group6

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.1 0.0

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0.0

Button Color 
Group7

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.0 0.0

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0.1
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№ Подменю Установочный пункт Установка
12 Config 4 Button 

Illumination
Button Color 
Group8

Диапазон настройки
R

От 0.0 до 1.5
G

От 0.0 до 1.5

Значение по умолчанию 0.0 0.0

Диапазон настройки
B

От 0.0 до 1.5

Значение по умолчанию 0.0

5 User Button User 1
Диапазон настройки

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, 
AUX1 Trans, AUX2 Trans, Effect Dissolve, Capture Still1, 
Capture Still2, None, от Shot Memory1 до 12, XPT Disable

Значение по умолчанию Key1 PVW

User 2
Диапазон настройки

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, 
AUX1 Trans, AUX2 Trans, Effect Dissolve, Capture Still1, 
Capture Still2, None, от Shot Memory1 до 12, XPT Disable

Значение по умолчанию Key2 PVW

User 3
Диапазон настройки

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, 
AUX1 Trans, AUX2 Trans, Effect Dissolve, Capture Still1, 
Capture Still2, None, от Shot Memory1 до 12, XPT Disable

Значение по умолчанию Shot Memory1

User 4
Диапазон настройки

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, 
AUX1 Trans, AUX2 Trans, Effect Dissolve, Capture Still1, 
Capture Still2, None, от Shot Memory1 до 12, XPT Disable

Значение по умолчанию Shot Memory2

User 5
Диапазон настройки

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, 
AUX1 Trans, AUX2 Trans, Effect Dissolve, Capture Still1, 
Capture Still2, None, от Shot Memory1 до 12

Значение по умолчанию Shot Memory3

User 6
Диапазон настройки

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, 
AUX1 Trans, AUX2 Trans, Effect Dissolve, Capture Still1, 
Capture Still2, None, от Shot Memory1 до 12

Значение по умолчанию Shot Memory4

6 AUX Name AUX1 Type Диапазон настройки Default, User

Значение по умолчанию Default

AUX1 Name Диапазон настройки Можно установить 32 символа.

Значение по умолчанию

AUX2 Type Диапазон настройки Default, User

Значение по умолчанию Default

AUX2 Name Диапазон настройки Можно установить 32 символа.

Значение по умолчанию

7 GPI GPI-In Setting Диапазон настройки GPI-In 
Enable

On, Off AUX 
Sel

AUX1, AUX2

Значение по умолчанию On AUX1

GPI-In Port

Диапазон настройки Port1 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, от AUX XPT1 до 12, RTly DSBL, 
GTly DSBL, AUX Tly DSBL

Значение по умолчанию GTly DSBL

Диапазон настройки Port2 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, от AUX XPT1 до 12, RTly DSBL, 
GTly DSBL, AUX Tly DSBL

Значение по умолчанию BKGD AUTO

Диапазон настройки Port3 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, от AUX XPT1 до 12, RTly DSBL, 
GTly DSBL, AUX Tly DSBL

Значение по умолчанию BKGD CUT
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№ Подменю Установочный пункт Установка
12 Config 7 GPI GPI-In Port

Диапазон настройки Port4 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, от AUX XPT1 до 12, RTly DSBL, 
GTly DSBL, AUX Tly DSBL

Значение по умолчанию KEY1 ON

Диапазон настройки Port5 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, от AUX XPT1 до 12, RTly DSBL, 
GTly DSBL, AUX Tly DSBL

Значение по умолчанию KEY2 ON

GPI-Out 
Setting

Диапазон настройки GPI-
Out 
Enable

On, Off
AUX Tly 
Sel

AUX1, AUX2

Значение по умолчанию On AUX1

GPI-Out Port

Диапазон настройки Port 1 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию RTly SDI IN1

Диапазон настройки Port 2 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию RTly SDI IN2

Диапазон настройки Port 3 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию RTly SDI IN3

Диапазон настройки Port 4 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию RTly SDI IN4

Диапазон настройки Port 5 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию RTly HDMI IN2

Диапазон настройки Port 6 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию KEY1 ON
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№ Подменю Установочный пункт Установка
12 Config 7 GPI GPI-Out Port

Диапазон настройки Port 7 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию No Assign

Диапазон настройки Port 8 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly от SDI IN1 до 4, RTly HDMI IN1, 2, от 
RTly IP IN1 до 4, от GTly SDI IN1 до 4, GTly HDMI 
IN1, 2, от GTly IP IN1 до 4, от AUXTly SDI IN1 до 4, 
AUXTly HDMI IN1, 2, от AUXTly IP IN1 до 4

Значение по умолчанию No Assign

8 Key Source 
Signal 
Coupling

Fill/Source Диапазон настройки Fill To Source, Source To Fill

Значение по умолчанию Fill To Source

IN1(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN1

IN2(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN2

IN3(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN3

IN4(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN4

IN5(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN5

IN6(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN6

IN7(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN7

IN8(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN8

IN9(***)
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию IN9

Black
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию Black
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№ Подменю Установочный пункт Установка
12 Config 8 Key Source 

Signal 
Coupling

CBGD 1
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию CBGD 1

CBGD 2
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию CBGD 2

CBAR
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию CBAR

Still 1V
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию Still 1V

Still 1K
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию Still 1K

Still 2V
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию Still 2V

Still 2K
Диапазон настройки

От IN1(***) до IN9(***), Black, CBGD 1, CBGD 2, CBAR, 
Still 1V, Still 1K, Still 2V, Still 2K

Значение по умолчанию Still 2K

9 System Menu 
Lock

Диапазон настройки On, Off

Значение по умолчанию Off

Таблица меню настроек
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№ Подменю Установочный пункт Установка
13 System 1 System 

Format
Диапазон настройки

1080/59.94p, 50p, 59.94i, 50i, 29.97p, 25p, 24p, 23.98p, 
720/59.94p, 50p

Значение по умолчанию 1080/59.94p

2 Reference Reference 
Select

Диапазон настройки BB, Tri-level Sync, Internal

Значение по умолчанию BB

Status Диапазон настройки

Значение по умолчанию

3 Output Phase System Диапазон настройки 0H, 1H

Значение по умолчанию 0H

H-Phase Диапазон настройки От – 0.50 до 0.49

Значение по умолчанию 0.00

V-Phase Диапазон настройки От –100 до 100

Значение по умолчанию 0

4 User Auth User Name Диапазон настройки Допускается установка в диапазоне от 1 до 32 символов.

Значение по умолчанию

Password Диапазон настройки ******** (Допускается установка в диапазоне от 1 до 
32 символов.)

Значение по умолчанию

5 Alarm Power Диапазон настройки Alarm, No Alarm

Значение по умолчанию

Fan Диапазон настройки Alarm, No Alarm

Значение по умолчанию

Temperature Диапазон настройки Alarm, No Alarm

Значение по умолчанию

6 Tally Settings Tally Mode Диапазон настройки Off, On

Значение по умолчанию On

Tally Target

Диапазон настройки Red 
Tally

Off, PGM, CLN, Key 
Out, AUX1, AUX2, IP 
OUT1, IP OUT2 Green 

Tally

Off, PGM, PVW, 
CLN, Key Out, AUX1, 
AUX2, IP OUT1, IP 
OUT2

Значение по умолчанию PGM PVW

7 Date/Time Date Setting Диапазон настройки yyyy / mm / dd

Значение по умолчанию

Time Setting Диапазон настройки hh : mm : ss

Значение по умолчанию

8 Initial Initial Settings Диапазон настройки Execute

Значение по умолчанию

Initial Fader Диапазон настройки Execute

Значение по умолчанию

9 System 
Information

System 
Version

Диапазон настройки Только отображение

Значение по умолчанию

System Core1 
Version

Диапазон настройки Только отображение

Значение по умолчанию

System Core2 
Version

Диапазон настройки Только отображение

Значение по умолчанию

System Core 
Update

Диапазон настройки Execute

Значение по умолчанию
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Таблица меню настроек
№ Подменю Установочный пункт Установка
14 Project 1 Project File Project 1 Диапазон настройки

Protect
Off, On

Load
Execute

Значение по умолчанию Off

Диапазон настройки
Save

Execute
Delete

Execute

Значение по умолчанию

Диапазон настройки
Name

32 символа
Date

Только отображение

Значение по умолчанию

Project 2 Диапазон настройки
Protect

Off, On
Load

Execute

Значение по умолчанию Off

Диапазон настройки
Save

Execute
Delete

Execute

Значение по умолчанию

Диапазон настройки
Name

32 символа
Date

Только отображение

Значение по умолчанию

Project 3 Диапазон настройки
Protect

Off, On
Load

Execute

Значение по умолчанию Off

Диапазон настройки
Save

Execute
Delete

Execute

Значение по умолчанию

Диапазон настройки
Name

32 символа
Date

Только отображение

Значение по умолчанию

2 Last Load File 
Name

Диапазон настройки I: *****, U: *****, L: *****

Значение по умолчанию

3 Last Load 
Date

Диапазон настройки yyyy/mm/dd hh:mm

Значение по умолчанию
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Таблица меню настроек
№ Подменю Установочный пункт Установка
15 Ancillary/Audio 1 Ancillary AUX Диапазон настройки Off, On

Значение по умолчанию On

PGM Диапазон настройки Off, On

Значение по умолчанию On

PVW Диапазон настройки Off, On

Значение по умолчанию On

CLN Диапазон настройки Off, On

Значение по умолчанию On

MV Диапазон настройки PGM, PVW, Off

Значение по умолчанию Off

2 Audio Assign AUX1 Диапазон настройки От IN1(***) до IN9(***), Analog, Follow Video, OFF

Значение по умолчанию Follow Video

AUX2 Диапазон настройки От IN1(***) до IN9(***), Analog, Follow Video, OFF

Значение по умолчанию Follow Video

PGM Диапазон настройки От IN1(***) до IN9(***), Analog, Follow Video, OFF

Значение по умолчанию Follow Video

PVW Диапазон настройки От IN1(***) до IN9(***), Analog, Follow Video, OFF

Значение по умолчанию Follow Video

CLN Диапазон настройки От IN1(***) до IN9(***), Analog, Follow Video, OFF

Значение по умолчанию Follow Video

3 Analog IN Audio Диапазон настройки Off, On

Значение по умолчанию Off

Input Type Диапазон настройки LINE, MIC

Значение по умолчанию LINE

Gain
Диапазон настройки

–36dB, –33dB, –30dB, –27dB, –24dB, –21dB, –18dB, 
–15dB, –12dB, –9dB, –6dB, –3dB, 0dB, 3dB, 6dB, 9dB, 
12dB

Значение по умолчанию 0dB

Delay(ms) Диапазон настройки От 0 до 512

Значение по умолчанию 0

4 Analog OUT Assign Диапазон настройки PGM, PVW, AUX1, AUX2, CLN

Значение по умолчанию PGM

Mute Диапазон настройки Off, On

Значение по умолчанию Off

Volume Диапазон настройки Отображается значение для регулятора громкости 
монитора на передней панели этого устройства. 
Диапазон составляет от 0 до 100.

Значение по умолчанию

16 Network 1 LAN IP Address Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 192.168.0.8

Subnet Mask Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 255.255.255.0

Default 
Gateway

Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 192.168.0.1

MAC Address Диапазон настройки –

Значение по умолчанию –

2 Primary DNS IP Address Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию –

3 Secondary 
DNS

IP Address Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию –
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Таблица меню настроек
№ Подменю Установочный пункт Установка
17 External 

Interfaces
1 External 

Panel 
Information

Active Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Port No Диапазон настройки От 62000 до 65535

Значение по умолчанию 62010

2 External 
Panel IP

Shot Memory 
Recall

BKGD Диапазон настройки
Target 

Off, On
XPT

Off, On

Значение по умолчанию Off Off

Key1 Диапазон настройки
Target 

Off, On
XPT

Off, On

Значение по умолчанию Off Off

Key2 Диапазон настройки
Target 

Off, On
XPT

Off, On

Значение по умолчанию Off Off

AUX1 Диапазон настройки Off, On

Значение по умолчанию Off

AUX2 Диапазон настройки Off, On

Значение по умолчанию Off

CBGD Диапазон настройки Off, On

Значение по умолчанию Off

XPT Диапазон настройки Off, On

Значение по умолчанию Off

3 External 
Control 
Switcher

Active Диапазон настройки Disable, Enable

Значение по умолчанию Disable

Port No Диапазон настройки От 62000 до 65535

Значение по умолчанию 62000

Interval Time Диапазон настройки 0ms, 16ms, 32ms, 48ms, 64ms, 80ms

Значение по умолчанию 16ms

Response Диапазон настройки On, Off

Значение по умолчанию On

4 External 
Control AUX 
Panel

Port No Диапазон настройки От 60000 до 65535

Значение по умолчанию 65000

IP Address1 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address2 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address3 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address4 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address5 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address6 Диапазон настройки от 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address7 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address8 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address9 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address10 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0



148

Таблица меню настроек
№ Подменю Установочный пункт Установка
17 External 

Interfaces
4 External 

Control AUX 
Panel

IP Address11 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address12 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address13 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address14 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address15 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address16 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address17 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address18 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address19 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

IP Address20 Диапазон настройки От 0 до 255.255.255.255

Значение по умолчанию 0.0.0.0

18 USB Memory 1 Load Load Type Диапазон настройки Still1, Still2, Project, Update

Значение по умолчанию Still1

Load Диапазон настройки Execute

Значение по умолчанию

2 Save Save Type Диапазон настройки Still1, Still2, Project, Log

Значение по умолчанию Project

Setup Диапазон настройки On, Off

Значение по умолчанию On

Shot Диапазон настройки On, Off

Значение по умолчанию On

Still Диапазон настройки On, Off

Значение по умолчанию Off

File Format Диапазон настройки bmp, tga, png, jpg, tif, gif

Значение по умолчанию png

Save Диапазон настройки Execute

Значение по умолчанию

3 Free Диапазон настройки Свободное место [KB/MB/GB]

Значение по умолчанию

4 Total Диапазон настройки Общее пространство [KB/MB/GB]

Значение по умолчанию

5 Unmount Диапазон настройки Execute

Значение по умолчанию

6 Format Диапазон настройки Execute

Значение по умолчанию
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Таблица меню настроек
№ Подменю Установочный пункт Установка
19 Color Adjust 1 Target Диапазон настройки От IN1(***) до IN5(***)

Значение по умолчанию IN1(***)

2 Parameter No Диапазон настройки От 1 до 10

Значение по умолчанию 1

3 Marker Диапазон настройки Off, On

Значение по умолчанию Off

4 Capture for 
Master

Диапазон настройки Execute

Значение по умолчанию

5 Adjust Target Диапазон настройки Execute

Значение по умолчанию

6 Enable Color 
Adjust

Диапазон настройки Disable, Enable

Значение по умолчанию Disable

7 Left Диапазон настройки От –50.00 до 50.00 (Left<Right)

Значение по умолчанию –50.00

8 Top Диапазон настройки От –50.00 до 50.00 (Top>Bottom)

Значение по умолчанию 50.00

9 Bottom Диапазон настройки От –50.00 до 50.00 (Top>Bottom)

Значение по умолчанию –50.00

10 Right Диапазон настройки От –50.00 до 50.00 (Left<Right)

Значение по умолчанию 50.00

11 Set Capture 
Points

Диапазон настройки Execute

Значение по умолчанию

12 Points От Point 1 до 
24

Диапазон настройки

X-Position

От –50.00 до 50.00

Значение по умолчанию
Значение, возникающее при Left = –50.00, 
Top = 50.00, Bottom = –50.00, Right = 50.00 
(использование полного экрана)

Диапазон настройки

Y-Position

От –50.00 до 50.00

Значение по умолчанию
Значение, возникающее при Left = –50.00, 
Top = 50.00, Bottom = –50.00, Right = 50.00 
(использование полного экрана)

13 Parameters От Parameter 
1 до 10

Диапазон настройки
Master

От IN1 до 5

Значение по умолчанию

Диапазон настройки
Name

Допускается установка до 16 символов.

Значение по умолчанию
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Приложение (словарь терминов)
Ниже приведено описание терминов, которые используются в настоящем руководстве.

Термин Пояснение

AB Bus system
Система AB шины

Шина A режим управления. При выполнении перехода, сигналы шины A и шины B 
поочередно выводят изображения программы.

Ancillary Data
Вспомогательные данные

Вспомогательные данные за исключением видеосигналов, которые передаются 
в пределах потока последовательного видеоинтерфейса. Данные, которые 
накладываются на период обратного хода вертикальной синхронизации, 
называются вспомогательными V-данными (VANC).

Aspect ratio
Пропорции изображения

Соотношение между горизонтальным и вертикальным размером изображения или 
экрана. Эти пропорции составляют 16:9 для формата HD и 4:3 для формата SD.

AUX [Auxiliary Bus]
[Вспомогательная шина]

Запасная шина, которая может переключаться сигналами помимо сигналов 
основного выхода.

BB [Black burst]
[Синхросигнал черного поля]

Сокращение термина “сигнал синхронизации черного поля”. Полноэкранный 
композитный сигнал уровня черного, который служит в качестве опорного сигнала 
принудительной синхронизации.

Border
Граница

Область или полоса, которая добавляется по краям замещения или вставки.
Ее ширину и цвет можно настраивать. Расфокусировка области вокруг границы 
называется эффектом плавности.

Chroma key
Цветовая вставка

Обозначает функцию формирования вставки на основе комбинирования цветовой 
информации видеосигнала и сигналов вставки.

Clip
Клип

Пороговый уровень яркости при создании сигналов вставки из источника вставки.

Color Background
Цветовой фон

Сигналы, которые выводятся от встроенного генератора цвета и служат в качестве 
фонового изображения.

Cut Обозначает эффект немедленного переключения на следующее изображение.

Density
Прозрачность

Параметр, который служит для настройки прозрачности сигналов вставки.

Down Converter
Преобразователь с 
понижением частоты

Данная функция преобразовывает материал в формате 4K в формат 2K/HD.

Embedded Audio
Встроенное аудио

Обозначает пакеты аудио-данных, которые передаются внутри интерфейсного 
потока видеосигнала.

Flip Flop system (PGM/PST 
system)
Триггерная система (Cистема 
PGM/PST)

Режим управления для шины A. Сигналы, выбранные программной шиной, всегда 
выводятся как программные изображения. При выполнении перехода происходит 
переключение сигналов программной шины и записанных сигналов.

Frame Synchronizer
Кадровый синхронизатор

Функция выполнения согласованной синхронизации несинхронизированных 
входных видеосигналов.

Freeze
Замораживание

Функция приостановки видеосигнала.

FTB [Fade to Black]
[Уход в затемнение]

Видеоэффект, при котором фоновое изображение постепенно затемняется до 
черного экрана.

Genlock
Принудительная 
синхронизация

Функция синхронизации видеосигналов с помощью внешнего опорного 
синхросигнала.

GPI
[General Purpose Interface]
[Универсальный интерфейс]

Интерфейсные сигналы, управляющие функцией автоматического перехода от 
внешнего источника.

Hue
Оттенок

Цветовой тон видеосигналов.
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Термин Пояснение

Key Edge
Край вставки

Граница или тень, добавленная по краям вставки.

Key Fill
Заполнение вставки

Сигнал, который служит для комбинированного заполнения области, оставшейся 
незаполненной сигналами вставки.

Key Gain
Усиление вставки

Параметр, используемый для настройки амплитуды сигналов вставки.

Key Invert
Инверсия вставки

Функция, инвертирующая сигналы вставки.

Key Mask
Маска вставки

Функция, которая служит для указания области комбинированной вставки с 
помощью задания координатного прямоугольника, и т.д. При использовании 
только части сигналов вставки, комбинация выполняется с маскированием 
неиспользуемой области.

Key Source
Источник вставки

Видеосигналы, служащие для формирования сигнала вставки.

Line Synchronizer
Линейной синхронизации

Функция автоматической регулировки фазы входного сигнала изображения в 
соответствии с горизонтальной синхронизационной фазой опорного сигнала.

Linear Key
Линейная вставка

Функция комбинирования монохромных сигналов вставки, пропорционально 
используя градации их интенсивности на выходе.

Lum [Luminance]
[Яркость]

Составляющая яркости видеосигналов.

Luminance Key
Вставка яркости

Функция формирования сигналов вставки, комбинируя входные видеосигналы по 
их яркости.

ME [Mix Effect]
[Эффект микширования]

Видеоэффект или устройство, в котором используется комбинация нескольких 
видеосигналов для формирования видеосигналов смешивания, замещения, 
вставки и др.

Mix
Микширование

Эффект изменения изображения путем перекрытия одной из картинок со 
следующей. Он также называется эффектом “наплыва”.

Multi View Display
Многокомпонентное 
изображение

Данная функция позволяет объединить несколько материалов и отобразить их на 
одном экране.
На одном экране можно одновременно просматривать несколько предварительных 
материалов в формате PGM, PVW.

PinP [Picture in Picture]
[Картинка в картинке]

Функция, позволяющая комбинировать входное изображение с фоновой картинкой.

PVW [Preview]
[Предварительный 
просмотр]

Функция, позволяющая заранее просмотреть изображение, которое будет 
выведено на выход после следующего перехода. Изображение выводится по 
системе PVW.

PGM [Program Bus]
[Программная шина]

Шина, которая всегда переносит программные выходные сигналы.

PST [Preset Bus]
[Шина записанных сигналов]

Шина, которая всегда переносит программные выходные сигналы после 
следующего фонового перехода.

Sat [Saturation]
[Насыщенность]

Этот термин обозначает интенсивность уровня цветности видеосигналов.

SDI
[Serial Digital Interface]
[Последовательный 
цифровой интерфейс]

Стандарт, в соответствии с которым осуществляется передача видеосигналов 
различных SD и HD форматов по одиночному коаксиальному кабелю.

Self Key
Эффект автозамещения

Функция создания комбинированных сигналов вставки из сигналов заполнения.

Приложение (словарь терминов)
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Термин Пояснение

Setup Data
Данные настройки

Память, в которую можно записывать и вызывать из нее настройки панели 
управления. В эту память можно записывать состояние переключателя выбранного 
синхросигнала, информацию о цвете границ, а также данные других настроек.

Tally
Сигнальная метка

Сигнал, который выводит данные о программном состоянии входных сигналов на 
внешнее устройство. Светодиоды, которые индицируют программное состояние 
выходных сигналов на панели управления, также называются сигнальными.

Transition
Переход

Функция переключения одного изображения на другое.
При переключении к изображениям можно применять Сдвиг, Микширование и 
другие эффекты.

Tri-level Sync
Трехуровневая 
синхронизацияс

Синхросигнал, который используется в HD форматах.

Trimming
Обрезка

Функция, удаляющая ненужные части сверху, снизу, справа и слева от 
изображения, комбинируемые с помощью функции PinP.

Up Converter
Повышающее 
преобразование

Функция, позволяющая преобразовать материалы в формате 2K/HD в формат 4K,
обеспечивающий более высокое разрешение.

Video Memory
Видеопамять

Память, в которой могут храниться изображения (статические изображения) с 
сигналами вставки.

Wipe
Сдвиг

Видеоэффект, при котором одно изображение постепенно заменяется другим путем 
перемещения границы с заданными свойствами между двумя изображениями.

Приложение (словарь терминов)
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